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Introduction

The entertainment industry relies on
the narrative pull and believability of

a character, and that character starts

its life in the hands of a concept artist.
With a need for powerful and flexible
tools to create these unique and refined
character designs, the popular method
of choice among concept artists in the
industry is digital painting in Photoshop.
Offering not only the advantages of
ease and speed, but also the ability to
dramatically aiter the colors of your
image and use custom brushes to
create impressive and credible textures,
it really is an extraordinary outlet in
which to hone your creative skill set.

Browsing through the most impressive 2D
character concepts onling, as well as in
books, films, and games, you will find a vast
variety of designs in many different styles.
So how do you begin to find the right style
for you and put your ideas into practice?
Figuring out the way your characters will
look and act is definitely not an easy task.
Shapes, colors, textures, and values are an

important part of character design, holding
the power to dramatically change the mood,
narrative, and those all-important elements
that make a character recognizable.

To guide you through your creative learning.
we have gathered a selection of skilled,
professional digital artists to lead you through
the fundamentals behind digitally painting
characters. At the back of the book you'll find
an invaluable glossary written by the brilliant
Bram “Boco” Sels, covering all the essentials
to get you started — plus you can refer back
to it while reading through the more detailed
project overviews that the book has to offer.

From setting up your interface and tools
with characters in mind, to in-depth creative
workflows packed full with top tips and
advice, Beginner’s Guide to Digital Painting
in Photoshop: Characters provides a
definitive resource for anyone on the path
to becoming a digital character artist.

Jess Serjent-Tipping
Deputy Editor, 3dtotal Publishing










Getting started

Find out how to successfully set up your
waorkspace and functions in Photoshop.

Learning how to use Photoshop for character design can be
daunting. To get you setup and ready to siart painting, Benita
Winckler will guide you through the features, tools, and useful
functions that will become a staple in your workflow. In this section,
Benita will give a breakdown on setting up your canvas and

layers ready for painting, overcoming a blank canvas, creating
your own brush library, and defining your color palette, all of

which will provide a solid foundation for the tutorials to come!




Setting up your canvas

How to prepare your workspace to start painting characters

by Benita Winckler

In this intreductory chapter we will
look at Photoshop CC and how to use
it for character design. If you are a
traditional artist (beginner-level or with
some experience), but you have never
really worked with the software before
— perfect! You are in the right place.

Before we begin, let me say right away
Photoshop is a massive program.

On first sight it can be a real beast
(although a nice one). Mastering all of
its powerful features up to the very last
button will not happen overnight. We
are in here for results though, right?

We'll start with a character that has
already been developed and use it as

an example to set up our document for
the actual painting process. The next
steps will give you a solid overview and
foundation for the tutorials that will follow
in this book. Here is what you'll need

* basic knowledge of drawing traditionally
* Photoshop CC - if you have an older
version, say CS5, that will work as
well, it's just that the example images

here might look a bit different for you

* a good graphics tablet, preferably one

with a high range of pressure sensitivity;

but for now simply use what you have

- a bit of creative madness (very useful!).

You will learn how to

* set up your canvas

* set up your layers for painting

* create your own brush library

* define your color palette.

EANBEANWAY




Step 01

Who else uses

) is the

all with varying need

makes sense, why Photoshop is

massive program). There are illus

and retouch artists working for high-

gloss magazines, animators w

ir magic for online games, and matte

orks have to fit into

a strictly defined pipeline set up by film

studios; there are fashion designers.

s, web and gr

phi

Now why is all of this interesting for you?
It means that for character design you

will not have to learn the whole -kage:

jusl

picking? Let’'s open Photoshog

Step 02

Selecting a workspace

If you have a fresh installation, you will

e interface default, called Essentials

workspace. It offers a bz

s that are t

arrangement of

cally used (ir e 02a)

As discussed, Photoshop has different
groups of users, so there are different
presets for workspaces available. Being

highly

Photoshop also allows
you to create your own arrangement and

save it for maximum comfort. For us, the

PS Fic Edit image layer Type Select Fiter 3D View Window Help
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Tool bar
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Essentials

Photography
Typography

A Keep the Essentials workspace, so that we all look at the same panels. If needed, select

Reset Essentials

ace will be suffici

) be using the Adjustments

so you can keep it like that

th the Adijt

n image 02a. (We will have

the Painting mode later, so th,

an exy ment with that

If yo

some val d some menus

know how to g

and don't et them back, don't

ion inside the

worry. Th

ere is ari

mer

workspace

(image 02b). Hit Reset

et back to the default s

Step 03

ht

niliar wit 2 interface

Let's further i ct the in Vhere

are all the important buttor

Application bar (Menu bar)
ook o4 BB

the left-hand side, we have the Tools

on the right there are the panel columns

that you wil

holding the individual pane
work with most. all collected in tabbed

groups. If you click a tab, it will bring the

corresponding panel to the front and activate

ill see the activat | in

it (y d Layers pa

image 03a; you will need this all the time)

On top of the screen is the Menu bar, also

abo

called the Application bar (it si

Or
Opt

ions bar, w options for the

currently selected tool;

ge the tool and

wa

ch the Options bar update cordingly)
For example, if you

nel group, you will
find the option to do so in its panel drop
down menu (as well as many other options

corresponding to a particular panel's topic).

=
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Secondary panel column

Panel column with tabbed panel groups

Panel menu icon

A Looking at the interface. The Options bar shows the options for the currently selected tool, in this case, the Move tool 03a



View Window = Help

Toggle “hide/show”

Minimize

Alt+F9

Character
Character Styles
Clone Source
Color
Histogram
History
Info F8
Layer Comps

b y F7
Measurement Log
Navigator
Notes

Paragraph

Paragraph Styles
Paths

Properties

Styles

Swatches
Timeline

Tool Presets

4 Opening a new panel to be included
Note that open panels are ticked

If you want to open the Brush panel, simply
go to Window > Brush (image 03b) and

the panel will attach its icon to the column
as you can see in image 03c. If there is a
check mark next to the option it means the
panel is already open in the panel column
tabs. Click the arrows to minimize and

click the panel icon to toggle hide/show
(image 03c). To close the Brush group
panel, click Close Tab Group (image 03d)

Step 04
Canvas resolution - print or screen?
Depending on your needs, you will either

want to create a file for screen purposes or

pRRERERER B D @

A Click the arrow icon to minimize a panel

Brush Tip
Shape Dynamics
Scattering
Texture

Dual Brush

Color Dynamics

Transfer
Brush Pose
Noise

Wiet Edges
Buikl-up

Smoocthing

BERERBRRE

Protect Texture

A Closing the Brush panel/panel group

for printing. At the start of a project you might

not always know if you'll need a print version
later on or not. Keep in mind that if you
create and polish your character in screen
resolution (72 dpi), you will not be able to
print it in high quality later on (image 04da).
High-resolution print documents (300 dpi),
however, can be converted into screen or
web resolution easily without loss of quality.

Let's create a screen-resolution file (I'll
explain the print preset as well, so you can
decide on the output resolution you prefer
for your artwork). In the top menu bar click
File > New, then in the dialog box, select

03d

Preset: Web and assign a name (or do

s0 when saving your file). We will create

a standing characler, so we need portrait
dimensions. Alter the default values to 600
pixels for width and 800 pixels for height.
The Preset changes to custom, indicating
custom-sized dimensions. Leave the other
entries untouched and click OK (image 04b)

For print resolution, select Preset.
International Paper, which gives you an Ad-
sized document at 300 dpi (image 04c). Your
new document will appear. Click File > Save
As: keep the default file format of PSD. Use
the Zoom tool (Z) to navigate (image 04d)



Preset‘

Widt

Heigh @ Pixels ¢
Resolutio o Pixels/Inch hd

Color Mode: | RGB Color  =| | B bit ¥

Pixels ®

Background Contents: | White - Image Size:
1,37M
Advanced
Color Profile: | sRGB IEC61966-2.1 ¢

Pixel Aspect Ratio: | Square Pixels -

Name: Untitled-1 OK
International Paper s Cancel
Size: | A4 s Save Preset
Width: | 210 Millimeters =
Height: 297 Millimeters s
Resolution: 300 Pixels/Inch #
Color Mode: | RGB Color  *| | B bit s

A Print settings l

PS Fie Edit Image Layer Type Seid
Q - @ Q 7 ReszeWindwstoFit

rirst_character @ 100% (RGB/B) x

HR A PANBRAN AR D

4 Your new document (size 600 = 800
pixels) at 100%. Try using the Zoom tool (Z)



Step 05

Image Size

Image Size: 5,49M (was 1,37M) .

Here's a trick to ge
Dimensions: '~/ 1200 px x 1600 px

Fit To: Custom :
.“.‘ld(h 5
@Hewghlo Pixels i

size needed. Another Resolution: 72 Pixels/Inch s

bonus is that minor irre | Resample:  Autom

use of the down-sce do this, hit

Image Size in the top menu bar
aht. Tt oK Cancel
-live, so width will be calculz | ———
0 1200 pixels. Now hit OK A Settings to change the size of the canvas m
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Maintain proportions
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A Transform the sketch layer (Ctri+T)
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4 Cropping or extending your canvas

Step 06

How to copy/paste cc

one document to an

The goal for the next step is to practice

how to copy and paste ontent of one

document into another ar

1 how to position

the material on your canvas. We are going

to need this technique in the next chapters

To open a scanned pencil drav

go to

File > Open and select the entire new file

by hitting Ctri+A. Then cc t
of that selection (Ctrl+C). Activate t

tab (main document) to bring it to the front,

then hit Ctri+V to paste everything in

MNow., depending on the size of your

scanned character, it m

ool and click-

to activate the Transform

drag the anchor points to scale and

nfirm

position your sketch layer and

(see image 06b). Then sz

round, RGB/E * *

“For a very intuitive way to
resize your canvas, simply
use the Crop tool. You'll
love it”

Step 07

ng canvas dimension

Right now our canvas is portrait in
orientation. For one character, this is a

od choi

2. But what if we want to change

dimension later on in the painting
process? Maybe we decide that we need

ce to the left of our character

more s|

and less space at the bottom? Or maybe

we want to switch dimensions completely

and turn portrait canvas into landscape

to display the same character several

times on the canvas, v each figure

earing a variety of different clothing

For a very intuitive way to resize your

canvas, simply use the Crop tool. You'll

07

love it — it can be used for cropping as well

as extending your canvas (image 07)

Let's see how it works. Select the Crop tool
ad

(keyboard shortcut is C), mark the prefe
area for your canvas with a Marquee
selection (the box that appears when
you drag the Crop tool aver your canvas.
marking out the area that will be left when
you confirm to crop), then grab the anchor
points and precisely drag them around until
you are happy with the new dimensions. If
you confirm by hitting Return (or clicking on
the check mark icon in the top menu bar)

the new canvas dimension will be defined

Pixel

outside the Margquee selection will

appear grayed out and w

| get deleted if

the checkbox for Delete Cropped Pixels in
the top menu bar is checked. If unchacked
Photoshop will turn your crop into a layer,

where the cropped pixels lie safely hidden

outside your visible frame. To enlarge the



e * PRO TIP

Enjoy the swiftness of Actions
Actions are a god-send. You need
them. You can see some of my
favorite actions | have assigned F
keys to in the image to the right.You
can also asign keyboard shortcuts by
clicking on Edit > Keyboard Shortcuts,
where you can alter how you access
most Photoshop tools. Shortcuts |

and not seal find myself constantly using are:

in the Edit menu or Y

The solution: for every imp ] = Ctrl+Alt+Z to undo

regularly will ] = Ctri+Shift+| to invert the selection

o e, S0 T, e e G E N SRR S

and assign ita rtcut key. So instead « Ctrl+8S to save (it's a lifesaver)
of having to learn whi s * B and E to alternate between
by heart duce the ha the Brush tool and the Eraser.

Actions panel menu

History ~Actions = Swatches
B v & Default Actions

B » Vignette (selection)
.} Frame Channel - 50 ...
Wood Frame - 50 pi..
Cast Shadow (type)
Water Reflection (ty...
Custom RGB to Gra...
Molten Lead
Make Clip Path (sele...
Sepia Toning (layer)
Quadrant Calors
Save as Photoshop ...
Gradient Map

Mixer Brush Cloning...

1 New Set
2 New Action
3 Start Recording of Action

4 Stop Recording of Action

+
R
v
s
v
L4
4
4
4
v
T
v
v
v
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Adjustments  Siyles
Add an adjustment
0 wik B PV
HAI2ESO6HE
E |

A Steps to create shoricut Actions




New Action

Name:

Set:
Function Key:

Color:

F2
F3
F4
F5
F6
F7
F8
=
Fi0
F11
F12

A The New Action dialog pop-up

————

Click here to stop

A The icon to stop recording

Action 1
Benita's favourites : Cancel

None =

~afff————————  Assign a short key for the Action

History

v =
v B
|

L L8488 888884848888 88484

Actions
v vmeun ~uma.

) Vignette (selection)
Frame Channel - 50 pixel
Wood Frame - 50 pixel
Cast Shadow (type)
Water Reflection (type)
Custom RGB to Grayscale
Molten Lead
Make Clip Path (selection)
Sepia Toning (layer)
Quadrant Colors
Save as Photoshop PDF
Gradient Map

» Mixer Brush Cloning Paint Setup
v @ Benila's favourites

» Fip layer horizontal

Fip canvas horizontal

Fiip layer vertical

Rotate layer 45 degrees

Rotate canvas 45 degrees.
Indexed colors to normal

Merge layer

Action 1

G LR B ]

n > I T &

TV ¥ ¥ ¥Y V¥V VY Vayow

Now we are recording

have to create those Actions and you will
have to learn the buttons you assign to
them. But create once, enjoy forever!

You can create Actions for your favorite
tasks such as Flip Canvas (very useful to
check the balance of your composition with
the push of a button), Flip Layer, Rotate
Layer, Merge Layer (needed all the time),
and Rotate Canvas. Assigning them to
Function keys (F4, F5, F6, and so on)
means they are comfortable to reach.

To get some practice, let's create
a simple Action for ourselves. You
will see that it's fast and easy.

Say we want to create an Action for flipping
the canvas. From the top menu bar,

select Window > Actions, and a panel will
open up showing a default set of Actions
called Default Actions. We could add our
new Actions to this default set, but it is

more organized to have our own set.

Click the folder icon (see 1 in image 08a)
to creale a new set (this will hold our new
Actions) and name it. Now we are ready to
create an Action in our new set. To create
the Action, click on the small page icon (see
2 in image 08a) or select New Action from
the Actions panel menu. A panel will pop up;
name the action “Flip canvas horizontal”
Assign a function key that you would like

to use for this command (you can always
alter the Action later) and hit Record (image
08b). The dialog box will close and a little
red dot in the Action panel will indicate

that we are recording (image 08c)

Now do exactly the steps that you want to
record. For example, from the top menu bar
select Edit > Transform > Flip Horizontal
(the image will be flipped). Next hit the
stop symbol in the Actions panel to stop
recording (image 08c). That's it! If you
accidentally recorded some other steps
with it, you can delete the Action and start
again fresh. To delete an Action click the
small trash bin icon or do so via the Actions
panel menu. To play your new action
simply, hit the function key you assigned



Overcoming a blank canvas

How to generate ideas and take them to the next step

by Benita Winckler

We now have a basic understanding
about the workspace and feel comfortable
about handling our canvas. We have

also gained knowledge about how

to copy and paste content between

files (we will need this soon).

In this chapter, let's do a bit of time
traveling and go right back to the
starting point of any character design!

"Some projects will
demand a highly polished
result, while for other
projects a number of rough
sketches will be sufficient”

Step 01
What does the client need?
What do we need in the beginning? A

cepl. If we are working as a character

cor
designer for a client they will give us

the necessary descriptions along with
the guidelines for the preferred style of
the illustration. We will also be given
additional information such as whether
the design will be used as reference for a
30 madel later on. The more information

we receive at this stage, the better.

Depending on the general purpose of your

illustration, some projects will demand a

polished result, while for other projects
a number of rough sketches will be sufficient.

20

A An early concept I
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A An example of a mood board to refer to when selecting elements Im

for your character design

Another factor to consider is how to
communicate your vision and ideas
effectively. Conveying moods and feelings
rather than technical ideas, for example, is
better done in color (we will discuss this in

later chapters — see pages 36 and 74)

The concept shown in this chapter was to
create a realistic figure of a time-traveling
agent — think Dr. Who mixed with Mary

Poppins, but more modern and a bit crazier:

a foxy eye-catcher who would get noticed.

Step 02

Creating a mood board

You have read the brief and all the
information; you have some ideas floating
around in your mind. Now it's time to fill
your head with inspiration. Photoshop is a
perfect tool to assist you. Simply capture
all your material in an extra document and
name it “mood board". Collect reference
images: everything that inspires you - from

pictures for costume parts and important

ayers Panel Gptions |

Thumbnail Size

Thumbnail Contents

ds

ocument

+ Use Default
' Expan
~ add “copy” 1
Fahe _
-4 1

4

details of the surroundings, to equipment
and supporting accessories, and anything
that visually describes your idea and helps to
communicate your vision. Look for unusual
combinations and follow your instincts
Sometimes you will get inspiration from

unexpected areas; combine and experiment!

For the example character of a time-
traveling agent, | collected various images
of old suitcases (visually indicating the
travel aspect). | locked at images of
stewardesses, pin-up girls, and women

in uniforms for example (image 02a). As

a source for references, everyone knows
Google, but be careful with copyright. To be
safe, check out http:/ifreetextures.3dtotal.
com, or www.cgtextures.com. Also

take your own pictures to build your

personal texture and reference library!

To create a mood board go to File > New
(Preset. Web, say 2500 x 3500), and copy
and paste the elements into it. You will get

5 on Fill Layers

A The layers’ thumbnail size can be changed via the panel menu

* PRO TIP

How to use clipping masks

A clipping mask is a layer that sits on
top of another layer, being clipped

to the exact size of the main layer
below it. Select a layer containing an
element that you want to paint on then
create a new layer. Hit Ctrl+Shift+G
and whatever you paint on it will

get clipped. Clipped layers can be
stacked to any number you like. Hit
Ctrl+Shift+G again and the clipping will
be released, showing you the complete
original layer in its complete size.

lots of layers. Select a lay hanel,
then use the Transform tool (Ctri+T) and the
Move tool (V) to arrange everything nicely

To delete a layer, right-click it in the Lay

panel ct Delete Laye

Layers panel’s thumbnail size, select P

Options from its panel menu (image 02b)
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4 Open a new document 03a

Step 03

Copy T
In the next step let's get some sketching [ pllcsks Loy
Delete Layer
practice! We will start with a basic drawing
to get things going and later loak at
some useful techniques to help break

up the white canvas background

Select File > New (Preset: Web and
1600 x 1200 pixels) and Save the file

as "suitcase.psd’. This will be our new
canvas for experimenting on. It's good
practice ta get in the habit of saving often
and in numbered versions; this is so that
you can go back to your last version

just in case something goes wrong!

In the workspace drop-down menu
select Painting, so that we have easy

ace

ss to the Brush panel (image 03a)
Now instead of sketching directly on

Create a new layer

the white canvas background, we will

use a new layer for our line art

Create a new layer | © C D
it ]

In the Layers palette create a new layer.
You can do this by either clicking on the
new layer icon or selecting a new layer via Delete layer
the Layers panel menu. You can delete a

layer by clicking on the trash bin icon. New

layers are transparent, which is indicated

by the checkered pattern (image 03b) A Create a new layer for the line art




To continue with our example topic of a
time-traveling agent, let's sketch the line art
of a suitcase. It is a simple shape, nothing
challenging, so you can fully concentrate

on how to use Photoshop. Select the Brush
tool (B). Select any brush and set its size to
something small, such as 3 pixels (see image
03a), and from the color swatches palette
pick black by clicking on it. Now on your new
layer you can start sketching (image 03c)

“To move a layer, grab it in
the Layers panel and drag
it to its new position”

Step 04

Setting up a layer structure

Let's go through a simple layer setup for
our painting. We have our example sketch
on the new layer, with a white background
canvas. Why did we sketch on a new
layer? Because we want to be able to

use our sketch as a guideline, so that we

can paint on the layers below it easily.

Next create a new layer for painting. If
needed, move its position in the layer

stack between the background canvas

and the line art layer. To move a layer.

Line art
(checkered
pattern indicates
transparency)

Double-click
to turn “Background™

into a normal layer -
o Lvero

4 The checkered pallern indicates
transparency

grab it in the Layers panel and drag it to
its new position. The background canvas
itself cannot be moved (indicated by a
lock symbol); to turn the background
into a normal layer, simply double-click

it in the Layers panel (image 04a)

A note scanned drawin

When bringing in a scanned drawing,
Photoshop will give us an opague white
layer with the sketch on it, blocking the

sight of everything eise. To get rid of all

A Sketch of a suitcase right on the new layer. Use the Eraser tool (E) if needed

Color

Adjpustments

Layers.

the white areas and to only have the
actual dark line art visible, you can use
the Layer blending mode called Multiply.
It will do the trick! All white pixels of that

layer will appear 100% transparent,

and the dark ones will stay visible

To do this, select the layer in the Layers
panel, then in the Layers blending
mode menu (the field where it says
Normal), select Multiply (see the red
circled parts in image 04b below).

Layers
e @ o T

Channels  Paths

Swatches
Styles

Channels  Paths

e TXONH

100% o0

A Layer setup for scanned drawings




Blending Options
Ganeral Blending

Bland Moda: | Norms B

Opacty: s

Advanced Blending

Fill Opacity

channeli: VR (V] G
2 Use History to step back and forth

Knackout: | Mone

Blend Intericr Effacts 55

' Blond Clipped Layer

Calor Overlay

' Transparancy 5
Gradient Overlsy

Layer Mask Hides Effe:

Fattern Duariay Vactar Mask Hides EFfects

Outer Glow

Blend If: | Gray %

Drop Shadow
This Layer 0 55
-
Undariying Layer 0
-

A The Layer Style menu: a wondrous tool that we don't need for now Im
but that you can use to change settings of blending modes in

Step 05

Painting the suitcase accessory

d up

Our layer stack for the painting of the

SUItC: now should ine  MNow activ

art layer; painting layer; background canvas

painting. F can select any shape, jus

pick a brown col 1 any basic brushes. Ric

k on your canvas
You

e set to s¢

jouble- brush (s

-name the layers by ling bigger, say the Eraser tool active and select a

clicking on their name. If you don't hit the 40 pixe

t the area marked by your new brush t

for it (image 05c¢). If you

name properly (it is easy to miss), it will line art. To go back and forth in the history like an explore different shapes for
bring up the Lay menu instead of your steps, use the History panel. Try your chal er's item to ave different
(image If this pops up, simply playing with the Opacity settings of your variations of the bag accessory (image 05d)

LE B e B e e B A o

i . 954 G, KGR ©
Experiment with the Opacity for your brush

Right-click to open Brush menu
(works for eraser tool as well!)

Layer for basic painting

A With the Brush (or Eraser tool) selected, right-click on your canvas to open the Brush menu 05c
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4 Some more examples for the bag accessory. Explore and try cut various shapes for your character’s important item

In the next step we'll look at adding some

interesting textures to our basic painting

and then we'll refine the painting further

Step 06

Working with textures

Save a copy of your last document. We need
the layer set up like before: line art layer on
top, paint layer, then background canvas

Starting with a mid-value background

Instead of a white background we'll start

with a mid-value background. That way it i Briic shapiaseid picione baskground S Deflnciihe dvecton ottt sounce

Shifts Carls N

Duplicate Layer...
Delete Layer

New Group..
New Group from Layers...

Texture layer

Convert to Smart Object

Blending Options

Create clipping mask

Merge Dewn Ctr-E
Merge Visible Shifts Ctrl £
Flatten Image

Animation Options 0
Panel Options...

Close

Close Tab Group

A Adding texture to the suitcase
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provides us with the ground for working
in both lighter and darker values.

From the tool menu on the left of the screen
select the Paint Bucket tool (shortcut G). In
the Layers palette activate the background,
select a nice brownish gray from the
swatches (not too dark, not too saturated),
and fill the background by clicking on it.

Painting the suitcase shape

Next, activate the paint layer (between

the canvas and line art) with a click in the
Layers palette. Select a slightly darker value
and paint the basic shape of the suitcase.
The result could look like image 06a

Define the light source and light direction.
In our example the light comes from

the top-right. Select a lighter brown

from the swatches for the areas that

will receive light (image 06b)

Selecting a texture

Next we will break up the CG look by
bringing in a texture. As an example
we will use a photographic leather
texture taken from the free library at
http://freetextures.3dtotal.com.

Using a clipping mask

Now for the textures, we'll create a clipping
mask so that our texture will be clipped to
the exact boundaries of the painting of our
suitcase area. Clipping masks on layers
are really helpful whenever you are working
with individual elements in a painting.

Copy and paste a leather texlure on a
new layer above the suitcase painting, but
below the line art. Transform and rotate
the layer as needed (Edit > Transform or
Crl+T). Select the paint layer, as this is the
layer we want to apply the clipping mask
to, and then from the Layers panel menu
select Create Clipping Mask (image 06c)
Now the texture will only be visible in the
boundaries of the suitcase outline; the
rest will be clipped/deleted (image 06d).

Blending the texture

For a smooth effect we'll have to adjust
the texture a bit more. First, reduce the
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Reduce opacity of texture

Try different layer modes

Texture is clipped to layer below

4 Clipping the texture layer. Note the small indent in the Layers panel indicating that the layer is
now clipped to the layer below it

A Layer mode set to Color Dodge

A Layer mode set to Qverlay. It looks like a good choice; the result is not too light and not
too obtrusive




opacity of the texture layer. Now, to further

blend the texture with our painting, wi
will try some of the layer modes. The
all

lightness or darkness of your texture

best effect will depend on the ove

Image 06e shows a layer mode with the
texture layer set to Color Dodge (which is
a little too bright for our purpose), while
image 06f shows the effect with the layer
mode sel to Overlay, which is just what
we are looking for! Experiment with the

other layer modes as well (image 06g).

In the next steps you could add a basic

texture for the floor layer as well. There
will be no need for a clipping layer.
Instead, simply copy and paste a texture

in, so that the new layer lies between the

Color Picker (Fareground Color)

background and the suitcase. Adjust the

opacity for a subtle effect and erase and

re-paint the floor as you like (image 06h)

Next we want to cover up our line art
by painting over it. To do so. add a new
layer on top of the line art layer. To
achieve a coherent look, bring in some

of the colors of your background to your

main object and vice versa. Use the

Eyedropper tool (1) to do the color-pi

king
e Color Picker (image 06h). Tip

oru

to quickly switch between the Brush tool

and Eyedropper tool, use the Alt key.

Textures are a great way to get a painting

going (or to add some final touches)
However, don't rely on them too much

— bring in your brushwork as well!

7 "1;". »

Channels  Paths

EeToa "

Layers

4 A selection of layer modes. Try to find a
subtle effect for blending your texture

A You can select the colors via the Color Picker tool as shown. A “high voltage” sticker texture is added to the suitcase via Color Dodge



Setting up your brushes

How to organize your brush sets for a faster workflow

by Benita Winckler

If you want to work efficiently, a well-
equipped and organized brush set is
essential. Certain brushes are more
suitable for particular tasks than others.
On the pages that follow, we will discuss
how to use the Brush panel and how to
save a set of brushes of our own. We
will also look at how to create custom
brushes for various purposes, such as
for painting the skin of our character.
You can see other uses of custom
brushes on pages 154 and 156.

AR AMEPANBAN W AT

BCLltee

A Use custom brushes and textured brushes to bring “life” into your artwork

Brush Presets

L]

LU

—
- ————
e
e ee—
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e
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A Look for the little icons — some brush features can be accessed in more than one place!
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"If we want to create a
believable character, we
need to somehow get rid
of that clean computer
look. Custom brushes (and
textures as well) can really
help with this!”

Step 01

The challenge of working digitally
Closely related to the brushes topic is one
major challenge that digital artists usually
need to face. The term “digital” already
gives it away; it is the danger of creating an
artwork that looks too computer-generated
If we want to create a believable character,
we need to somehow get rid of that clean
computer look. Custom brushes (and
textures as well) can really help with this!

As always, the human eye loves a bit of
conirast. So, if we try to bring in some little
imperfections while painting, we'll be able
to better mimic the features of the real
world around us. As a result our artwork
will look more convincing and also way
more sensual. Think about putting a hint
of dust or some scratches on an otherwise
pristine surface to break up that CG
perfection. The key is to aim for variation!

Step 02

Creating a new brush set

Photoshop has a wonderful brush engine
However, on first sight the panels can

look confusing with the options to alter the
brushes quite spread out (image 02a). Let's
see where we can find the important parts!

Looking at a fresh installation (in Painting
mode}, you will be presented with the
default set of brushes in the Brush Presets
panel (image 02b). Photoshop calls the
brushes "Brush Presets” because for each
brush displayed, a number of features have
been defined, such as hardness, spacing,
size, and Pen Pressure sensitivity.

We want to create our own set, then alter
and create new ones, and importantly,
change their position in the list, so that we
have easy access to the ones that we need
most. Creale a new brush set by selecting

|
TR
R
P i’
E—
L e
N
-
E—
.
e

A Brush Presets panel default thumbnails

Save Brushes from the Brush Presets panel
menu (image 02c). In the Save dialog box
assign a name for your set and save itin a
location that you can remember. Right now
the set will hold a copy of the default brushes
because we haven't changed anything yet

To get the defaults back, hit Reset Brushes
in the panel menu. You can experiment with
other brush defaults from the menu, too
Either Reset or Append (you can choose
between these two options in the dialog
box ance you hit Reset Brushes). The

latter will add those brushes to your set.

Appending brushes can cause your list
to grow quite big, so it is good to be able
to arrange and delete brushes to make
your brush library more manageable.
Let's see how in the next step

Mew Brush Preset...

Text Only
Small Thumbnail
Large Thumbnail
Small List
Large List

v Stroke Thumbnail

Preset Manager...

Reset Brushes...
Load Brushes...

Replace Brushes..,

Aszsorted Brushes
Basic Brushes
Calligraphic Brushes
DP Brushes

Drop Shadow Brushes
Dry Media Brushes
Faux Finish Brushes
M Brushes

Matural Brushes 2
Matural Brushes
Round Brushes with Size
Special Effect Brushes
Square Brushes
Thick Heawvy Brushes
Wet Media Brushes

Close
Close Tab Group

Background

A Select Save Brushes to create new set
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"You can create new
brushes by using the
Brush panel. The new
brush will hold exactly
the settings that are
currently selected”

Step 03

Using the Brush panel

We have saved our brush set, now let's
explore how to create new brushes and then
arrange them for an efficient workflow. You
can create new brushes by using the icon on
the Brush panel (image 03a). The new brush
will hold exactly the settings that are currently
selected. Assign a name and hit OK. The
new brush will be added to the list (scroll
down to see your new brush). In the following
chapter we will explore the Brush panel,
seltings, and custom brushes in more detail
For now though, just try creating a new brush
by hitting the icon as shown in image 03a

Now let's discuss how we can
rearrange and delete brushes. We
will use the Preset Manager

Right-click a brush to delete or rename it

Hame:

A Create a new brush to be added to your set

PREBEERRERERRB

4 EeTon”"
Brush Name

tock: B 2 3 B
O‘i\e-—l
- IS

Hard Round 13 1 - TEST oK

| Capture 8n

¢h Size in Pracet

Create a new brush

i
f

]
E
PERERRRDRER DD
EELERERET ]

i
i

Various ways to access
the Preset Manager

A Use the Preset Manager to manage your brushes: you can arrange their position, rename, or delete them



Preset Type: Brushes =
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W

Preset Manager

Text Only
Small Thumbnail

= : T
Large Thumbnail

e fy Ay et Small List
_‘__ Ly, L M, e ,_;LE-E—EL
Y e VRO, =
24 4 mw Reset Brushes
~ . 4 Replace Brushes...
F Assorted Brushes
e 35 Basic Brushes
~ Calligraphic Brushes

DP Brushes

Drop Shadow Brushes
Dry Media Brushes
Faux Finish Brushes
M Brushes

Natural Brushes 2
Natural Brushes
Round Brushes with Size
Special Effect Brushes
Square Brushes

Thick Heavy Brushes
Wet Media Brushes

-y s —

4 Select Stroke Thumbnail from the panel menu to see an example of the actual brushstroke

"Don't forget to save your
altered brush set once you
have made changes to it -
itis easy to forget!”

To rearrange the brushes, simply grab them
and pull them to their new position. Explore
various brushes to find your own personal
favorites and then arrange them in a fashion
that feels most comfortable to you. If you
want to delete (or rename) a certain brush
from your set, righl-click and select Delete
(or Rename) Brush (see image 03b). To
see the actual brushstroke of our brushes,
select Stroke Thumbnail (see image 03c)

Don't forget to save your altered brush set
once you have made changes to it (see step
02) - it is easy to forget! Also save your set
if you want to reset your brushes or want to
explore the other interesting defaults such
as Dry Media or Calligraphic brushes

% PRO TIP

You can control the opacity of the brush via

trait lies in the Opacity slider itself. To have
more control over your brushstrokes, you
the individual brush setting itself (Transfer >
Opacity Jitter: 0%; Control: Pen Pressure).
You can also do so globally for all brushes

can globally set the opacity to a maximum
of 40 or 50%. This way ever'y brushstroke
you make will gently blend into the whole

via the icon in the top menu bar (see image  and add to the painting. This can be very
below). If the icon is checked it will override
all Brush presets and instead Pen Pressure

will be used for all brushes. This is a great

useful, especially if you work on delicate
areas where you need soft transitions.
For bold design choices, however, make

little feature; however, the really interesting S|

you set the opacity back to 100%.

Brush T Shape
‘Shape Dymames
Scatterng
Temure

Oual Brush

4 Control the level of opacity of your brush individually via the Brush menu
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* PRO T|P You may have noticed that most brush tips are circular — however
Altering brush hardness and tip shape this can be changed easily! Want a nice oval to work with? Simply
The Brush menu offers some simple but effective ways to adjust the two anchor points in the circle icon as indicated in
alter your brushes. Not only can you adjust the size, but the image below. You can also adjust the angle of the tip, by

also the hardness of a brush. Right-click with your tablet/ pulling at the small arrow. Oval brush tips are highly useful as

mouse to open the Brush menu. Pull the slider for Hardness they offer a varied brushstroke which will give you more control
o to get a soft, fuzzy brush edge and pull the slider in your work (this feature works for custom brushes as well).
to get a hard edge. (Note: the slider will not be
2 for custom brushes, just for basic ones.)

A You can alter the hardness of the basic brushes via the Brush menu. An oval brush tip can be useful for control

"You'll need a brush that

assists you in making bold _

statements. No fluff or = L@l

fuzziness but a hard edge” Emmm '“""
- ~

Dl Brush & 7ot seale
Calor Dynarmics

T Transfer
Brush Pose

Step 04 &
&
&
Nose ﬁ
&
&
&
5]

The secret of the hard-edged brush
Let me highlight one of the basic brushes
that is particularly useful for character
design! It is the solid hard-edged brush Wet Edges
Why is this one useful? Because in the
early design phases, you'll need a brush
that assists you in making bold statements
No fluff or fuzziness but a hard edge

The trick is that it will force you to focus on
the basic shape of your character design T Flip X Jter T Fip Y Jter

which is highly important, because shapes 7 Brush Projection

are among the first things we notice and it Control the tip shape via “Pen Pressure”

"_\—"’

is vital to get them right (see the chapter
on form and anatomy in the next section)

Set Shape Dynamics to Pen Pressure

to achieve a nice brushstroke (image

A Brush panel with settings for a simple hard-edged brush 04a

04a); hard-edged brushes are ideal
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ArLf

A Explore the silhouettes of your character. Use a hard-edged brush to find out which shapes are needed to tell your story l
to explore the silhouettes of your R Joeoe ; Tlayer. Type S Skt ey 30 View! Window . Help
character design (image 04b). B et WERTTNE opct oo 7 @ e o Bt &

Good silhouettes are easy to read and
Note: checking that button will set opacity to “Pen Pressure” for all brushes,
this will enhance the effect your character regardless of individual settings
has on your audience and give your
viewer some visual clues about what to
expect from your character. To achieve
this, you don’t need thousands of tiny
little details. Keep it simple; reduce and
enhance. Which features are needed to

tell your story? Which can be omitted?

Step 05

Brushes suitable for painting skin
When painting characters, eventually at
some point the topic of “how to paint skin

will crop up. There is no secret formula for

how to paint skin; however, some brushes

will be better suited for the task than others

Try to start with a hard-edged brush, either
pressure sensitive or non-sensitive (image
05a). Once the planes and the lighting Control the opacity (“Transfer”) via “Pen Pressure”
are defined you can switch over to some
speckled brushes (see image 05b on the

next page) and finally you can go over

the painting with a soft-edged brush to

A Always use Pressure for opacity. When this is off, the Brush Preset controls the pressure 05a

smooth out some of the harsh edges
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Speckled brush for painting skin

€ uEnieE®
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Transfer set to Pen Pressure

A Use a speckled brush to further refine the skin 05b A If you need to paint freckles, use a speckled brush at the final stage lm

Step Backward

Define Brush Preset

in the pop-up assign a
name such as “Hair_1"

Brush Name

Define Pattern.

Adrbe PDF Presets
resets
Remete Cennecticns

Keyboord Shomeuts
HMen
P

benta.wincklerSgmad.cem

A The process of how to create a custom brush

Skin is soft, but the underlying structure

is not. It is a common mistake to start
painting the skin with a soft brush, only

to end up with a blurry, shapeless mess.
Keep in mind that the skin is just the top
layer of something that has volume and
form. Always start with the idea that you
are painting an object in 3D space. If you
notice towards the end that your painting has
lost its life, it could be due to the fact that
you overdid it with the soft brush. Get back
in there and bring in some brushstrokes,
add texture, and do everything to avoid the
clean CG look that we talked about earlier.

Also remember that a character's impact
on the viewer will not depend on how
many freckles we paint on the skin — don't
over use custom brushes or rely on them
as a foundation for your character. If you
absolutely need to paint freckles, as your
character close-up demands it, you can
use a special brush for it (image 05c)



Add texture to the brush

T Color Dynamics
¥ Transfer
Brush Pose

Naise

Wet Edges

L)

@ Texture Each Tp
Mode:  Calor Burn
Depth

a
&
@
@
@&
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@
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Play with the settings

4 Our new brush right after creation

"Using a variety of brushes

will lead to greater
variation in our brushwork
and it will help you to
communicate the material
you are painting better”

Step 06

Create your own custom brushes
Using a variety of brushes will lead to
greater variation in our brushwork and it
will help you to communicate the material
you are painting better. Let's go aver the
process of how to create your own custom
brushes, so that you can make your own
brushes for special tasks. As an example
we'll create a speckled brush suitable

for (but not limited to) painting hair.

Create a new document (set to Web)
and set its size to 100 = 100, keeping the
white background. This will be the basis
of our brush. We will now paint what

will be the tip of our brush with black

Everything white will be transparent.
Select any brush with a small size of 1-3
pixels. Now put down some dots onto

Minimum Depth

Depth Jitter

Off

Important: save the altered brush!

Brush Name

Name:

| Capture Brush Size in Preset

oK

Cancel

4 To get a more natural look and to bring in some variety, you can add texture to your brush

the canvas. From the Edit menu select
Define Brush Preset and in the pop-up
assign a name; confirm with OK (image
06a). The brush will now show up in
the Brush Presets list (image 06b).

Let's refine its settings so that we can

use it effectively. As discussed earlier, itis
important to get variety into your brushwork
to achieve a vivid look. The texture setting
is especially interesting here, as it allows
you to add textures and variety to your

brush (image 06c). If you want to paint fur or
grass materials, you can create a brush tip
consisting of small strokes instead of dots,
and then combine it with Scattering (above
Texture in the Brush Presets panel). You
can also enhance the effect by using the
Shape Dynamics: Size Jitter/Angle Jitter.

There are many possibilities so |
highly recommended that you try
out the various brush settings. Have
fun - and don't forget to save!

w
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Setting up your color swatches

How to work with complementary colors, use the Color Picker, and convey moods

by Benita Winckler

In addition to technical concerns (such as Visible light

how to work with complementary colors 400 500 500 700

or how to set up color swatches), we also T S s

need to know about the psychological and i |

physical effects that colors can have on w
us (consciously or unconsciously). What
is the response we want from our viewer? A Color spectrum of visble light: warm red at one end, cool bluelvilet at the ather | 012 |
Which colors convey a certain mood
most effectively? We need to ensure calming or sad; think of “feeling blue” be linked with solitariness, royalty, and
that we communicate the right things. or being “ice-cold” (image 01b) spirituality. It can also be associated with

mythical topics and otherworldliness
Step 01 - Green is associated with nature,
Some colors and their effects health, and growth. It has a calming We will explore the many effects and
Image 01a shows an illustration of the and relaxing effect (image 01c) uses of different colors and color
spectrum of visible light. Let's break combinations further in the “Storytelling
it down to get a quick overview. + Violet is a combination of two very different and moods” chapter of this book

colors: cool blue and fiery red. It can (see pages 74 and 76-78)

* Red is eye-catching, exciting. and demands
atlention. It's a very active color. Hot,
aggressive, and sensual. Think of glowing

fire, blood, fruits, or poisonous fungus!

« Orange is an attention-grabber, it's not as

demanding as red. but is still very warm

and can be associated with youthfulness,

fun, ambition, and high energy.

= Yellow draws attention and is associated

with optimism, happiness, sunlight, and

warmth. But it is also used as a warning

by some animals, such as wasps.

* Blue

cool and distant; you associate A The blue color scheme adds a cold A& The character is more approachable

atmosphere to the image due to the warm, golden, green tones
it with the sky, air, and water. It can be
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Color Picker:  adobe v

Intarface =

Syric Settings UD Color Picker,Mue Wheel (Small) v
Hue Strip (Small)

Hue Strip (Medium)

Options Hue Strip (Largsj

File Handing Image Interpolation:
Performance

Cursars

_] Auto-Update Ops Hue Wheel

Hue Wheel (Medium)

Beep Wh )
ep When Done | o obeal (iaioe)

| Dynamic Color Shdefs™

Transparanzy & Gamut

Units & Rulers

Guides. Grid & Slices

Plug-ing [¥]Export Clipboard
Tvee | Use Shift Key for Tool Switch
it

[¥| Resze Image During Place

[+] Animated Zoom

[ ] Zoom Reszes Windows
[[1Zoom with Scroll Wheel
|_|Zoom Clicked Point to Center
|¥|Enable Flick Panning

[¥ Vary Round Brush Hardness based on HUD vertical movement
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History Log

A Setting up the HUD Caolor Picker

Step 02

Using the HUD Color Picker

There are several options you can use
to select your colors in Photoshop.

One feature is the HUD Calor

Picker. Let's set up this feature

In the top menu bar select the Edit menu
and choose Preferences > General to

above). To use the Color Picker feature,
select the Brush tool (B), go to your
canvas, and practice the following:

- Alt+click the canvas to color-pick
the normal way (image 02b).

= Next try holding down Alt+click while
open the Preferences panel. We want
to look at the Hue Wheel, so select it in
the drop-down menu (see image 02a

hovering over the canvas. You will get
the option to alter your brush size by

Alt+click canvas

\ .

m A Alt+hover-click allows you to change
the brush size

A Exploring the HUD feature does take
‘some practice

Select the HUD Color Picker “Hue Wheel”

moving/hovering to the left/right (image

Alt+click hovering over canvas

0K
Cancel
Prev

Next

02c). If you moverhover up and down you
can change your brushes’ hardness.

* Hold down Alt+Shift and click; the canvas
will set a color sampler on that spot. To
get rid of it again, simply click it another
time with that key combination held down

and it will be removed (see image 02d)

A Alt+Shift+clicking the canvas will set a

color sampler. Click again to delete
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"One useful technique for
creating color swatches
from a photographic
reference image is to use
the Mosaic Filter”

If instead of clicking the canvas directly
you hover and click, the color wheel will
open (see image 02e). Keep all

keys
held down (also on your pen) and you
can move around the wheel to select a
new color, while being able to see the
color's position on the color wheel. If you
need to find a color that has the greatest
contrast to another chosen color, have a

look at its opposite position on the wheel

Step 03

Color swatches are useful if you need to
create your character within a certain given
color scheme. Maybe your client has already
given you a painted image with some colors
for reference, and then you can color-pick
from that (image 03a). Or maybe you were
given some photographic references, to
create something that will have the same
look color-wise. In this case it can be a

bit more difficult to do the color-picking

One useful technique for creating color
swatches from a photographic reference
image is to use the Mosaic Filter, turning

our photography into a mosaic

Psn.-.axl-n;lq«rm-sim_-
I BT rehe om

ol _pracock welerence.gud @ 10 (1 ayes 1,

Open a beautifully colored photograph

to use as a base. We want to copy the
background layer to have something to
go back to, so select All (Ctrl+A), copy
(Ctrl+C), and paste (Ctrl+V). The new
layer will be used for the filter. Click on
the layer to activate it, and from the Filter

menu in the top menu bar select Pixelate

> Mosaic (see image 03b). Depending on

the ¢

> of the blocks, you will get a good
variety of the major important colors
suitable

Experiment with the size, to geta

result — that is, where you can clearly see
the tiles of separated colors to pick from

(image 03c). Next pick your colors from the

mosaic and paint your own palette (either

A Brush selected and Alt+shift+hover- E
clicking it will open the HUD color wheel

on a new d ment, or directly on a new

layer of your main character document)

Darkest dark

E Lightest light

1o note, as they are great to use for
_ulng the Mosaic Filter may cause you to lose some
im the original source to add to the color swatches

A Create a mosaic out of a given reference image to achieve a basis for a possible color scheme. Play with the settings for the block size 03b



oK
Cancel

Load.

[ow]

A Click on the empty slots to open the
Color Picker and select a new color

Due to the reduction of the colors, you might
lose some pretty highlights and dark values
(refer to image 03a). To add them to your
color swatches, hand-pick them directly from
the original phaotograph with the Eyedropper
tool (1) and paint them on your palette

Step 04

Color swatches from index mode
Indexed Color mode uses a color look-
up table to create an image. It is a
method for creating 8-bit, 256-color
files. It is useful for saving disk space
and creating web-based images

Open your reference photo. To keep it
simple, take an image of JPEG or PSD
format. We will use peacock feathers again
We will be messing around with this image
in a second, so make sure you save it under

a new name so you can safely play with it

What we want to do is extract a number
of beautiful key colors, while omitting the

Where is our color table file?

Fip ame

gL

L8 B e T

’_f’ _ﬁ"‘*‘#.' ey

indexes Color

g

A Play with the numbers and watch the image change accordingly

Important: change this to “Color Table” (*.ACT)!

2]
A ’ _yi

F
4 To locate our new Color Table make sure to set the file type to Color Table ACT Iﬁ

superfluous ones. But this time we want to
create a set of Photoshop color swatches
from the image. Color swatches can then
be loaded, saved, or even exported to
other programs such as lllustrator.

From the top menu bar select Image > Mode
> Indexed Color. In the pop-up menu enter

a small value and watch how the image
changes accordingly (set Dither to None to
achieve clear color shapes instead of dotted
transitions) and hit OK (image 04a). To get
our swatches from the indexed image, select
Image > Mode > Color Table. In the pop-up
menu you can see the swatches; hit Save

assign a name, and hit OK (image 04b)

Let's open our new Color Table (image
04c). In the Color Swatches panel menu

4 To add more colors click the icon as
shown above

either click Load Swatches (to add the
new swatches to the existing ones; image
04d) or Replace Swatches to replace the
existing ones with the new set. Note that
you should make sure that in the pop-up
menu you change the file type to Color
Table (ACT), so that your new file will be
displayed. Select your file and hit Load



4 Black-and-white sketch. It is useful to
focus on the lighting first

Channels Paths

Layers

A Repaint the colors of some areas using
a new layer with the blending mode set to Color

Step 05
Coloring the character

Paying attention to w

e the main light

g from, paint in your light

and dark areas. Starting in grayscale helps

ermine yo s without getting

ted by color options. With your

and-white charar finished

atching, time-travel

The character desi

when the ac
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A The chosen color scheme: red, electric
blue-turquoise, yellows, and chartreuse green

For her time-traveling equipment | chose

the warning colors of a wasp to indicale the

ger. Think about those yellow

ack “Danger! High voltage!” signs

n in image
05c. Set your layer mode to Color, and

place the layer on top of the black-and-white

tch layer, so that it ton

everything. It

will be the dominating color for the artwork

The next element to color was her

suitcase. It holds something special that

is of

t importance. An attention-

slor is needed: red!

oping, color

ges, we can use the

Layer modes, or

command for Hue/Saturation. Let's start

the Layers mode for color changes

ment create a new layer on top

ainting layer. In the Layers

panel select the Layer blending

e, Color

). Now paint the areas you wish

can use the Adjustments

A Adding the dominating color. The color
layer is above the sketch layer, toning everything

"Another really fun
technique you can use

is to invert the colors

of your current layer by
hitting Ctrl+| to give a
photographic negative
effect. If only used on one
part of an area in your
image it will give you the
maximum color contrast”

to change the color of in the new color.
When you have finished, merge down that

layer (Layers panel menu > Merge Down)

To change the colors of an existing layer,
or to alter the colors for the whole image.
use the command Ctrl+U. This will bring
up the Hue/Saturation dialog box (image
06b). You can play with the settings by
maving the sliders to achieve some fresh

ideas for possible color schemes!

Another really fun technique you can

e
is to invert the colors of your current layer
by hitting Ctrl+l to give a photographic
negative effect. If only used on one

vart of an area in your image it will give

you the maximum color contrast

Image 06¢ shows the final character so you

can see the effect of the final colors chosen



Hue/Saturation

Saturation

Lightness

A Use the Hue and Saturation command to play with the colors A Final character

% PRO TIP

You have an iconic
candidate!

When designing characters and
you are not sure if your ideas
work, it can be helpful to translate
your design into a new style:
say a comic figure, a children’s
drawing, or a caricature of your
original. Something reduced,
that will show the important
parts. Are you are still able to

recognize the character? If

yes, there is your hint — you
have a good thing going!

A A children’s drawing of the character

Children’s drawing of the character

*
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Establishing your
character

Discover key art theory techniques and top tips to present
compelling and recognizable character designs.

You now have the knowledge to set up your workspace and tools, but
how do you go about designing a convincing character? In this section
Benita Winckler will present some notably recognized theories linked
to depicting a character. Starting with form and anatomy, Benita will
then take you through character types, composition, storytelling, and
moods, using images to demonstrate definitions and discuss the clues
and tools behind communicating an effective character creation.



Form and anatomy

How to portray your character through the use of body types and gestures

by Benita Winckler

A
|
!

3

X,

)

\
=

The human interest in portraying
characters has a long history, in some
ways making character design an ancient
art form. Nowadays artists have the
mighty Photoshop available, but the basic
problems of how to present a character
in the most compelling and recognizable
way still remain. To make a character
design work, you need to consider

many different aspects, including form,
shape, posture, and facial expression.

It's also important to understand that it
all starts in the mind of our audience.
The more we know about the clues
and magic tools behind the art of
communication, the more powerful
and effective our creation will be.

A character consists of much more than
just his or her high-tech armor. If we can
manage to scratch at the surface and
bring out what is behind the fabric, metal,
or painted mermaid scales, then we can
show our viewer a real “person” and they
will be able to make the connection.

Step 01

Form and anatomy

Form is one of the first things we perceive
when looking at a character. Based on the
appearance, the anatomy, and the pose
we start to make assumptions on what

we can expect from the character in front
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JHeAds

4 The human figure is about 7-8 heads high as a guidline

of us: for example are they a friend or a

predator? Strong or weak? Young or old?

When taking in the available information

about the world around us, our brain starts

to generalize; we run internal scripts and

then certa

1 responses are {i

ed. This

ast and ¢

ten w

happens lighter

our conscious awareness. The result c

JFHeAds

[ o |

be that we are afraid of someone, or that

we feel drawn to them, for example

Looking at a baby, for instance, will
trigger emotions of protecting something
helpless, while looking at an image of a
powerful attacker will trigger feelings of
fear, awe, or antipathy. This all happens

level

on a deep, subconsc



Using shapes for character design

ation

the human f

that the fema i
less angular than the male. These kind
lifferences in the overall an |

wit ffect as we will ¢ t

> form and the

are so important when it comes

sed on our

are able tc

assign different

to different kinds of she

mage 02a)

Think about a

spiky, and probably has sc stre lines
Reducec ape this can give yo A Basic shapes can enhance the personalities of your character design. Triangles = dynamic |m
sharp, dangerous. Circles = calm, friendly, soft. Squares = static, strong
3 triangle this idea is taken further, y
ould enhance your charact 0y
apes
dge
rnatively, think about a round ¢ ke

ar or an apple. These

ess and

ntleness often

female charact

attribut

it flowir

Another basic shape we can use for our

designs is the square or rectangle. Its

attributes are

are reliable. T

ed in your

4 Combine basic shapes for new characler ideas! Here, a round head shape (friendly) plus
some spikey triangles (possible danger) creates a rascally beastling
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* PROTIP

Break the rules
Playing with these shape stereotypes
and “breaking the rules” can add a lot

What about creating a feminine-looking,

male villain with long hair and dark
eyelashes? Or a male-looking, strong
heroine? Try angles on a female or

soft rounded forms on a male.

Step 03

Differences in female/male portraits

So, what is it that makes a male face look
“male” and a female face look “female™?

If you take a look at image 03a, the generic

male has hard lines, angularity, features
as if chiseled from a rock, a strong jaw-
line, and a square chin. The female portrait
shows delicate, rounded features, overall
soft curves, and no harsh angles

To produce a male-locking portrait, draw
the head shape a bit squarer and more
angular, make the neck shorter and
thicker, and add the Adam's apple

For a female head, draw the lines rounded,
with less sharp corners. Her neck will

be longer and thinner with soft curves
instead of straight lines. The skin tones
can be darker for the male, indicating
rough features and a hint of facial hair; for
the female paint the skin light and silky.

For your female portraits, paint the
eyebrows in a fine soft curve. You can see
the effect of masculine bushy eyebrows
on a female portrait in image 03b

For females paint the eyes more open
and bigger than the males’. To enhance
the female touch you can add eyelashes
and eye makeup. For females paint the
nose delicate with finer features.

Female lips tend to be fuller; however

males can be equipped with beautiful
lips and still look masculine
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4 Generic faces in comparison. Notice the differences

Step 04

Facial expression and mood

Unless our character is a very good actor,
poker player (or has had lots of Botox
injections that prevent the facial muscles
from working), we will be able to tell his

or her emational state from the facial
expression and the look in their eyes (image
04). Are the eyebrows raised or furrowed?
Are the eyes wide open or droopy half-
awake? Is the mouth relaxed? Smiling?

There is a great variety of emotions, positive
and negative, and our facial features will
display them accordingly: happiness,
pleasure, interest, disgust, anger, contempt,
fear, and surprise, just to name a few.
However it will help a lot if you don't just stick
to these basics; instead try to invent some
sort of context for your character — a story, a

4 Thick, bushy eyebrows for females will Im
create a masculine effect



A Depending on the intensity of the emotion, the whole face will be affected, stretched and
twisted, by the expression

Eye contact!

"'_-»/'

special situation that he or she is confronted
with — so that you can come up with better

fitting expressions with finer nuances

"A look can be challenging
or inviting; it can signal
interest, involvement and
warmth, fear, sadness; or it
can seem brutally cold and
intimidating”

Step 0

How do you give your character that special
look”, which really brings them to life?

Just as in the old saying, “the eyes are the
window to the soul”, you can use the eyes

of your character to communicate how they
feel and what they are thinking. A look can be
challenging or inviting: it can signal interest,
involvement and warmth, fear, sadness; or

it can seem brutally cold and intimidating

If you take a look at images 05a and 05b
below, you can also see that a portrait

of a character that is directly looking into
the c

era can have an intense effect
on the viewer because of the connection

that will be established - it address

=
and involves the viewer directly. This can

be a useful trick so keep it in mind!

A Characters who look directly into the camera can create an instant Im A Hiding parts of the face behind a mask will obscure the expression 05b
connection with the viewer. Use this little “trick” to engage the viewer of its owner, causing the viewer to guess what lies behind it



A Cultural stereotyping

Step 06

Body types (somatotyping)

Are body types relate: ecial character

traits? According to Dr am Sheldon, a
US psychologist who studied the variety of
human bodies and temperaments, they are
In the late 1930s he created his “somatotype
system. Having taken pictures of thousands

of people for analysis, he discovered

three fundamental elements which, when

combined together, make up all body types

A Some generic female body types

48

on calls his three somatotypes

tomaorpt

>, mesomorphic, and

endomorphic. Of course we all (men

women) have these components

in varying degrees; nc e is simply a

mesomorph without having the other

elements present even a little

But the easiest way to

get an idea of the

variety of human physig

s by looking at

the three extremes (see also image 06)

* Ectomorphic: long, thin limbs and

thin muscles with low fat storage

They don't build muscie easily
* Mesomorphic: muscular, strong, with large

bones, moderate fat levels, and a solid

torso. Predisposed to build muscle easily.

* Endomorphic: wide hips, medium

shoulders, with a medium bone struclure

They gain weight and store fat easily



4 More categories for female body types

Certain physiques carry certain cultural
stereotypes. For example, mesomorphs

(muscular) are perceived as popular

hardworking, whereas endomorphs (fat)

seen as being lazy and slow. Ectomorphs
(bony, thin) are stereotyped as being
intelligent but fearful, with a strong love of

long-distance sports, such as marathons

Presumptions also include the idea that
endomorphs are sociable and easy-going

mesomorphs are adventurous, bold

competitive, aggressive, and energetic, while

ectomorphs are introverted, inhibited, and

cretive. So th

ape of your character

can convey what type of person they are

Step 07

Categories for body shapes

Study the differences in form and shape
in our fellow human beings. By closely

examining the people around us, we develop

a keen eye for the rich variety of proportion

that exist. It is like building a visual reservoir

to use for our character designs.

In general you will want your female

characters

appear more d

their male counterparts. Think soft
instead of hard angles. Females tend to have
higher levels of fat to be stored in their bod
compared to males. This will also affect the

in females the buttocks

body fat distribu

hips, and thighs will be more rounc than

those of males; males will be more muscular

Images 07a and 07b give some examples

of different boc 'apes that can be used to

e female

categorize y. Obviously there

is no fixed rule and there are wide ranges

ape. With an

of actual sizes within each st

shapes and variations you can
create pretty much any type of character

you want. Don't draw all your women (and

A Explore the effects of different poses by using silhouette drawings. The shape alone can
communicate a lot about the inner state and mood of a character

07b

men) the same tho

h! It happens often

that we adapt to one way of dc

and then we get lazy and repeat what we

have learned in. Explore

the differences and try some variations!

Step 08

Poses, balance, and movement

When drawing a character, it is important to

understand that the human fc

is a delicate bal

every

step, we set the ma:

ses of our body into

m

This can look graceful or not. The

various ways in which people walk is a g

of inspiration for characte

gn

Depending on the energy a character

puts into the movemer

t can be a
presentation of confidence, the head and
body held upright, challenging the world, or

if the energy is missing it can be

sloppy
eated and

maneuver, with the character de
slouching along, with drooped shoulders
and hanging arms. These qualities will

show in their silhouettes (see image 08)

% PRO TIP

Silhouettes

Silhouettes are a great tool to explore
the effect of a pose, to check if it
really works. Also, they act as a

quick way to focus on shapes and

designs that make a strong impact on
the viewer. A good character will be
easily recognizable as a silhouette
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Step 09
Curves, rhythm, and motion
Since character design has a lot to do with

producing an emotional response from i
the viewer, the more life-like a design, Symmetry: E@‘i
the easier it will be to connect with our passive, stiff {2
(a bit boring)
audience. We need to caplure the energy =

and attitude of an imagined, “living” being.
In a drawing we can work with the lines and
curves to tell our story and give a sense of
movement and excitement to our creation

Asymmetry:
interest, action,
excited movement

In image 09, you can see the effect that
symmetry has on a pose. It will look stiff,
dead, and a little boring. But, if our model
Is presented in an asymmetric pose, as
seen on the right side, the flowing curves

will change that impression instantly.

Step 10

Body language and gesture drawings
Non-verbal communication plays an
important role in human social interaction
Even if we don't speak, we still communicate
via our body language. According to

some studies about the communication of
emotions by Professor Albert Mehrabian,

if a person sits in front of us, talking about A Note the effect of the asymmetric pose: the flowing curves give a sense of motion and balance lm
their feelings, we will react to 55% to body e e, pose, DrsKeleton cones (6 el

Flowing lines suggest balance, rhythm, and vivid movement

). K \ \
X ‘(\\,
Describe the outer form with dynamic, asymmetric curves
S. J ho
Avoid lifeless “snowman” effect
A Initial gesture drawings. The red lines llustrate the rhythmic flow. Use asymmetric curves to indicate movement, direction, and balance! |m

50



4 The hand. holding the delicate scarf of the dress, adds to the seductive pose of the character

"Capturing some spark
of life in a drawing or
painting is where the real
magic appears”

language, 38% to tone of voice, and only
7% to spoken words. That means that while
we are watching the person in front of us,
we will subconsciously “read” his or her real
feelings and attitudes, no matter what they
say. As artists then, we can use the effects
of body language to communicate our story.

To find a nice, lively pose for the character.
it is helpful to start with some quick gesture
drawings (image 10). These are simple
drawings that capture the essence of

a pose. Is the character happy or sad?
Aggressive or passive? These basic
qualities should be apparent in the initial
lines, ready to be taken further in design.

Capturing some spark of life in a drawing
or painting is where the real magic
appears. The more we render and rework
an artwork, the more we tend to kil this
off. Make sure you keep the lines vivid
and loose right from the beginning

so that there will be some energy left
shimmering through in the final illustration

Step 11

Expressive hand gestures

Another way to enhance the look of

your character is to pay attention to the
expression of the hands. We use our hands
when communicating. Some of us do it
more than others. There are subtle poses
and wildly exaggerated ones. Hands can be
used to point at things; they can be clawed in
anger, or opened in friendship; they can be
inviting, seducing, demanding, or defending.

Sometimes simply looking at a character's
hand pose can offer sufficient information
to understand what kind of character we
have in front of us. There are so many cues
we can get from analyzing the way people
hold their hands: if someone is biting their
nails, for example, the person appears
anxious and unsettled. Hand poses can
therefore be used with great effect to tell

your story (see images 11a and 11b).
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A To make the audience feel uncomfortable, add alien characteristics that prevent an emotional
connection
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"As human beings we have
the ability to be empathic
and the more similar the
other being is to us, the
easier it will be”

Step 12

ughts on alie

Tt
Let's end this chapter with some thoughts
on hybrids or alien characters. How far
can we go with our creation? How many
human characteristics can we replace
without losing contact to our audience?
As human beings we have the ability to
be empathic and the more similar the

other being is to us, the easier it will be

The more alien our counterpart appears,
the more suspicious we are (see image
12a), and so when it comes to an emotional
contact, we need similarity to connect (see
image 12b). We can relate to hybrids as
they are fully capable of emoting as human

beings do - take a look at the one in image
12c for example. Play around with this

balance to see what you can achieve!

A This guy seems to be rather unlikable,
but has relatable human characteristics



A Hybrids are great fun to paint. To get inspiration, simply look at the animal world and combine elements to create a new design



Character types

What makes different types of characters recognizable?

by Benita Winckler

We tend to perceive the world around
us with a lot of biases; stereotypes do
exist. If they are overdone in an artwork
it can look kitsch and our reaction will
be either boredom, or amusement if
the presentation is really over the top
and intelligently done so on purpose.

As character designers we need to be
aware of known character types and
the associations that go along with
them. The big task here is to create
interest and avoid generalization
(where the result is boredom), while at
the same time showing our audience
something that they can relate to.

To do so, we need to open a door into
the audience’s past experience. We need
to find something that will connect with
them on a deeper level. If you are able to
talk to your audience about something
that is meaningful to them, which

taps right into their feelings and their
emotions, then and only then will you get
a response for your artistic endeavors.

If you want to be understood, be original;
but don’t stray too far from a certain
type. If the character is evil, make them
look evil. Let’s talk about the various
character types and how we can use
visual key elements to make sure that our

A Heroine character. Notice the strong stance and the commanding gesture

character will be perceived as we want it.

N



Step 01
Heroes and heroines

The main character for most stories is

the hero (or heroine), or the good guy
(or girl). This doesn’t have to be a mega-
muscular superstar, eternal winner,
half-god. or top model; but the character 1 K
does has to have certain features and
characteristics that will make them

recognizable as a hero in any situation

Let's analyze what makes a character

appear to be a hero. In the previous chapter

we talked briefly about the effect that shapes I
can have in character design: triangles for

active, dangerous fealures; squares for

reliability; and circles for friendliness. This is

one way to communicate an idea. Another

approach is to work with a mix of elements

that when seen together will convey certain

A Another example of a heroine character

characteristics. Elements that can su st a

hero are a strong, upright stance, shoulders

back, wide chest, and belly tucked in y the dark side & jo wild!

1d

a commanding hand gesture. Weapons can Ir son to the good guys there is

also suggest strength (although be aware portunity to add subtle humor

that a little unarmed boy can be a hero, to and to happily ovel a shows
an example of a villain Elvil | have

In image O1a the jewelry and the insignia of enhanced the front pz style

the uniform suggest power and influence to give his already pointy face an even

Blond hair looks good on angelic characters pointier an Here the

but can be used on evil ones as well if attitude of the character is mainly shown

accompanied with supporting elements. in the expr of his fac

The long

Red is a good color for strong characters

as it demands attention. Here the effect

is enhanc dding golden tones

overall to suggest wealth and energy. As a

quideline, make your hero

look strong

with a strong expression on their face. Image

01b is another example of a heroine

Step 02
Villains and evil characters
These are the fun ! With evil

characters there is nothing holding you

% PRO TIP

Add some contrast
To make the character really stand out,

always aim for contrast. Try combining

the hard (or even nasty) features with
something nice, charming, and beautiful

A A villain Elvin warrior

blowing over his shoulder gives a nice spiky
outline with lots of splinter-like triangles.

su

sting a certain dynamic and danger.

At this point you may wonder what it is with

all this analysis of small details: it's important

to remember
thin:

same character but with softer facial features

e importance of the little

If you look at image 02b, it shows the

e how the evil aspec

wun
(¥



A Guess her character type!

=

4 Some goofy/funny characters produced in a stylized comic style

villain, try to imagine

vould b { could

art in your mind — imagine

sion
rests of the character. Minor
details such as a particular way fle

ot of depth to

the hair can really add

the impression of a villain (image 02c¢).

% PROTIP

Use lots of layers
If you aren’t already doing so, work with
layers. This will allow you to exchange

elements during the process of the

work. There is nothing more annoying
than having to repaint elements
because of premature merging.
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"If you need to paint a
powerful femme fatale
for your project, first think
about her story. What is
your character’'s mission?”

Step 03

Femme fatale and pin-ups

=

emme fatale: think of snake-dancers,

spies, and double agents in James
Bond movies; think mystery, seduction

(image 03a), and deadly situations!

alyzing this character t

y that the major ingre:

are

e, erotic, strong-willed

If you need to paint a powerful femme

le for your project, first think about her

ory. What is your character's miss

In what time i 1e living in? This wil

dictate the ¢

ce of clothing. Se

suitable lascivious - self-assured

and feminine. Keep the expression in her

face strong. No weakness! To add a soft

spo!
add

champagne, or cigarettes. Add these

yche, give her a luxurious

on such as a love for diamonds

elements to her outfit to support your story.

in comparison, generally

ocent anc

olayful. Here the

task is simple: paint a sexy, playful female

for decorative purp:

some

skin, tease, and make sure you keer

atmosphere light and joyful (image 03b)



Step 04
The goofy/funny character
Thinking about the

assic Disney cartoons

a number of characters will easily spring to

mind when you think of this type of character.

Image 04a shows an example of two
characters created in a comic style
The wonky guy on the right is our hero

the evi

oking lady on the left is the
antagonist. Let's analyze the features that
make the hero look particularly goofy

First, note the pose. His stance is quite

crooked and stooped. He is a good guy

(smiling, open expres:

but sloppy
and clumsy: the open belt of his jacket

suggests that he is slacking off, careless

His hair isn’t very tidy either

In terms of the antagonist, sil

requested style in this
but comic, exaggeration is {!

She is supposed to be a villa

mistress so the headdress

element to fi

costume

sen with its stiffness, communicz

the inner state of the characler. The w

i to the impression of her ab

glove

correctness and idolized perfection. Her

weapon of choice is the little red book

1ands (let's assume

s some

The environment that the figures are plac

in is also significant in establishing the

(image 041 background

ve the viewer an idea about
the time and location in which the

characters live — there is no electricity

stead a gas lantern and candles

Look at the background in image 0da as

well. Gnarly, leafless trees and cobwebs

hint at the autumna

season

ough

g in the far background we can see
me sort of castle or what may be the

roofs of a shabby

old town. The overgrown

steps add to the overall atmosphere

"Feel free to overdo the
physiques: strong fightin
types can do with a bit o
unnatural muscle mass”

Step 05
The dark warrior
The next character type on the list is the

dark warrior, a charact

aquipped with a

sword and fully armored. When painting

fighters in armor, it can be helpful to analyze
the functionality of the equipment before
starting with the design. Most people will
probably never notice if a sword is made

for two hands or for one hand, or if the

grip is long enough or too short. For a
warrior character, however, there is extra
effort needed to make sure the armor and

weaponry are recognizable (while stil

being functional). Al

so feel free to overdo

the physiques: strong fighting types can

with a bit of unnatural muscle mass
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% PRO TIP

Create a focus point
To pull the focus of your viewer to a

certain area, make sure you give it the
greatest contrast in your image. This is
where you will want to put your lightest
lights and darkest darks (see more
about composition on pages 62-71).

Step 06

Magicians, spells, and light

Let's talk about magic. When dealing with
magicians, a certain amount of visual
fireworks have to be expected. After all
they have supernatural power and know
how to bend and manipulate reality. We'll
now stop the theory and open Photoshop

to creale some fireworks for ourselves

Image 06a shows a magician character. As
you can see, there is no pointed hat, flowing
robe, or long wand. Instead | have played

with a mixed effect of exotic costume, hand

gesture, and light to suggest the magical

act of spell-casling. To create light effects

hints at thi B try | to the magical han re
| usually use the following workflow 4 The costume hints at the profession. Symmetry leads the eye agical hand gestu

Select Brush tool (b)

N bl

Select textured brush

Paint some rough strokes

XL

Z

”
.
»
o,
'8
T

k.
o
W,
Q

o
g

Create new layer: “magic light”

el

A Select a new layer 06b
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Set Layer mode to
Color Dodge

Note the effect on the light!

4 Select Color Dodge 06¢

Hit Ctri+U to open the Hue/Saturation
dialog box Preset: | Custom

Master

Saturation:
Increase the value for Saturation;
decrease the value for Lightness Lightness:

Colorize
v Preview

A Alter Saturation and Lightness 06d

Select a new layer to paint on and name
it “magic light”. With a textured brush,
paint some rough strokes. Choose muddy

colors for this — no extremes (image 06b)

2. From the Layer mode menu in

the Layers palette, select Color

. {4 G eaila
Select Smudge tool Dodge. This mode can cause some
interesting effects (image 06¢)!

With the “magical light” layer still
selected, hit Ctri+U to open the Hue/
Saturation dialog box. Alter Saturation

Carefully Smudge
the.flames

and Lightness (see image 06d)

(don’t overdo it) 2 With the Smudge tool
selected choose a
soft brush tip

&

Carefully use the Smudge tool to

soften your brushstrokes. Note: image

06e shows extreme smudging. in
Use thy d ]
e e 06e order to better illustrate the effect
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® MomentumVolsk - Card gar

a

A Elite paladin, marked from endless fights

A Paladins on their way into battle

Step 07
Knights and paladins

s often needed

Another character type

is the knight or paladin character. There are

similarities to the warrior character. what

has been said about the weaponry and

armor applies in this step as well. In

all these categorizations are quite flexible

Maybe a paladin will take better care of

his appearance than a warrior living out

in the highlands. However, if a knight has

spent the last few months on the road

sleeping in muddy tents, that image could

look different. Again, think about how the

story will have an influence on the look

Has the sword of your knight char

been exc

ssively used in batt

armor marked from endless be (image
07a)? Is he a spotless, shiny knight on a

white horse, composing peems all day?

Considerations such as these will enhance

A The crown indicates her royality

tr

> believabil

ty of any artwork you create

When painting a type of knight that will freedom, howe!

we can still give Step 09
h8a) ild

appear as a group or more than once > an intimic look (ima

on a battlefield, it can be helpful to give A throne adds a lot to the idea that heroes for

The perfe

the grou haracters

a visual element that is ea

are dealing with a king here. The crov

recognizable

Image 07b shows &

example of a group of knights, all with red

elements visible. The rounded de:

gn of rounded. A

the helmets also gives a visual clue that When painting le of roy

to his bod

these are members of the same side/army to strengthen the impression is to use Tor ta

rich ornate a child, use ar eyes, a larger forehead

Step 08 (image 08b). Think delicate struc

and shiny jewe

es smalle nall arms

Skeleton kings and other royals
Ske

for facial expressions, with a bit of artistic expect a simpler look in comparison that w

tern

letons don't offer that many possibilities Pose is anot

you wo
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We will talk more ¢

storytelling in the following chapters

% PRO TIP

Experiment with scale

To play around with the scale of
your character design, select and
copy your design, then use the
Transform tool (Ctrl+T) to scale it
up or down (hold down Shift at the

same time to keep the ratio)

e Y A S e = i \

JHeADS

A How can we tell if the character is a child? The secret lies in the relation of head size to body Im

N

4 Ayoung orphan boy. His clothes don't fit and the huge hat further enhances his childlike appearance © Sauerlénder audio/Argon Verlag
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Composition and positioning

Techniques and rules to enhance your designs

by Benita Winckler

EEF YEE
L

If you want to enhance the visual
impact of your design, you need to
decide on a good position for your
character within your composition.
Certain compositions will work better
for a given task than others.

In this chapter we will look at the different
qualities of various compositions. We will
look at rules, such as the golden ratio
and the rule of thirds, and will discuss

how the application of them can improve
the appearance of an image. We will also
examine some of Photoshop's tools that
make composing an image much easier.

Note that composition rules do

apply for character portraits. We will
therefore look at the subject of the
framing of a portrait. We will explore
possible pitfalls in composing portraits
and learn how to avoid them.

Composition not only works on a macro
level (big shapes) but on a micro level

as well (inner coherence). To achieve a
harmonious result, a composition needs
to work on all levels. The trick is to not
paint parts in isolation, but instead relate
them to other parts. Playing with the
macro and micro in your composition is
a lot of fun; it will help lead the eye of the
viewer around the image, ideally directing
the speed and flow of their attention.

A B A B A ~a_B
.
~
\
\
\
\
|
D E C D E i D E 2] IF
oustuey a suae ABCD Courdrued widpein - E N2l coutar: T o iz FE
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~
Y
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D E € F D E C p Rec "l’”‘é fe

Qu;"{hc‘ ﬁf’vrcuﬂJrcg\/ay' Yo >F ﬂ}:

Fscknod AE Yo Ak smed— Fbe preperoicule

at &

A An approximate of the golden spiral, a logarithmic spiral whose growth factor is the golden ratio or phi
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A
x
A An example of a design that can be ‘!

described with the golden spiral

“Without mathematics there is no art
Fra Luca Pacioli (a contemporary

of Leonardo da Vinci)

The human instinct for the detection and
appreciation of beauty is one of life's great
mysteries. Sure, beauty lies in the eye of

the beholder, but there are proportions that
are commonly accepted as beautiful and
aesthetically pleasing. The first discovery of
the golden ratio dates back as far as some
hundred years BC. Since then numerous
mathematicians and artists alike have studied

and worked with the “divine proportion

Examples of creatives who have worked
with the golden ratio include the famous
architect Le Corbusier, who proportioned
his work approximately to this ratio. Another
example is Leonardo da Vinci, who used the

golden rectangle extensively in his paintings

You can construct the golden proportion
(which is the beautiful number of
1.6180339887, represented by the Greek
letter Phi) by following image 01a. As you
can see, the golden spiral is derived from
the golden ratio and is an organic way to

lead the eye of your viewer around your

4 Another example of the golden spiral. Here the background elements are framing the
character in a spirally flow

composition. It draws the eye to where you
want it to focus. Your subject can sit in the
intersection or, for great impact, in the center

of the spiral (see images 01b and 01c)

Although numbers are a fascinating topic,
let's not look further at the math here, but
rather inspect the possibilities of its use

in our character design compositions
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Step 02

Photoshop tools for composition
When starting a new creation we normally
work instinctively, without measuring the

relation of elements with a ruler. Often it is

not until the image is

notice that we have followed an inner idea of

a harmonious arrangement that can now be

made visible by overlayin jiagram, such

as the golden spiral. This is an important

point: when laying out an initial design

don't restrict yourself to rigid guidelines, but A Select the Crop tool to refine the A The overlay grid shows whether the
composition and framing of the character design is kin,
instead trust your instincts. Still, it is good to o) ng oS workng

know the theory beh mposition so you

can improve your paintings if nec:

ssary

Before we practice how to generate fresh
composition ideas, let’s look at a useful
Photoshop tool that will come in handy: the

Crop tool. If you want to check if the framing

A Anchor points are pulled to re-frame the canvas

works or if it can be optimized, simply use

the Crop tool to shift the important eleme

to the sweet spots of your composition

(for example, where the composition lines ‘ _—
i ! ol "
intersect and create a focal point)
I
Open a sketch. From the toolbar, select 4 Left: balanced; middle and night: tension because of the contrasting sizes Im

the Crop tool (shortcut C). The Crop menu
has different options; select Golden Ratio
for example (image 02a). With the Crop

tool selected, click into the image. You will

get an overlay dividing your image into
golden proportions (image 02b). Note that . —/
intersections are a good place for your / “ -

center of interest. Pull the anchor points
(image 02c) to shift areas of your image

to these intersections and improve the
composition. Hit Enter to confirm; then you

can continue the work on your design A Two ideas for dividing the canvas horizontally and vertically Im

A Add diagonal lines to divide the canvas into interesting sections Im
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A This technique works the other way around as well! Use shapes to analyze a sketch and then play with the composition as discussed

Step 03

How to generate composition i

2as
Breaking the spell and coming up with new
ideas out of nowhere can be a challenge
Let's look at a way to discover possible new
ways of placing our elements on the canvas.

Start with a blank canvas of any size
you like, say 600-pixel x 900-pixel
screen resolution (this is going to be a
rough sketch for exploration, so there
is no need for print resolution at this
paint). The example discussed in this
step is in a landscape orientation

With a hard-edged brush, paint two
interacting abstract shapes on the canvas
Note the different impressions of the abstract
shapes. To create tension, draw one shape
bigger in relation to the other. If two shapes
are seen as identical in size, they will tend to
balance each other out, which will result in a
calmer and less dynamic look (image 03a)

We're going to continue with the balanced
version on the left, touching upon the rule of
thirds. The rule of thirds involves applying

a physical or mental grid over your image
usually made up of four horizontal and

x|

vertical lines, and placing your focal point
on the intersections or along the lines. Start
by dividing (using brushstrokes) the canvas

horizontally and vertically (image 03b). Then

decide where to put the center of inte

(see step 04); avoid putting it in the center

Now add diagonal lines that further divide
the canvas into interesting sections (image
03c). Later on you can refer to these “lines
of action” when sketching. Shapes help

to analyze a composition (image 03d)

and can be a guideline for simplification

Image 03e shows the final composition

A The final composition

03e
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Step 04

The center of interest is basically about
fascination. One area of the picture is given
the quality of creating a powerful attraction
If all goes well it works like a charm and the

focus of our viewer is magically drawn to it

For a successful center of interest, ensure
that other elements of the picture do not
create distraction; they should support the
effect. If their appearance is loo intense
elements will start to compete, diminishing
the intensity of the area of interest

Image 04 shows some interesting
compositions. In the top-left the scribble
shows a compaosition with a center of
interest reduced and simplified for maximum
effect as a dot in the middle of nowhere; by
eliminating all other elements in the image,
the viewer has no option but be drawn to
the simple object in the compaosition. If we
zoom in (top-right), we can detect a person
Interesting! Coming even closer (mid-left)
we naturally focus in on the face and the
gesture (the center of interest is placed at
the top-left intersection) until we are close
enough see the beauty spot on her skin
(mid-right). By placing the center of interest
along intersections we are following the
rule of thirds, which helps to emphasize
the focal point in the composition

For mandalas (bottom-left), a centered
focus area might be acceptable. Portraits
of royals (bottom-right) or other awe-
inspiring figures can benefit from a
symmetrical composition, with the center
of interest placed in the middle instead
of somewhere to the left or to the right

Give one part of the artwork special attention
Decide where the viewer should look and this
spot will have to hold the greatest contrast
the richest colors, the blackest blacks, the
whitest whites, and the loveliest details
Step 05
low to create dyn
In the first chapter of this section on
establishing your character, we briefly hinted
at the effect of form in character design. It

A The center of interest in different sketches

b :

A A dynamic composition versus a static composition




n the shape

can assist you in your task

1age a shows ar

sxample of a dynamic

composition

3 static col

sit

Fora

ynamic composition, choose lots of

diagonals. Guide the eye of the v

rhythmic motion thro

gh your

the ¢

almness use

zontal

the impre

order, strength, anc

the

ontrol. This is especially

e in arty

ks feal

Iring a

symmetry. In example b) in image

character is placed a little clc

resulting in a more interesting composition

» shows an example of a

compaosition, which gives a dynamic

img There

effect co n further by

break

simply move the

center of interest away from the middle

line. Remember, diagonals are dynamic

> impression of r on

npaosition

hance the effect o

movement and flo

symmetry

Step 06

The angle from which the

cCharac

seen will completely alter the effect on

the viewer. The resul

s can be sublle, but

they w

ork nonetheless. In this step we

will look at three ways to draw characters

in perspective (refer to image 06)

Looking up to the character

ing down on the cl

Being on eye level with the character

Lookin,

g up to the character, the figure

seen from a position lower than themselves

As viewers, we have the impression that

he (or she) i

e us. This

| give us t

powerful in

comparisc

/ing
ying

This is defi

e or a malu

pose of dominance and ability. The

haracter

as str

3 PErce

Looking dow he character allc

us to see the character from a

which is hig than them

e effect of the ct being small and

innocent, weak, or a child. It could also be

a defeated enemy. The

character can Ic

further enh.

INCE

r SEems approa

with them more

4 Examples of different perspectives



Step 07
Positive shape and negative shape

When framing the character you have to

deal with two types of space: positive ar
negative. The positive space is the actual
main subject whereas the negative space

isthe a

ea around the main subject. That
means that every item you put on a canvas

will immediately change the dynamic and

perception of the whole. The more elements
you add into an image, the more you reduce

the negalive space and how dynamic a

will look in a composition. Image

a character that has been cut

has been darkened, so you can see the

effects

positive and negative space

N

mirrored and repeated in the elements of the

e how the spiky horns of her crown are

background. There is more repetition of this
idea in the lines at the bottom on the right

The shapes of the steps

tinue the design

idea of the spikes seen at the top, but bigger.

To test your

mposition for effectiveness as

in image 07, you can follow this technique

A All elements interact and the negative shapes are part of the design structure

« Cut

your character with the L

tool

> page 215). Copy/paste it back into

your document. If your character cor

many layers, select C

Edit menu to create a merged copy

content of your selection (super u

» The new layer then needs to be darkened

Open the Hue/Saturation dialog box

(Ctri+U) and lower the Lightness

* Nexl create a ne

ayer below it

and fill it with a light color.

« Now improve your positive (and

negative) shapes to enhance the visual

impact. The negative space should

give your positive space clarity

Step 08

Dominant value

There are different ways to present a

character. Sometimes it is e h to

communicate the design elements in a

clean way. Then skelches will do. However,

n as we are painting a fully fledged

hare

illustration, showing our ¢

A Adominant value will give an image
weight and interest

Y O i
‘D‘“ VI
value |

[ oss |
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Let's conclude with some final thoughts
in the treatment of edges. You can pl

lighting

& Example of using lighting ‘09a

4 If everything is dipped in shadows, it would be hard to read details of the costume, for example Im



A When painting characters in a setting, you can start playing with the compaosition

find a good mixture of atmosphere

and technical clarity (image 09b)

"Playing with all of these
qualities in a composition
can give an artwork a more
dramatic flow”

Now, bac

edges, hard
edges. A found line is sharp, whereas

ale ne is soft or less defined; lost

and found e N help in creating

more of a 3D effect of a subject on a

background because the character looks

more part of a scene rather than being

cut out and stuck into it. Playing with all

of these qualities in a compos an

give an artwork a more dramatic flow

Image 09c¢ s! a quick portrait as an

example of contra etween st

and cur

this

results in contrast in the

left side

s kept simple, while the right

side contains lots of curves and visual

like this to ¢

interest. Use

the speed of perceptic

% PRO TIP

Flip your canvas

To check the composition, use the
flipping command. When working

on an image for a long time, we
become blind to it in a way, accepting
how it looks without noticing the
errors. Flip the canvas and rotate it

around to get a fresh look (use Edit

> Transform to bring up the menu).



Storytelling and moods

Discover narrative arcs and visual clues

by Benita Winckler

Let's begin with a question: what exactly
is a “story”? One answer is that a story
has a beginning, a middle, and an end.

If we are looking at the narrative arcs
of fictional stories for example, we will
find that in the beginning a character
will be introduced. We will get to know
the surrounding environment and

the people the character is involved
with. The middle part will feature the
adventure, the difficulties, the twists
and turns, the ups and downs, before
finally, the story reaches its climax.
After that the curve goes smoothly
downwards again and the story ends.

Although the medium of a visual
image is a bit different to that of text,
we still have a person in front of us
(the viewer) who likes to be led on

a journey, just like a reader does.

Step 01

The problem of a single frame

What needs to be done to map a similar
curve of excitement for our illustration? Here
comes the first challenge: we only have
one frame. If you are working in animation
or film, you have several frames available
and you can take your time to introduce the
character and so on (images 01a and 01b).
But how do you build up tension with just

a single image? Our composition needs to
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A Anarrative arc for fictional stories

be carefully crafted. Then a timeline effect
will happen in the mind of the viewer, as
they follow our direction and decipher the
visual clues we have laid out for them

Step 02

Directing the view

A powerful method to direct the view of
your audience is to have other figures
looking in that particular direction. Think
about those everyday situations where
people form a crowd and gaze at something
— our reaction is to think that it must be
exciting if so many people stop to look at

it. Most times we at least get curious

In image 02a, for example, the viewer's
eye follows the supporting characters
direction of sight. All the boys focus on the
center figure, where the candle is shining
so the viewer will look there as well

When it comes to light sources, humans are
not so different to moths; we like a nice light
source. Light attracts interest and also directs
the view (image 02b). A character in the
spotlight will demand our attention naturally.
You can either have the light source visible or
you can omit it, showing only the lit character.

Another thing that demands our attention is
movement. Our characlers are supposed to
be life-like and believable, so if something
attracts attention in the image, they will
look as well. Movement can be difficult to
pull off in an image: however, we can show
our characters focusing on an object.

Step 03

Location and time

Who? What? Where? When? These are

all important questions in storytelling. To

visually indicate the location and the time
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A What will happen next? A comic strip can show the “before” and “after” states of a situation Im

at something

we need to place some

ual clues into
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onal response or k
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s mind. The effect

on first sight but it will work

ch with

jood times arise
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4 Using light to direct the view. Note the characters’ attention to the movement of the owl

well). these clues
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To indicate the era
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A The bagpipes suggest the location
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A The location plays an important role
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A Play with the dominating color using a textured brush

A This color scheme is dominated by warm red and golden hues

"You can greatly enhance
an image by giving ita
clear dominant value. This
can be the middle value,
the light, or the dark”

Step 04

Spring and summer colors

When making design decisions for a
character, an effect that is often overlooked
is the use of seasons. Let's first look at
springtime: nature is back and it's time

for colors! Subtle cool hues can serve as
contrast for the pinks, reds, and fresh greens
The mood is joyful! Place your character in
a spring scene to convey positive feelings
Show blooming trees and clear blue skies

Summer conveys the feeling of perfect
days outside, with deep blue skies and
warm air. Everything looks bright, rich, and
vibrant. The colors are brilliant and intense,
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and the shadows are strong. If you look

around during midday, notice that the light
is almost overpowering, washing out the
highlights and casting harsh shadows

You can either select colors intuitively
from Photoshop's Color Picker (or color
wheel) or you can collect color inspirations
from photographs and paint your palette
from there (images O4a and 04b). You

can greatly enhance an image by giving

it a clear dominant value. This can be

the middle value, the light, or the dark

Step 05

Autumn colors and winter colors
Autumn features the most wonderful hues
of gold and russet colors, but on bad days
autumn can offer ideal conditions to portray
gloom: foggy streets, heavy rain, wind
pulling at umbrellas and hair. You could have
the character grab the collar of his coat to

A A muted palette with plenty of opportunity to paint blue shadows

keep off the cold or, if you are aiming for a
playful mood, positively surround him with
whirls of golden leaves. Adjust the outfits
accordingly: add scarves or earmuffs.

A winter palette basically consists of black-
and-white, bluish gray tones. With most

of the colors missing you can only play
with the effect of warm light against cold
Dominating cool areas are perfect to be
set off by red glowing spots of fire or the
warm light of interior places. Explore the
possibilities of outside/inside scenarios
The mood caused by winter, if analyzed
further, will show an association with an
archetypal danger, but also mystery and
wonder. Think starry nights and virgin snow.

Step 06

Archetypes and symbolic elements
Since our image is lacking a timeline to
tell our story, we have to find another



ommunical

An archetype is a universal symbol that has a

can use symbols and ar mean| opeful
almost lik N, negative o
ng that represents ch erheroes, mother lang 15. Horns are often associated with

some s, and villains. If we want to convey ;ing the caption

2. For example an owl

is often assoc d with wisdom; a rex n make use of orld

symbol of love 2N archetypal imag way a whole story

> frame alone Iy

be cautious upon ir

e cultural opium poppy, a symbol o

ground, otherwise plays with symbols and of Dreams. The forest

ten used to ar

types that often appear ir

A She carries an opium poppy, symbol of Morpheus, God of Dreams 06b

% PROTIP

Working in an non-destructive way

Often you will work on a project and then at some point
you will need to make changes to your design. What if
you have merged your layers, deleted your reference, or
saved over an old version because you thought you won't
need that one again? The solution: work in an organized
fashion. Keep old versions. Save numbered iterations.

And use layers, masks, layer modes, copies of layers, and

so on. It might save you time further down the road
A A character on her way back from the underworld

i



Step 07

Using color palettes to create mood

Now let's focus on mood by taking a look

color pa

ettes for dark characters. First
thoughts are to use lots of black and blue

and to stay within a mor

chromatic

scheme instead of using plenty of colo
Analyzing the distribution of dark and light
areas, you will notice the portrait in image

07¢ is predominant

light, in comparison

to the portrait in image 07a, which has the

dark values dominating. Additionally, a

blue color s

heme is used in

7a: a classic

combination to get the desired effect

Instead of painting everything black

however, you can play with the co

darkness itself. In image 07c a warm color

scheme is use

2d, but by enhancing

shadows close to her face, a k area is

introduced that will draw attention there. The

angelic elements, such as the silver hair
and porcelain skin, are harshly offset by the
dark red shadows. Her eyes are alien-black
another element that tells us that there is

something out of the ordinary going on

Interestingly enough, you can get a dismal
atmosphere by using colors which would
normally be perceived as being mild and

friendly, such

s pastels, pinks, gold, and
warm reds (image 07d). Furthermore, the
image doesn’t need to be all dark to convey

the atmosphere succ

sfully. Composition

plays an important role, as well as the facial

expre

on of course, which is naturally a

key element to set the mood instantly

Step 08

Light and color

Lighting has significant power over mood and
perception. Using a single source shadow
on the face in high-contrast can signify

mystery; if highlighted with red, it can signify

evil. Color also affects our emotions, making
this a great storytelling tool as well. As you

saw in step 04, colors

n trigger emotional

responses and connotations (see al

“Setting up your color swatches”, page 36)

Let's quickly discuss nature's rules, so that

we know our subject. Image 08a shows

an example of a

vball hit by the
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4 Dominating color here is blue, a classic decision for a, dark lock. A cold red is used for contrast Im

C0000e

A As expected, a bluish color scheme will result in the effect of a cold atmosphere in the image |m

T

A Use dark shadows with angelic white to get the an enigmatic effect, without using blue O‘.l’:
A This friendly color scheme plays with warm hues, but stays within a monochromatic look. I
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A Main light source is the sun; secondary is the sky, causing the color in the shadows to lock blue I



A With the new cold color, the fish stand in a nice contrast

1. Add adjustment layer

N o/ Sutumation

B TRy

™
™

A Lowering the chara

EEARSE
HEETE

cter's saturation pushes it into the background I 08d

orange light of the evening sun. Note the cool
tint of blue in the shadows? That's actually
light bouncing from our secondary light
source, the blue sky. The holes in the snow
are areas that receive very little light, neither
direct light from the sun nor indirect light from

the sky; as a result, they appear very dark.

Before picking a palette we have to consider
where the light is coming from. Is it natural
or artificial? Is it morning or afternoon? What
are the colors of the environment? Once we
know the light source, we will have an idea
about the colors and their temperature

However, natural light isn't the end of the
story. If we want maximum effect, we can
bend the physics a bit. Images 08b and
08c show the use of color temperature

as a contrasting element in a design. The
golden light illuminating the character is
not to be found on the fish and rocks in the
foreground in image 08¢, adding a slightly
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eal feel to the character. Contrasting
a warm shade against a cool one can also

an

add a lot of visual interest to a ¢

Im,

> 08d (previous page) shows how
instead of changing the foreground color, you
can also lower the saturation of the character
in the background to push it further back. To
find a nice color combination, use the Hue)
Saturation dialog box or use an adjustment
layer (image 08e). Subtle changes in the hue

and saturation of elements in your image can

change the mood of your image, for example

from warm and inviting to cold and eerie

Step 09

Using masks for final effect

By creating selections and masks you can

isolate or modify sections

of your image,
allowing you to easily alter mood without
having to repaint areas. If you need a
dreamlike backdrop for your character, try the
blur effect. This can be overdone, but if used
sparingly, gives a sublle ethereal quality.

Set the workspace to Essentials as | have

done, sow

can s

he same panels. We
want two copies of the same layer holding
our image. One layer will be blurred and
then masked, to let the original version show
through. First, make a copy of your layer. If
your file has several layers use Edit > Copy

Merged to get a merged layer of your image

Put that layer on top of the layer stack (image

09a), or create a new document with it

Color Picker

A The Color Picker shows you can alter the mask by painting with black or white
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4 Copy your character image layer to get two exact copies

With the top layer selecled, hit the Mask icon
(the Mask thumbnail will appear in the layer
humbnail

stack next to your image image

09b). Pick any brush and roughly paint the

vant to be affected by the blur

(since t applied the blur yet, it will

look the same). The Mask thumbnail shows
the painted area in black. You can only paint
or erase, black creates holes in the mask or
white closes holes (image 09¢c). Grays will

work too, indicating areas of transparency.

Step 10
Using masks for final effects (part 2)
Let's quickly check the extent of our masked Mask icon

area to « ck the coverage of the mask is

as we wanted. Select the bottom layer; hit

| (Image > Adjustments > Invert) (image
10a). This will invert the layer, making it look

like a negative. See the area covered by the

mask? Repeat the command to invert it back

Mask thumbnail



»

The Invert command can be very useful

4 Activate the image thumbnail then blur the layer

4 Close-up of before and after

Feather slider

Mask thumbnail

10c

Next we'll soften the transition. Click the

Mask thumbnail. In the Properties panel, pull

the slider to feather the mask (image 1(
apply blur to the image, first click the image
thumbnail of the Mask layer. From the menu

er > Blur > Gaussian Blur

bar, select
decide on a value, and confirm (image 10c)
To lower the effect of the blur, simply reduce
the opacity of the layer altogether, by using
the Opacity slider in the Layers panel, or (this
is the more controlled way) use a soft brush
and paint on the mask to make more holes
Make sure you activate the Mask thumbnail
when trying to alter the mask, otherwise

you will paint on your image; it can easily

happen! You can see the effect in image 10d
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Character generation

Find out how to use Photoshop tools to create a character.

Now that you have discovered the key tools and theories

behind character creation, it is time to put them into practice

Bram “Boco” Sels will guide you through a complete character
generation process. Using his own character creation, Bram

will break down the workflow, explaining each setting, tool, and
technique he uses lo develop his design. From using masks to
paint skin and custom brushes to paint hair, to adding background
texture to ground your character in a scene, you will learn a
variety of methods you can then apply to your own paintings.



Body type and skin

Figure drawing and painting realistic skin textures

by Bram "Boco” Sels

In this section we'll look in-depth at how
to create a heroic 19th-century character
for a video game. It's tailored to concept
artists who are just starting out, as well
as more experienced concept artists
who are looking to hone their skills. The
approach is simple: each chapter starts
with some insightful theory, followed

by an explanation on how to create part
of the character, all leading up to the
polished hero pose in the final chapter.
Need to design just the portrait or the
costume? No problem, just skip ahead
to their respective chapters (pages

88 and 104) and start from there.

By following this step-by-step tutorial
your designs will become more
flexible and you'll be able to quickly
do thousands of iterations of the same
subject without effort. Don't like the
head of your character? Just unscrew
and replace it with a new one. Not
sure about his mustache? We have

a few others in stock for you! We'll

go over all the basics you'll need to
paint a flexible easy-to-adapt character
ready for the production pipeline of
the AAA-studio of your dreams.

And to top it all off, this section is filled
to the brim with quick tips such as
how to use the Pen Pressure toggle to
your benefit, how to create your own
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A Some really quick anatomy studies, each taking about 5-10 minutes

textured brushes, how to use the free
PaintersWheel palette, how make your
character feel gritty by applying the
Noise filter, and how to conjure mood
with custom fog and particle layers. My
fingers are tingling to get cracking!

"Your painting techniques
quickly improve if you do
some studies every day”

Step 01

Warm-up 1.0

When | start on a new piece | almost always
do a warm-up first. This is a step that a

lot of beginner artists are tempted to skip.

[ o1 ]

Mainly because they feel it's a waste of

time and working on an epic environment or
character is so much cooler than doing small
anatomy sketches or perspective studies. It
is, however, a step that | feel is absolutely
necessary for two important reasons.

First and foremost, your painting techniques
quickly improve if you do some studies every
day, and it broadens your horizon a lot,

too. It forces you to paint different subjects
in rapid succession, learning something

new with every session. Second, though
warming up seems like a waste of time
when you have a deadline coming up, a
good warm-up makes you paint faster and



A Alonger study of around 30 minutes

moare fluently, so you'll regain that time (and
even more) throughout the rest of the day

Step 02

Figure studies

Every art-school student goes through figure-
study classes. The reason for this is that the
human body is often the main focal point

of an illustration and is very hard to master.
We are constantly looking and interacting
with other humans, so our eyes are trained
to quickly detect inaccuracies when we

see a human body in a painting. The good
news is that it's just a matter of practice

When you do figure studies (and you can't
do enough!), you start to notice how light
impacts the body, how muscles connect
and how perspective and foreshortening
change what we see of the body. Practice
every day and you'll get better in no time.
Image 02 tock me around 30 minutes

Step 03

The human machine

Of course, the human body is different for
every person, but a reigning theory in art is
that it all starts from a perfect base - an ideal
body that can be modified to create different
body types. So following that theory you start

A Ablueprint of the perfect body. Really focus on how body parts are positioned around

the center line

out by learning how that perfect body works
There are different approaches to doing that
but one of the more famous ones is that

of Andrew Loomis, an influential American
illustrator, art instructor, and author.

Part of this approach involves measuring
body parts against each other in order to
get proportions correct. For instance, the

% PRO TIP

Pen Pressure

Photoshop CS6 and upwards comes
with some cool new brushes that

are perfect for digital artists. These
brushes mimic how an actual brush
works and come with a small pop-up
window that shows how Photoshop is
registering your brush on the canvas.

Tilt your stylus and you'll get a fiat line

push hard and you'll get a fat line. Nifty
and great to do line art with, it prevents
you from getting monotonous line work

Another new gimmick is the Pen Pressure

toggle next to the Opacity slider on

ideal body is made up of 7-8 heads, so
when you draw the head you can quickly
measure where the feet should be. The
crolch is exactly in the middle of the body
and the bottom of the breasts and knees
are in the middle of their respective halves
The body is also three heads wide and
the shoulders and crotch should create an
imaginary triangle that goes between them

top. When you have it on the harder
setting, you press on your stylus and
the more opaque "“ink” will flow out of
it, which is a bit more intuitive than
working with the Opacity slider itself.

4 Using the Pen Pressure toggle for opacity gives you more control over your brushes
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A An easy-to-draw skeleton and how it translates to different body types

Step 04

Imaginary heroes

Up until now the only thing we have done
is study the perfect human form and how
it's translated to a drawing, but what if you
don't have an exact reference for what
you want to draw? As an illustrator or
concept artist you should be free to draw
whatever you can imagine, so copying a
reference 1:1 will get you nowhere. (Unless
you have a bearded dwarf or an alien
locked up in your basement, that is.)

Artists often have to draw bodies for which
they don't have a reference, so an easy
alternative is to start with a shell that looks
like a human and for which you do find a

* PROTIP

Lock transparent pixels

reference. That “skeleton” is easy to draw,
can be moved around and posed without
much work, and afterwards you can draw
whatever you want on top using your
(human) reference as a guide. Drawing

a small muscled dwarf for example?

Just broaden the head, ribcage, and

hip, and move them closer together

Step 05

An ancient Greek hero

Around 500 BC the Greek sculptors became
masters of anatomy by studying the ideal
body and creating millions of sculptures

to its likeness. They almost always placed
the weight of the body on one leg, making
the sculpture a lot more dynamic. Compare

When you're working on a character, masking is always one of

the first things you should do. Basically it means you paint the

silhouette of the character you're working on and use it as a stencil

Create a layer below the line art to act as a mask and in the

top of the Layers palette you can lock transparent pixels,

which blocks off all pixels in that layer that are empty (in other

words, everything outside the silhouette). Now when you're

painting you don't have to mind the size of the brush you're

using, since all paint will stay neatly inside the mask

A Masking out the silhouette of a character can really speed up your workflow
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& The idsal body, leaning on his right leg | [EER

this body to the blueprint of the body in
image 03 and notice how the entire body
language changes, even though it's based
on the same blueprint. Closely study how
the muscles group and how the center of
gravity slightly moves towards the left

"A body with correct values
but wrong color still looks
okay, but a body with
wrong values quickly looks
anatomically incorrect”

Step 06

Key light/back light

Trying to figure out how to light a body might
feel difficult and overwhelming at first, but it




4 Defining the light scheme on a little ball helps to organize things

becomes a lot less daunting when you go
at it one step al a time. A great tip is to start
out in black and white. That way you can
focus on the values without being distracted
by the color and temperature of the skin. A
body with correct values but wrong color still
looks okay, but a bady with wrong values
quickly looks anatomically incorrect

Another great trick is to define the lighting
scheme on a ball before starting on the body.
A common lighting scheme in concept art

is with a key light (the main light) from the
front and a rim light (back light) from behind.
Note in image 06 how the muscles react
almost the same to the light as the ball.

Step 07

The body as a whole

Keep in mind that the body remains a volume
in itself. See it as a giant cylinder and think
about how that giant cylinder would react

to the lighting scheme you defined in step

06. It's not enough to define every muscle
according to the lighting scheme; you should
also keep in mind where those muscles are
on the body. If they are on the light side of
the “cylinder”, they will of course be lighter
than the other side. This is most clear in the
biceps of both arms. The right bicep is on the
light side of the body and is almost entirely lit,
while the left bicep hides in the shadows of
the chest that sticks out and blocks the light.

Step 08

Highlights, midtones, and shadows
After adding in the basic values, try to define
a color scheme. Different lighting conditions
have a different impact on the body, but for

this study we're keeping the light neutral

s0 the skin tones will be fairly neutral as

well. Caucasian skin tones often range from
purple to deep red, to yellow and even green.

When you look closely at a person’s skin,
you'll see that there's a lot more information

4 Defining the skin colors; the arrow points towards the main wash

A The value block-out for the body

there than you might expect. Still, it's best

1o define some common skin colors at first
and start from there. | usually change the
painting mode of my brush (you can find that
in the Options bar at the top of Photoshop)
to Calor, and give the entire body a color
wash; in this case a warm, orangey tan
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Step 09

Color zones

Often skin tends to have areas where
a certain color dominates over all other
colors. Once you're familiar with these
zones it becomes easier to notice
them and eventually predict how the
skin there will react to the light.

When you move lower down the body, skin

tones will gradually become more reddish

-
£

and purple than they are around the chest

LR

area, where they'll be more yellow and

orange. You can especially see this in

the hands, knees, and feet. This has its

effect on the shadows as well, resulting in

Ll A

dark purple shadows in those areas and

warm shadows around the chest. Look

for some references when painting these

€ - akENFD

areas — they will really help out a lot to

get your figure correct and realistic!

E]fj

Step 10

Refining the body

The last step in this chapter consists of
refining and detailing. Although you already
defined the values a few steps back, you
should still keep working on them — nothing
is set in stone at this point. Push the
highlights as much as you can and try to
create lively shadows by introducing vibrant
colors to the darker parts and areas. Take

a sl

p back from it once in a while, so you
can come back to it with a fresh eye later
on. It often makes you nolice the mistakes

and gives you a fresh perspective.

% PRO TIP

Noise
A great way fo give skin some exira texture is with Photoshop's

opacity to 1

built-in Noise filter. Create a new layer and fill it with a neutral
gray (use the following RGB levels as shown in the image on
the right here: R: 125, G: 125, B: 125). Click on Filter > Noise >
Add Noise, and use it to whip up a 100% monochromatic noise.
Now use Edit > Transform > Scale and then drag to double

the layer in size; this will give you nice big chunks of noise

Click on Filter > Filter Gallery > Brush Strokes > Spatter; then

click OK and select a Spray Radius of 10 and a Smoothness of 5.
Now click on Filter > Blur > Blur More and you'll get a nice gritty

A Creating a noise layer to blend over your skin will often give it that extra edge
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A The body gradually becomes more reddish near the bottom

skin texture. Put the layer's blending mode to Soft Light and it's

— your skin will suddenly have a lot more texture
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Designing and painting the face

Mastering the techniques to create a life-like portrait

by Bram "Boco” Sels
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Portrait painting has been around
for centuries. Before the invention of
cameras people mainly used it as a
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With the development of concept art, I e
however, methods from portrait painting S b
L)
have become a lot more popular again e
— be it as a way to put existing actors in
imaginative:afvIFoHiTeS ot CFeats A Five head studies from Wiki Commons, taking around 10 minutes each | 01 |

characters that don’t exist in real life but
look so convincing that they could do.

To create such a character it's important
to master the techniques needed to create
a life-like portrait. In this chapter you'll
learn, among other things, how the skull
is the foundation of the head and how

it changes the distribution of light on
the face; you’ll see how the direction of
the light can dramatically change how a
person looks and how the face is made
up of different color zones. You'll learn
everything you need to know to paint
realistic, imaginative faces from scratch.

Step 01
Warm-up 2.0 (the classy one)

02

Just like in the previous chapter, it's A Studying the skull that's on my desk. On the right you can see how it can be reduced to basic,

primitive shapes
important to warm up when starting on a new
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piece. This time | opened up Wiki Commons
and browsed through their enormous library.
It's a fun thing to do and browsing through
different eras and different subjects expands
your internal reference library each time.

Eventually | stumbled on a set of early 20th-
century gentlemen and decided to do a study
of a few of them. Something to think about
while doing studies like these is how the eyes
can really define the character of a person
Got to love that facial hair, too — | wish |
could get away with a mustache like that!

Step 02

Skulls are awesome!

Write this down: you should do at least one
skull study each year. Not only is it a cool
subject, it really makes you understand
how the human head works — how the jaw
connects to the rest of the skull for instance,
and how the brow and the cheekbones
define the form of the head. It's a good
idea to get yourself an anatomically
accurate skull to refer to while painting

When drawing the skull you'll start to notice
that it basically consists of a few simple
shapes: a ball with the sides cut off and the
chin as a rounded square protruding from
it. Understanding these simple shapes is
half the battle when painting the head.

Step 03

Lighting the face

Starting out with the simple shapes from the
previous step, you can construct the rest

of the facial features on top of them. Keep
the facial features simple at first; it will be

a lot easier to light them that way. Notice

in image 03 how the nose protrudes from
the face and how the eyes are (obviously)
round and should be lit that way.

The two lighting schemes on the right of
image 03 are pretty basic but very common
in concept art. The first has light coming from
the top, the other from below. Depending on
where the light comes from, some planes will
be lit while others will hide in the shadows.
Always keep in mind how the planes are
oriented towards the light; planes directly
facing the light should always be lightest.

A Different lighting conditions have different effects on the head

A The line art for the head, trying to create character with the facial features

[ o4 ]

Step 04

Creating your own character
Inspired by the warm-up in step 01, |
wanted to create a face that looked both
worn and rugged, but still appeared
stylish and 19th-century-like. | wanted to
create the main character for a fictional
video game, and chose to go with a
Caucasian, bearded, hero type

| started out with the basic shapes from
the previous step and once they were
correct | placed a layer on top for the
details, systematically erasing the under

A Creating a mask, while simultaneously Im
drawing as | went. In this step it's important checking the sthoustis
to really look at how facial features are
constructed. Look at how the eyes have

eyelids and how they work. Note how the

unharmed. Eventually these lines will be
erased and blended with what's below.

nose as well as the mouth is divided into
planes that flow over into each other. Creating a one-color mask will also give
you a clear view of the silhouette of the

Step 05
Masking the face

head. There's a lot of character in there
as well: the hair, for instance, is slick

As with the body, | created a layer and thin and cuts into the silhouette
below the line art to function as a mask. above the ears and on both sides of the
The idea is to keep all paint within the forehead. The same goes for the beard

mask and still have the lines on top of it and his left eye socket (see image 05)
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"Because the face is often
the focal point of an image,
itis important to get the
facial features just right”

Step 06

Blocking out the main planes
Keeping the same lighting scheme as for
the body in the previous chapter, | started
blocking out the biggest parts of the face.
I've put the hair on a separate layer so that
| can focus on it later on. As with the body,

| started out in black and white to really

concentrate on getting the values right

This is the step where knowing how the face
is divided into planes really comes in handy.
The planes that face the light directly catch
most of it and will be the lightest. You'll also
notice that some transitions will be sharp

(like the front of the nose), while others

will be a lot smoother (like the forehez

Step 07

Refining the face

Because the face is often the focal point

of an image, it is important to get the facial
features just right. If something is a little off

it will skew the entire character. Get into the
habit of flipping your image once in a while
(Image > Image Rotation > Flip Canvas
Horizontal), it gives you a fresh view so you'll

notice mistakes in a heartbeat (image 07a)

While you're refining, it's also very
important to gather the right reference
Look at how eyes reflect the light source,
how the tip of the nose often catches a
highlight, and how age lines turn with
the shape of the skull. Note that here the
head will have a lighter side and a darker
side. Depending on the side it will differ

how the facial features should be lit

When rendering, | basically stick to the
same basic round brush and a textured
brush. Using the Opacity Pen Pressure
toggle helps me to achieve some interesting
complexities. | often use a seamless texture
that | use as a texture in my brushes as
well. It has a convincing grain in it that
waorks really well to give the impression of

pores and details on the skin (image 07b)
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A Quickly laying in values for the face, keeping the lighting scheme in mind

% PRO TIP

PaintersWheel

PaintersWheel is a free plug-in for
Photoshop, created by Len White
(http:/Nlenwhite.com/PaintersWheel/)
It doesn't do anything you can't directly
do in Photoshop, but it's a lot more
accessible than the standard color
picker and it arranges your hues in a
circle which is somewhat more logical
When you're painting skin it's a helpful
tool to quickly micro-manage your hues

if you feel your skin is becoming too dull

A Len White's PaintersWheel, a free and very accessible plug-in for Photoshop



A Flipping the canvas regularly can help you to notice any mistakes I

A Refining the facial features using settings like these can really give the head a lot more character 07b
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Step 08

The color zones of the face

When thinking about colar, the face can

be divided into different color zones. It all
depends on the color of the light of course
but for Caucasian skin for example, when the
light is neutral, the top part of the head tends
to be more yellow, the middle part more

red, and the bottom part more blue/gray.

This is especially true with male faces due
to the facial hair they tend to have around
the chin, which has a very distinct blue/gray
tone. This should be subtle of course and
should not be exaggerated, but knowing
those colors are there makes it easier to see

them when looking at reference photos

A The face is roughly divided into these three color zones
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% PRO TIP

Soft Light and Overlay

The Soft Light and Overlay modes

are traditionally ways fo increase the
contrast of what's below. The two most
common ways they are used are by

creating a new layer on top and changing

its blending mode, or alternatively to
directly change the blending mode
of your brush in the toolbar at the top
of the Photoshop window. The latter
avoids having to create a new layer,
but is admittedly a little less flexible.

The difference between Soft Light
and Overlay, is that Soft Light uses a
combination of Screen and Multiply
blending, and Overlay uses as
combination of Linear Dodge and
Linear Burn. Both are valid ways

to boost contrast (see step 10), but
Overlay is the more intense of the
two and thus a lot less subtle




A Mask the area of skin you plan to paint color over

"You'll find the most
intense reds around the tip
of the nose and on the top
of the cheekbones”

Step 09

To tone the face, | created a mask over
the area of skin | wanted to paint (see
image 09a). | then started out with a
wash in the same color that | used for the
body in the previous chapter. After that

| kept the painting mode of my brush on

Color, but changed the opacity to 25%

One by one, | color-picked the colors from
the last step and went over their respective
zones (see image 09b). Again, look for
some references online and make a mental
note of where the most saturated colors
should be on the face. You'll find the most

intense reds around the tip of the nose and

on the top of the cheekbones for instance.
Don't overdo it though, or your character

A the col Im I I
Applying or zones on top of & brownish base color will quickly look unrealistic or like a drunk
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4 Build up the character by adding little scars and irregularities

Step 10

The head is not a cue ball * PRO TlP

That's right, the head is not glossy and Brush texture There is, however, a lot of great

smooth like a cue ball. It's covered with Another way to get some extra texture in and usable presets already present

little holes, pimples, and pores; especially your skin is to work with textured brushes. in Photoshop, so you'll quickly find

in the case of my character who | want to If you open up the Brush palette you'll something that fits. It's a technique that's
be a bit more worn than the average Joe see an option for Texture. In this case | usable with every brush and on every

used a texture | created from a watercolor subject, so when you feel your painting is

| put some scars on his cheek and n painting. | felt that the rough texture of lacking an edge, this might help you out
and used a textured brush to get some the wet paper had some really organic

extra noise in the skin (see pro tip on the bumps which could fit well on human skin

right). | took the time to make the age lines
pop and to palish up the eyes, making

them appear more lively. | also notic

the forehead should be a little lighter and
that the overall contrast could be boosted

so | tweaked those two things, too

To boost the contrast on the forehead use the

Dodge tool, set to Highlights. It's a great way
to build up values and to get vibrant colors in

skin. The scars and irregularities are subtie
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changes in the midtones that have a sh.

Mo Dt

side and a highlight side. Using the textured

brush means they fit in nicely with the res!

the skin. It's important to keep it subtle here -

the strongest highlights and shadows should

be preserved for the bigger shapes like the
A Using the texture option in the Brush palette to get some extra bumps in the skin

forehead, eye sockets, nose, and

9%






Painting hair

Techniques for painting hair and creating a brush to speed up the process

by Bram "Boco” Sels

Painting hair might seem very different
to painting a face, but you'll soon
discover there are more similarities
than you might expect. There is one

big difference though, and that is that
hair is anything but static, so it's harder
to predict where and how it will move.
There's no anatomy involved either

s0 you can't really measure it against
something. The only thing you do know
is that it follows rules of gravity and is
therefore likely to fall in a certain way.

| used to struggle a lot with painting
hair. I just couldn’t get a handle on it
until | started learning about sculpture.
It was a real eye-opener to see how
classical sculptors were able to

render realistic-looking haircuts by
chiseling hair from marble. It drastically
changed my approach to painting it.

Instead of looking at hairstyles as a
combination of individual hairs, | began to
see them as solid forms weaved through
each other. This not only made hair
easier to understand, it suddenly became
clear how hair should be lit as well.

Here you'll discover how to light those
solid forms, as well as how by adding
little specks and hairs you can create
the illusion of the haircut censisting
of thousands of hairs. You'll also learn
how to create a simple brush that can

save you an huge amount of time.

"The haircut alone can
really help define the back
story of a character”

Step 01

Warm-up 3.0 (the stylish one)

During this warm-up | copied the line
drawing from the previous chapter and tried
some new haircuts on it, just to broaden
my horizon. None of these haircuts made
the final cut (pun intended), but | don't
think it hurts to try experimenting anyway.

For the sake of this tutorial, | quickly
masked out the hairstyles in image 01;
you'llimmediately notice how much the
shape of the hair can affect the way
your character looks. The sharp point on

A Five different hairstyles, each generating a different back story
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4 Don't think about individual strands, but look at the large shape

of the hair and think about how it would react to light

the second portrait makes you wonder
if he's an evil mastermind, while the
voluminous hair and slick mustache

of the last one make you think he's a
Casanova. The haircut alone can really
help define the back story of a character.
"Think about how you
would chisel hair out of
marble and try to mimic
that in your painting”

Step 02

The shape of the hair

Beginner artists often make the mistake of
nds. By

thinking about it like this you are tempted

thinking about hair as individual

to meticulously paint each one, hoping it

values are correct

will result in a convincing haircut. Nothing is

further from the truth. Hair has the tendency

to group into locks and those locks are

larger shapes that react in the same way

to light as every other shape would

Think about how you would chisel hair

out of marble and try to mimic that in

painting. Afterwards, you can always paint

some individual strands on top to give
the solid shape the illusion that it consists

of thousands of individual strands of hair

Step 03

The color of the hair

Painting hair does not differ from painting
anything else, in the sense that values

are still more important than color. If

l A Coloring the hair is a lot less difficult if you make sure your

your haircut looks believable in black

ang hite, it will look believable in color

as well. Heck, you can color your hair

le if you like and claim it's part of

your design if your Jes are correct; but

you can't get away with bad values
y

n this study | went for a goiden

brown hairstyle and after looking at

some references, | defined t C

swatches in the bottom corner to refer

to and to help me out (image 03)

As a quick tip, | woul jvise that you

never use pure black in the ar of

shadow or pui

> white in the highlighted
areas; even black, gray, or white hair

contains some subtle color in it
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% PRO TIP

How to brush your hair

After you've suggested the bigger volumes of the haircut you can
start by adding the texture it needs. Rather than doing it with a single
brush a thousand times, an easier way is to open a new rectangular

document and put some more-or-less evenly spaced dots in it. They
should be black and white, differ in size, and have different values.

Now click on Edit > Define Brush Preset. Then give your brush
a name and click OK. This will now appear as a usable brush
in your brush library. Open up the Brush (Window > Brush)
palette and in it you can select your brand new brush. In the
Brush Tip Shape menu, change the Spacing to 1% and you'll

have a fast and convincing hair brush. Don't use it too much

though; it's better to switch back to single brushes during the

final stages because they lead to a more spontaneous result.

4 Creating a new brush is a quick and easy way to fill up those big volumes of hair

Step 04

A mask of hair

Keeping the haircut on a separate layer
is a good idea when you start laying

in the big volumes. By selecting Lock
Transparent Pixels in the Layers tab, you
can use a big, soft brush on the sides to
manually create some gradients. Using
this technique also forces you to see the
haircut as a solid shape rather than a
combination of lots of single hairs, so it will

be easier to shade it as a whole as well

A Masking the hair is great to get some gradients going, but keep in mind that you're not creating a hairpiece!
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Look, for instance, at the shadow under
the nose and behind the ear. By painting it
roughly now, I'll remember to avoid strong
highlights in those parts later on. There is
a pitfall in working like this, however: we're
creating haircuts and not hairpieces, so we
need to remember to work on the transition

between the head and the hair, too

You can change the settings of your custom-
made “hair” brush (see pro tip above) by
going into the Brush Palette to achieve

Name: Har Brush




A Hair is grouped in locks that are draped around the head in different directions

the desired effect. The most important
things here are to change the Spacing

to 1% and to turn on Shape Dynamics

to get Pen Pressure opacity. Turn off the
Size Jitter though in order to keep your
hairs straight and consistent (image 04).
Scalttering, Texture, and Dual Brush mode
shouldn't be used here because they will
make your hair feel messy and cluttered

Step 05

Twist and turn

A haircut is mainly defined by how the bigger
locks of hair are cut and draped around the
head. When designing a haircut it's a good
idea to think about which way the hair is
turning. In this case, the slick hair on top of
the head will be neatly combed to the side
flowing over into the beard which will be
more rugged and chaotically weaved (image
05). Mustaches can be the exception and will
often be neatly combed and modeled as well

Use your brushstrokes to suggest the
direction of the locks; try to use large brushes

to avoid the individual-strands-of-hair trap

Step 06

Color as a statemen

The color of a haircut can be a statement

in and of itself. In this case, | wanted my
character to look a little wiser but still not too
old, so | decided to give him dark hair that
started to turn gray. For the beard, | wanted
to give him a salt-and-pepper kind of look
warm dark browns combined with bright gray
and saturated browns around the mouth

You can change the mode of the brush itself
to paint in Overlay in your current layer,
withoul creating new overlay layers (see
image 06a). You can use this technique
instead of the Dodge tool to boost the
highlights and to sneak in some new colors
As touched upon earlier, even when painting
gray hair, you should always avoid using
neutral grays. It's better to go for either a
warm gray or a cooler variation (image 06b).

Using different colors helps prevent
the haircut looking dull and uncriginal
and slightly builds up the character
by giving him another edge

v
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4 Changing the brush mode to paint on
Overlay in the current layer

A Coloring the beard with a salt-and-
pepper tone

99



% PRO TIP

Blurring the hair

It's not hard to imagine how hair strands
fall in layers on top of each other, so

it's a good idea to actually approach it
that way in Photoshop. Create a layer
for the base of the hair and keep on
adding layers of hair on top of that. As
you work from dark to light you should
also work from blurred to sharp.

Blur the lower layers of the hair with
the Smudge tool or with Filter > Blur
> Gaussian Blur. This will reduce
the clutter and give the haircut more
volume. As you go higher up the
hair layers, get crisper and sharper
and top them off with a few extra
sharp hairs going criss-cross over.

A A step-by-step breakdown for painting hair

"It's important to work
from dark to light. Start
with the dark undertones
and build your locks on
top of that”

Step 07

hen painting hair it's important to work from

to light. Start with the dark undertones
and build your locks on top of that (see pro
tip above). Use big brushes to lay in the
shapes and rough values, and see how it

tarts to group in locks (image 07)

It's a bit different for the beard since it's so

chaotic, but the idea behind it is the same

La

y, put a few hairs e which way

lo avoid getting a sterile and unrealistic

haircut

d if you really want to make

it pop, set the painting mode of your

h to Overlay, pick a bright color, and

paint in some extra shiny highlights

Step 08

ntrollin

s important to step

e the bigger picture. When the

first thini u notice is individual strands of

hair, you're probably doing something wrong & Using Lighton and Derken'es palnting modes to pull k al togethar Im



"No haircut is perfect,
there will always be a few
hairs running against the
stream”

A A haircut becomes a lot more convincing if a few hairs stray away from the path



% PROTIP

Use reference!

The age-old discussion of whether or not a “real” artist

needs references is a redundant one. Millions of artists
throughout history have used references, and to great result
at that. It's not a question of whether or not you should use .
it (you should); it's a question of how you should use it.

Basically there are two different ways. The first is to
look for a reference (be it photographs or en plein

air) and make an exact copy of it. It's a great way to
learn and it's a whole art form in and of itself.

The second way, which is used by concept artists all

over the world, is to create something from scratch but

get the right information from the right resources. In this

case, | browsed through freetextures.3dtotal.com for

a hair reference (first image on the right here). collect in it: the way hair flows, how tiny hairs get highlighted
and stick out, the way the hair shapes around the head, and

Notice that the reference is completely different from what | so on. While painting | go through tons of these photographs,

was painting, but there's still a lot of valuable information to getting exactly what | need out of each of them

A Use reference photos to your benefit when painting — there's a lot of valuable information to be found in them

Step 10

Moving the hairline

t this point | felt the hairline of my character

off. | wanted him to look just a

was a bi

tiny bit younger so | ed lo move his

hairline forward and introduced a bit more
rd

d then

brown into it. | move

the hair line forw

€ v anbN A
ANHAENN NAT

it with the Lasso tool a

tri+Shift+

by select

pressir

to copy merged)

and Ctrl+

o paste). Now the entire hair
line is in a new layer, which | then nudge
forward with the arrow keys. Afterwards |
only need to erase the edges with a soft
brush and paint in some new hairs here and
there to make it fit with the rest of the head

| used the

> on my brush

to push the volu to make the

ard fullel the left

side of the fac: ited some

extra tiny rugg the transition

ine between the skin and beard

It's a matter of g our gut, letting

the image rest for a while, and picking it

back up again later on. Keep at it and soon

ract A | move the hairline forward and introduce more brown to make the character feel a bit younger Im

dy to hit the
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Designing a costume

Painting different materials to create a 3D feel for your character

by Bram "Boco" Sels

Generations upon generations have
expressed themselves through fashion
and that’s precisely why concept artists
can greatly use it to their benefit.

When you look at someone’s clothing,
you immediately (and perhaps even
subconsciously) picture what type of
person it must be. It is a form of prejudice
that can be wrong and hurtful in real life,

but often spot-on in movies and games.

There's a good reason for that: because
of the fast pace of most movies and
games you should be able to take one
lock at a person and judge what his

or her role is in the story. The concept
artists behind the scenes are expertly
trained at communicating this; their job
is to create characters and environments
that speak for themselves, show history,
and are rich with a back story. In the
previous chapter you learned that the
shape of the hair can be helpful in
doing that. The same holds true for

the clothing you give your character.

It is important to remember that every
decision that you make as a concept
artist should contribute to what you are
trying to communicate through your
designs. If your character is a villain for
instance, giving him sharp, dark clothing
will help to reinforce the idea that he is

bad and make him seem more evil.
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Blue boy
scout

A Quick studies of some 19th-century outfits

This chapter will take you through
everything you need to know to give
your character an interesting costume,
from how to paint different materials
to how to translate that knowledge
into painting onto volumes, to
achieve a lively and 3D character.

Step 01
Warm-up 4.0 (the historical one)
A different kind of warm-up this time! | had

o move forward with the 19th-

/ theme | had going in the previ

mmons

]

German
deadhead soldier

again, this time researching costumes
from that period. | wanted to create a
hero, so | looked a lot at military uniforms
and did some little studies of the outfits

that really spoke to me (image 01)

| particularly liked the German deadhead
soldier's roped jacket, the officer's jacket
buttons, and the blue boy scout's crossed

eather bands. | looked at paintings

porary to the time as well. You can't

have too many references, so | created

w folder in my reference library for

ything | ¢ find from the 19th century.
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A An example of one of the patterns and brush texture settings | used

A Three mannequins, ready to be dressed

& Toure st T

e,

Step 02

Different materials

When painting outfits you'll come across

a lot of different materials. Each material
has a different color and texture, and reacts
differently to light. While warming up | noted
which materials were going to return in the
outfit and did a separate study of those.

In image 02a you'll notice that there's a big
difference in values for each material. I've
put the value range in black and white below
each, and you'll quickly notice that materials
like metal and gold reflect a lot more light
than fabric does. Their highlights are
stronger and they reflect their surroundings
a lot more clearly than the fabric, which has
almost no highlights but does have very dark
shadows. The texture is also different in each

material: some are rough, some smooth

To paint the different materials | used exactly
the same brushes as | did for painting the
face. | did change the pattern in the texture
mode from time to time though (see image
02b). You can find great textures on sites
such as www.cgtextures.com. To create a
new pattern, download the image and open
it in Photoshop. Then click Edit > Define
Pattern. To get that sleek lighting look for the
glossy-looking areas on the edge of the balls
in image 02a, | used the Dodge and Burmn
tools around the edges of the ball masks.
The highlights were painted manually.

Step 03

Mannequins

Just like a fashion designer, start out with an
anatomically correct mannequin. Picture it as
a dummy which you dress up the way you
like. It shouldn't be too detailed since it'll be
covered with clothes, but it's important to get
the big volumes right. If the base is incorrect
it will be very difficult to rectify it later on, so
really make sure the foundation is right

Eventually, | duplicated it so | have three
figures and can therefore create three
entirely different outfits. This way you

keep your mind open and, especially in a
production pipeline, it gives you a few options
to show to your client, which is always safer
than coming up with just one suggestion
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Step 04
Dress to lill

3 fun thi

er | kept the

1d introduced b with spurs

to push

Step 05

Assigning values

A Three costume gns, using elements from 19th-century costumes but combining them to
create something new and unique

4 Thinking about the big values is important if you want to create a character that's readable




Still, all these elements will have to work As a result. you can see that the ropes age 82). but the difference here is

together and support the character. in the second jacket become a lot that instead of painting muscles you're
more subtle and the emphasis moves painting different materials and wrinkles

It's important to keep this in mind and think towards the buttons on the coat

about what you want to emphasize and The way you approach it, however, is

what you don't. For instance, note that in Step 06 almost the same. Think about the body

image 05 there’s a difference between the Making it 3D as a cylinder; think about what side of the

roped jacket in the first character and in the Once you've settled on the basic values cylinder you're painting on and let common

second. In the first | chose to use light ropes you can start thinking about volumes sense lake it from there. It also doesn't hurt

against a dark jacket; in the second | used again. The process is basically the same to keep some references open in a separate

light ropes against a mid-range jacket as in the chapter on painting the body window; | almost never paint without them

4 Pushing the values, thinking about the direction of the light and which planes are facing it 06

% PRO TIP

Using the Histogram

The Histogram is a great way to keep track of your values. You
can consult it by pressing Ctri+L, which opens up the Levels
pop-up window for the layer you've got selected. Alternatively
you can also open the Histogram palette through Window >
Histogram, which shows you the Histogram for the entire image

What the Histogram does is show you how many pixels of each
value there are in your painting. In the image here you can clearly
see that for my costume layer the curve leans towards the left,
which means I've got a lot more darks in it than lights. Note that
no pixels are entirely black (0) and no pixels are entirely white
(255). This is an important thing to keep an eye on since pure

black and white can quickly make an image feel flat and dull

4 Checking the Histogram once in a while keeps your values balanced and alive
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"Depending on the
material you're paintin
those highlights and
shadows can differ”

Step 07

Picture it!

0 in my mind

hat I'm painting

are directly facin

be light

ding on the materi;
hlights and s
nple, the white A A cutout for part of ths stume. Note where light hits hardest and w)

’ receive light at all
lighter value range than the darl © g

% PRO TIP

Photographic textures
Freetextures.3dtotal.com has a great

and free collection of textures that

you can use in your paintings. These
photographic textures can help you get
your materials just right. Simply look for
the right texture, paste it into your layer,
and use your mask to select the part
you need (Ctri+click on the thumbnail
of the layer in the Layers palette)

If you change the blending mode

of your texture layer to Soft Light or
Overlay and reduce the opacity, your
materials will suddenly become a lot
livelier. This is one of those occasions
where subtlety is key, though. Textures
should boost your painting, not be a
substitute for it or an easy way out

4 Photographic textures can really liven up your clothing

areas hardly




A Pushing the values with the Burn and Dodge tools

"When working in black
and white you don't

have to worry about
oversaturating the colors,
so burning and dodging
areas is a quick and easy
way to push the values”

Step 08 You the g
Pushing the values on pag t brush to go
A great way to push the values further evel g part of the outfit to

(that is, push r darks darker and your on shac




Step 09

Color through history

The color of clothing has changed a Iot
over the course of history, so researching
the right colors for your designs can really
make your character believable. Think
about what people dressed like in the 90s
and try to picture a medieval warlord in

those colors. Doesn't work that well, huh?

In the case of my 19th-century hero, | noticed
the recurring colors from that period were
navy blue, ocher, and burgundy. So with
those colors in mind and a brush with the
painting mode on Color, | quickly went over
the bigger elements to try out some different
combinations. After that | gave them one

more round of detailing with a regular brush

Step 10

We have a winner

After a while | settled down on the second of

roped jacket were the better combination of

the three figures. | felt his double coat ar

the three and | liked the double-colored pants
combined with the dirty boots. | wasn't too
sure about the belt, which | felt was better

in the third design, so | copied that part and
pasted it on my new champion. Lastly | gave
the costume another round of detailing and

polishing until | felt it was ready (image 10)

* PRO TIP

Color noise

If you look at most photographs up close you'll see they tend to have subtie color
discrepancies all over them. Using roughly the same technique to create the noise
for the skin in the first chapter of this tutorial, you can create that great photographic
noise yourself

These color smudges will unify the picture and make the underlying colors feel vibrant.
Follow the pro tip steps on page 86, but ensure you uncheck the Monochromatic

checkbox in the Noise pop-up; use Filter > Blur > Gaussian Blur at 92 pixels instead of
Blur More. This way you'll get nice blurry chunks of color that you can blend over your
painting. In this case, opacity at 6% should do the trick — you don't want to overdo it

A Blurred color noise unifies the picture and makes the underlying colors feel more vibrant

A Using navy blue, ocher, and burgundy as the main colors for the costume

no

09






Pose and background

Learn to pose your character and add post-production effects

by Bram "Boco" Sels

The final pose is often just for
presentation purposes. You've already
decided what your character looks like
and you've got the green light for the
outfit. In other words, everything is ready
to go into production and will eventually
start its new life in the game world. A

lot of studios do, however, still prefer to
have a nicely shaded mood painting of
the character as well. It combines all the
elements and gives them a nice image to
use for promotion. Preliminary sketches
and designs like the ones from the
previous chapters are great and helpful
for a 3D artist to move forward with,

but can’t be used in marketing. Hence
the last step: the polished hero pose.

The main difference here is that the focus
lies more on how you light the scene
and which mood you wish to convey.

In other words, your character should
almost be swallowed by the environment
around him. This chapter will teach you
how to create fog and particle effects

to do just that. By smartly using light
and color you'll quickly learn how to
create the illusion that your character

is really standing somewhere.

Step 01
Warm-up 5.0 (the quick one)
A good exercise to warm up with is to

do some gesture studies. Look at some

12

A Quick gesture studies with the line of action going through the middle

reference photos and try to lock down
the poses as quickly and with as few

ines as possible. These geslure lines

are the bare minimum you need to get

area

pose. And if you decide to
take them further, everything you add
from then on should be submissive to

these simple but dynamic guidelines

Also notice that one line in particular is
the absolute king of lines, that's the line of

action. It goes right through the torso and is

what makes the pose dynamic (image 01). A

good thing to remer

ber here is that if you're

looking to create s 1ing dynamic, the line

s be a curve. A curve

of action should alwa

indicates movem

lines quickly tationary a
Step 02

Mannequir

As in the previous chapter, every character
painting | begin starts with a basic

mannequin which | then detail. When | first



"You can't build a house

on crooked foundations. If
your mannequin is off, your
end result will be too”

nnequin dressed up and ready for action

% PRO TIP

Painting fog

Step 03 Volumetric fog is a natural phenomenon that's
Translating the design used by a lot of concept artists to create depth
Once the mannequi in a painting. By placing something both in

front of and behind a character you make
him or her part of the environment. You can
create custom cloud and fog brushes to use

Keep in mind that fog is so organic that it's
impossible for two parts of it to look alike and
by using pre-made brushes you're bound to
end up with such copies. You can counter
that problem by quickly blocking the fog

out with cloud brushes, but then heading
back in with a regular soft, round brush and
erasing and smudging the repetitive edges.

A Volumetric fog makes the environment swallow the character




4 Most body parts can be seen as cylinders, to which it is easier to apply the rules of perspective 04

Step 04

Perspective

Something that is often forgotten by beginner
artists is that even characters have to abide
by the rules of perspective. Even though

you might not see the obvious straight lines
moving towards a vanishing point, it doesn't
mean that perspective doesn't apply.

Think about every body part as a cylinder
and try to figure out how it's oriented. It's
a good idea to draw a horizon line on a
separate layer as it helps you put your
shapes into the context of perspective. In
our case, the most obvious cylinders are
in the boots; look at how they are below
the horizon line (image 04) which means
we see the top of them. Knowing this will
help you to visually calculate how the
boots should appear around the leg

114 Beginner’s guide to di

Dragging and dropping a layer on the
Create New Layer button at the bottom

of the Layers palette quickly generates
duplicate layers and keeps a backup hidden
underneath your new one. It's a good

idea to keep backup layers so you can
always go back a few steps if needed

Step 05

The final mask

For the final image | decide to mask every
element of the outfit on a separate layer:

“Waistcoat”, “Skin”, “Coat”, “Pants & Jacket",

and “Junk” for things like the musket and
boots (see image 05). Keeping elements
on separate layers gives you freedom to
fluently paint on the layers below, and you
can quickly use the Burn tool to darken
the transitions between different pieces of
clothing without affecting what's on top

4 Masking everything onto separate layers

| had decided | wanted to create a
dramatically backlit scene, so as a first
step towards this, the Light layer above
the layer stack is an Overlay layer that
brightens the top of the image.

Step 06

Detailing the face

A trap I've fallen into a lot before is detailing
the face just as much as the rest of the
body, marking the place of the eyes, the

tip of the nose, and the line of the mouth
without worrying about the rest of it. That
way a lot of subtle information goes out

the window and these gaps need 1o be
made up later on. | feel it's much better to
zoom in a bit and really plan the portrait out
in advance. It's more manageable when
you have a very specific face in mind, and
it will save you a lot of time later on



% PROTIP

Color adjustments

Adjustments can be made directly into a layer through
Image > Adjustments, but can also be made via an
adjustment layer, which you can find directly above
the Layers palette. Working with an adjustment layer
does create another layer, which will clutter up your
file, but on the positive side you can toggle it on or
off later on. This means you can always change the
settings later on. Color adjustment layers allow you to
experiment with color and tonal adjustments without
permanently modifying/changing the pixels in the
image. In this case | used a Color Balance layer to
make the entire image coherent. The color options

you can see in the image here map an existing the color changes unified. Color Balance can also be a great
range of pixel values to a new range of values, which helps keep way to get some extra color in the shadows and highlights

A The Color Balance adjustment layer, an easy way to unify the colors in your painting

A Planning out the facial features for the portrait




Step 07

Changing the lighting

| wanted to create a more dramatic and
foreboding environment, so | had to
change the lighting scheme somewhat.
To get that dramatic vibe | increased
the back light and moved in some fog to
disconnect him from the background

To paint fog, | create a brush from a cloud
photo/texture. Do this by opening a cloud
photo (it can be one you have taken yourself
or from a free texture site), and, using the
Lasso Tool, select an area of the image from
which you want to make the brush. Right-
click the selection and select Feather to
about 20 pixels. This blurs the edges. Then

copy and paste onto a new document

We now want to desaturate the cloud: go to
Adjustments > Desaturate (Shift+Ctri+U)
Add a Levels adjustment layer and move the
sliders until you end up with a blacked-out
background. Next add an Invert adjustment
layer (Layer > New Adjustment Layer >
Invert). You should be left with a nicely
defined cloud, so choose Edit > Define Brush

and you now have a ready-to-use brush

Returning to the figure, | blocked in the
values, looking closely at the images from
the previous chapters to make the final
illustration as consistent as possible. You
might be tempted to copy parts directly
from your previous designs, but | feel

it's better to just paint them again from
scratch. It'll be more correct and you'll have

more control over what you're doing

Step 08

Cue the dramatic music

If you're creating a mood piece like this it's
important to think about the color scheme. |
knew that | wanted it to be cool and dark to
get that tense vibe across, so one of the first
things | did was darken the background and
tone it blue. | also started toning each part
of the character in its local color (the color it
has under neutral light). It's important to note
that color changes when under a colored
light, but | wanted to get the local colors as
close to the original designs as possible
before worrying about the color of the light

1é

% PRO TIP

Particles

Adding particles is another
fantastic way to liven up an
environment. Be it snow, rain

fire embers, or in this case

dust, it makes you “taste” the
atmosphere. | used a grainy photo
of a moldy brick wall and placed
it on top of the layer stack with
its blend mode on Calor Dodge.

| reduced the opacity and erased
the particles that | felt got in the

way of more important elements.

| think that after erasing, only
about 20 percent of the particles
remained, which was just the
right amount to keep it subtle

4 The dust texture | created from a photo of a moldy brick wall






"Some artists just starting
out may be tempted to
throw over an adjustment
layer at this point and call
it a day, but that should
only be the starting point.
Your lighting becomes a
lot more accurate if you
take the time to go back
in and touch up your new
colors by hand”

Step 09

Grounding the character

To make your character feel real and
believable, it's important to suggest that
he's actually standing somewhere. A great
way to do that is by creating a platform and
giving him a cast shadow. For the platform
| used a free texture of a cobblestone road
and used Edit > Transform > Perspective

to warp it towards the horizon

The shadow was created with a Multiply layer
(see page 23) on top of that. Finally | added
some fog in front of the character to really
create the illusion that he's not just a cutout

but an actual person standing amidst the fog.

Step 10

Pushing the mood

At this point the character still feels unhinged
because of the local colors. It feels as though
the mood and lighting have no impact on

him whatsoever and that he is lit with a
different type of light entirely, which makes

him feel disconnected from his environment

vhat needs to be done is to look at the
different local colors and calculate what

they will look like under a blue light source

e coat will become more vibrant,

the undercoat will mix with the

1d turn purple

| become a lot colder. Some

and call it a day, but that should

only be the starting point. Your lighting

mes a lot mare accurate if

the time to go back in anc

on the

by hand. As you can s

ge 10 shows the final version

ne

A Creating a platform and cast shadow can really ground your character









Creative workflows

Learn how to create different styles of characters in
Photoshop by discovering the processes of top artists.

With the many different approaches and techniques accessible in a
program as powerful and versatile as Photoshop, many artists have
adopted signature and unique styles. Part of growing as a digital artist

is crafting a style of your own and over time you will soon refine your

own techniques. To help you on the path to developing your own style, a
selection of talented artists, with a plethora of knowledge to share when it
comes to digitally painting characters, are on hand to guide you through
their creative workflow. Each artist will talk you through their complete
creation — from initial ideas to the technical process — sharing their tools,
methods, tips, and tricks. which will encourage you to find your own style



Desert man

Create an evolved human designed for living in the desert

by Derek Stenning

In this chapter we'll go though
the steps | usually take to create
a character design for a client.

The assignment for this design is to
create a character that has adapted, or
evolved, to live in a desert environment.
The design brief is pretty strict, in

that even though the character has
evolved, the character must remain
human, with two arms, two legs, and
so on. This means the evolutionary
changes won't be too drastic, but
they will (along with equipment and
costume elements) help the character
cope with the desert environment.

Challenges of a desert
environment

To warrant the need for these
evolutionary changes, we won't be
using any high-technology solutions

to the challenges posed by the desert
environment; we'll keep it fairly low-tech.

An important thing to look out for in

a brief is a scenario or story. When
design assignments don’t have a
scenario aspect to them | usually make
one up myself, as it is a huge factor in
making design decisions — what is this
character doing in the desert anyway?

My process for this assignment will be no
different, so I'm going to imagine that the

Covered clothing:

+ Block cut heat and sun

+ Robes, capes, layers

+ Light in color 10 reflect heatirays

Not going to Nocturnallcrepuscular:

Evolution: Aestivation ysa this * Burrowed, inactive in day
« Abity o close nostrils + Shaller
+ Smaller mouth, no lps
Avoiding
—_— heat | Increased mobility:
El"';::g-“dneys - X + Aids for traveling in sand, loose
bty Retaining | Extremes of L]
water temperature s i
ik g Walking stickicanestaft
Cold at night
k
Lact of [ Covered clothing:
A water f Dissipating  « Light in color fo raflect heatiays
cquiring / Staying et
- / warm at Evolution:
night «Amove to darker skin

Moisture trap

+ On staff andior body?
Ground water pump

+ On staff?

Stores carried on body

A Collecting the various design problems in this assignment and thoughts on how to address them m A References are a great way to inspire
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Covered ciothing
Shelter to stay warm

»Longer limbs/bedy to allow more
heat loss

* Increased shoulder width 1o allow more
airflow and heat loss between arms and
bedy. Same for hips?

«Larger ears o allow heat 1o escape

character is some sort of scout; maybe he
is tasked with patrolling the vast desert
boarder areas of the society or group that
he belongs to. This task will require him
to spend extended periods of time out in
the desert alone. Even though his people
have evolved to be better able to cope
with this environment, the scout will have

to be equipped to carry out his mission.

Step 01

Character and environment research
| always start my designs with a little look
into the subject matter. I'm no expert in
evolution, or in desert environments, so

a little time spent learning about those
major elements for this assignment

could go a long way in informing my
design choices for this character.

| look into the challenges of living in, or
adapting to, a desert environment. The major
issues are the extremes of temperature

h milIﬂ LY




Brow:
Large brow to protect eyes.

Ear:
Enlarged ears allow heat
to escape the body

\ Mouth:
Smaller mouth, with little or no lip
helps retain moisture

Eye:

Alarge brow and darkened eye
wells help protect the eye from
intense light

A nictitating membrane helps
to protect the eye and retains
moisture

“-F
A \;’
7

Y ./)

Nose:

A flattened nose with nostrils that can
close helps reduce evaporation and
prevents moisture from escaping

A A sketch of potential evolutionary changes to adapt to a constant desert environment

(hot in the day, cold at night), and a lack of
water. To address the temperature issues,
I'll have to find ways for the character to
avoid and dissipate heat in the design.

I'll also have to find a way this character
can retain or acquire water. The desert
can be a hostile environment, so that will
have to be reflected in the design. | take
all my notes and collect them on an idea
map for quick reference (image 01).

Step 02

Image reference gathering

After taking time to think about the design,

| spend more time gathering images that

I think can inspire me or introduce me to
new ideas. References help to expand your
thoughts on a particular idea, so | search
for what | think are topics related to the
assignment at hand. | collect images that
strike me, or contain something that seems
to address a part of the design concept, and
put them on a reference sheet (image 02).

1 limit my time doing this as | could search for
reference images forever; I'm only looking

for little bits or elements that contribute to
the design, not for the perfect image.

"I'm keeping the body long
and lean, as this will allow
for less heat retention and
increased heat dissipation”

Step 03

Evolution study

The brief states that the character has
to remain human, so the first step in this
design is to figure out the evolutionary
changes to the body that have occurred
for it to live in this desert environment.

| sketch these ideas out, as | find that it
moves things a little faster than painting.
In Photoshop | use a simple round brush
with pressure sensitivity set to around
10-15% and opacity set to 50%. | lightly
sketch out a few of the ideas that came
to mind after putting together the idea
map. | sketch these ideas out loosely on
a layer, and once I'm happy with them, |
then tighten them up a bit on a new layer,

Body:

The slender elongated body
allows for less heat retention.
Wide shoulders allow for
increased airflow between
the body

Pigment:

Darker skin pigment helps with
the protection from high UV
radiation. Here, for visual interest,
I've broken up the darker pigment
areas to create fades and spotting

[ o3 |

adding a bit of quick shading to help define
them and to give them a little “pop”.

As it is early in the design phase and since
this material is mainly going to be used

to create another design, these sketches
don't have to be too final or polished - they
just need to communicate the ideas.

I'm keeping the body long and lean, as

this will allow for less heat retention and
increased heat dissipation. Wider shoulders
set the arms away from the body and allow
for increased airflow and more heat to
escape. Darker skin pigment, in image 03
broken up into spots and fades for visual
interest, aids in protection from UV radiation.

On the face, a heavy brow, darker eye wells,
and the re-introduction of a translucent
nictitating membrane protect the eyes from
UV radiation and airborne debris. Larger ears
facilitate more heat loss and a smaller mouth
decreases the loss of moisture. The nostrils
have gained the ability to be open and shut
when breathing to conserve moisture.
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Step 04

Silhouettes round 1

I love using silhouettes when designing
characters. Itis a quick and easy way
to rifle through various design options
Here is a quick rundown of how | create

the silhouettes for this very purpose

First, | sketch out a quick pose over my body
sketch from the evolution study | did earlier
(under the pose on its own layer set to 15%
opacity), so I'll know I'm keeping within

my original proportions (see image 04a)

Then | rough out some loose costume
elements and ideas over the pose sketch
(see image 04b). Then with an angled
brush set to 100% opacity, | fill in the

main body forms (see image 04c)

P
k' e MFeTeTs
Llalals
\ HER X
“ u
f =
A A quick pose sketch

A Filling in body forms
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Once the body is filled in, | fill in the interior

of the cloak and the hood on a layer beneath
the body fill (image 04d). | do this so | can
lighten up these areas to give the silhouette
more form and depth. To lighten these
areas | just use the Radial Gradient tool

lightening the areas furthest away (see

image 04e). Then | darken up the elements
closer to us: the front side of the body

belt and the

1t hand (see image 04f)

The next element | get to work on is a

staff/rifle tha! ses for protection

and for aid in traveli This is a more

compl o I'll paint it in profile,

as you can see in image 04g. | use the

Free T

1sform tool to move this element
e 04h). The final
04i

nto

silhouette n imag

Now | repeal these steps several more times

vith different design options.

pl

nents to

The options ure various e

address the temperature issues, such as

layered loose robes
providing hoods. These elements are meant
to double as shelters at night. Water-saving
devices such as moisture traps and filters

combine with water storage elements

Protective footwear and armor combine
with staffs to aid in traversing loose, rough
and hostile terrain. Signal reflectors

flags, and silks aid in communication
across the vast desert expanse. |'ve
noted these features on the silhouette
page as points of interest/discussion as

if | would be going over these design

options with an art director (image 04j)

. 3 .
B = /‘
-
. e
v s>
+ 7 P 1
7 \ f
e {
- s
& s A
s 4
. ’
s
= L ‘l
s
¥ s+ \
L
¥ = (
= \
1 o
¥« ]
A B
e
Y] s T K .
4 Roughing out costume elements
Y s P
o+ v | G("le@islele
SEIECI il . e ¥
LX) s a[axiaieh
ERrATEt 18 - p » @ @
CaE s il ¢ & [ e
s = -
W 7 e
'/. = s 2
I
7| oste
7l 0[]
a

I A Filling in the interior of the clothing
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4 Lightening the areas further away I A Darkening the closer elements
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A Painting the rifle in profile I A Using the Transform tool to position the rifle I
Reflector
signal
—_— Maisture Armor
Cloal trap
Musket/ ¥
iaf shelter
Water
cistems
L]
L]
L]
‘Robes/
shelter
Louvered Cordacs
Signal garyost
silk
Water
bladder
o @
Cleats
A The final silhouette I A As you can see, silhouettes explore design options in a quick and efficient way I
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Step 05

Silhouettes round 2

We'll now narrow our options down by
choosing our favorite designs and modifying
them, with the addition of new ideas or
elements from other options presented in
the first round. In a production environment
this would be done using feedback from the
art director, but here | let my own thoughts
and preferences guide the process

To put these together you can cut up the
silhouettes using a selection tool, such as
the Lasso, and mash elements together.
Alternatively you can paint elements over the
silhouettes from the other existing silhouette

options or new ideas that come to mind

My first selection is option 7 from the
silhouettes in image 04j as | really like the
simplicity of it and it seems to communicate
the desert scout theme to me. But | really
like the signal silk from option 5, so | paint
in a similar version and alsc add the signal
reflector to his staff to aid in his scout role.

| also paint in water collection bladders
from option 5 along his sides to give him
some more waler retaining/creation ability.

My second choice for further study is option
1, as it also seems to sum up the character.
The only additions | make to him are
extending the armor elements and adding
some armor to his right arm as in option 4,
but in a much more restrained fashion

A Painting in mid-gray tones
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A Revising and combining silhouette design options

4 Sketching details over the silhouette
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Step 06

Grayscale rendering

The next step is to take these two
designs further - to block out the interior
coslume design elements to see haw
they work. This is done in grayscale as
this can be a faster way to render up

a character as you don't have to worry
about color - you can just focus on the
costume/body elements and values

To get started on the grayscale
rendering | first sketch out some interior
elements on a layer over the silhouette
to guide the painting (image 06a).

The lighting will be coming down from the
upper left. To help indicate this and to get
the rendering started | take a mid-gray and
use the Radial Gradient tool across the
upper left side of the character (image 06b)

Then using an angled brush, set to 50%
opacity and with pressure sensitivity on, |
do a quick rendering pass over the whole
character, defining the major forms and
keeping lighting and materials in mind
(image 06¢). | also use a cloud-like brush,
and on a separate layer, fill in behind the
character. This will aid later in rendering.

| now start rendering up individual elements

(image 06d). The headdress is a major piece,

so | start with that. An important thing to
keep in mind while rendering is the material
of the object you're painting. This will affect
how the light is absorbed, reflected, or
plays across the surface. The outer shell

is a worn metal, so it will be well used but

it will also reflect more light than the dark
wrapping around the character's arms. | start
by giving it a little texture to indicate wear
by painting in some variance and marking
with a couple of abstract shape brushes

Then with the round brush | paint in the
panel cut lines (image 06e on next page). |
keep these on a new layer above the main
painting layer, so | continue to paint in the
lighting and texture information without
obscuring these cut lines. As | said, while
this is older, more worn metal, it should still
be reflective, so | decide to paint in more

A Aquick render pass over the whole character

4 Rendering individual elements

% PROTIP

Presentation

Remember that concepts are about
communicating ideas, and you can
communicate your ideas better by
adding a level of presentation to
your work. Of course, a good design

that is executed with a high degree
of skill is the most important part of
creating a good presentation, but you
can make your concepts stronger

by clearly labeling them, following

naming conventions, and including

additional thoughts and information.
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contrast, punch up the highlights, and

ome panel detail (image 06f). | carry out a

final detail pass adding more highlights to the

cut lines, a few more tertiary elements, and a

reflected light from the environment to
give the headdress more form (image 06g)
ss the rest of

| then repeat this process ai

the character, keeping my mind on points
of interest and materials. These aren't
final designs, so only spend time on areas
that communicate unique aspects, like the

headdress, staff, moisture trap, and signal

silk on this character. The rest can be

addressed later if this option is selected

A Painting the panel cuts in Im
Image 06i shows the two options at the end
of this process. The first design focuses
moare on softer malerials like layered loose
robes, the wraps, and the signal silk. He

sems like a traveler, and is somewhat

mysterious, with his headdress and his

face obscured by the moisture trap

The second option explores my idea

of louvered clothing. These garments
can open up to allow the passage of air
and to allow more heat to escape, and
can then be closed up for warmth. This

character also seems more aggressive

because of his armor and how the musket

has been incorporated into his staff A Adding contrast to suggest reflective material

HRene
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e
7|
4 Afinal pass, adding more highlights |
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A | repeat the process over the whole character Im

A The result after grayscale rendering was used to further explore design options Im
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Triad color scheme

A triad color scheme uses colors
that are evenly spaced around
the color wheel. Triadic color
schemes tend to be bold even if
you use subdued versions of your
colors.

Itis best to let one color dominate

and use other two colors as .4
secondary/accent colors.
A The triad color scheme I A Set the blending mode to Overlay and fill the layer with red
4 3 £
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A | use an angled brush at 100% opacity I A | tweak and balance oul the colors I
Ste p o7 Once we have our color scheme sorted, so on a new layer within the layer set | fill
Rough color compositions | create a new layer set and change the in a red color over the entire character.
After the characters have been blocked out blending mode of the set to Overlay (image
in grayscale, the next step in this exploration 07b). This will allow me to use, sort, and | then go over the character, painting in the
is to add some color to help us evaluate the change multiple layers for different colors different colors for the different elements
designs. Color is important, and using an over the grayscale image. | want the hot | create new layers as needed for the
Qverlay layer in Photoshop is a great way temperature to come through on these, different elements. This just makes it easier

to quickly add color to your rough work. I'll
explore a couple of different color schemes

ke
across the two designs and judge the results. s)
| [P
On the first character, I'm going to use 3
a primary triad scheme. Triad schemes . ] _‘, B Ay
use three colors that are evenly spaced =3 }z e -
around the color wheel (image 07a). This | # | osta ™
12| ® e e
method creates color schemes that are ol |s -
quite bold, even when using subdued 9, |® [F4] mae
.
hues, as | tend to do. As | want the heat i ')' 'Ej—-
to come through on these characters, p TS =
v |® ] mawens [
I'm going to use red as my anchor color, G . :
with yellow and blue backing it up  Create a new layer under the character and paint a background | o7e |
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A Levels adjustment layer to alter contrast I

A Adding in the secondary details
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to modify and change the colors as you go

| then select the character and create a
For the painting I'm just using an angled Levels adjustment layer. | tweak the levels
brush at 100% opacity (image 07c). punching up the contrast by increasing
the lights and darks (image 07g).
When the major elements are all filled
in | spend some time tweaking and Finally, in order to warm it up a little
balancing the colors (image 07d). For this | select the character, and then on a
| often pick a new color and paint over separate layer | fill my selection with a
the specific layer, but | also sometimes warm, lighter-toned orange | grab off the
use the Hue/Saturation or Levels character's shadow (image 07h). | then
adjustment panel and tweak the existing set the blending mode of the layer to Soft
Light. As the fill color is lighter than 50%

gray, this will lighten up the whole image

color until | find something that works

After the colors are where | want them,

| create a new layer under the character
and paint in a simple background for the
character to rest on (image 07e). This
was painted with a cloud-like brush and a
texture brush to give it an abstract random
feel. This background helps the “pop” of
the page and will aid in the detail pass

I now do a quick detail pass on the
character. On a new layer on the top of
the layer stack, using an angled brush
with pressure sensitivity on and set to 50%
opacity, | go over the character adding
secondary details (image 07f). | also paint
in some reflected lighting using the colors
from the background to give the character
more volume and depth. As this isn't a
final design, you don't have to go too far
with this detail pass, just get the image to
a paint at which the elements are reading

and you are comfortable presenting it 4 Fxploring passible color opticns

A Wash the character with a warm orange I

and wash it in the subtle warmth of the fill
color. | pull the opacity back to around 40%,
s0 we are left with a warm, hazy feel

kind of like you would expect in a desert!

| repeat this process on the second
character, this time using an analogous color
scheme (a color scheme that uses colors
that are next to each other on the color
wheel; see the right-hand figure in image
07i). | start with the same red base, but move
into violets and indigo as my secondary
colors, and add a bit of orange for an accent.
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Step 08

Creating the final design

After weighing-up the two designs, | decide
to move forward with the first character
option. This version seems to hit more of the
design criteria: the loose, layered robes and
the large headdress (which I'm imagining
will fold out into a shelter) help to block out
heat radiation; the moisture trap, that collects
moisture in the water bladders, helps with
waler retention; the footwear increases

the sale surface area; and the staff will

aid in traversing the loose, rough terrain.
The signal staff and the signal silk (one of
several carried) help this scout communicate
across the desert expanse as well

I'm also moving forward with this design
because it has more emotional impact,
and hits on the solitary, somewhat
mysterious nature of the desert scout.

Now that I've made my choice, | refine
the character a little more to bring it up
to a presentation level. | start by taking
the color composition and merging it
all together, except for the background.
Then | make a few larger changes.

First | adjust the position of the signal staff

bringing the heavier front end down. This
looks more natural given the weight of the
signal end of the staff. Using the Polygonal A :'

Lasso, | grab the staff and free transform
A The chosen character option is refined

it into a downward facing position.

2 Shelter

The large headdress unfolds into a small single-person shalter. This sheiter

is used 1o avoid the hotlest periods of the day, to bed down for the night, or to
provide protection from the desert storms. The staff is separated in two. with the
bottom portion extending to become the main support for this shelter

1 Supplies

Carried on the back, this parcel contains: a

ceramic vessel that carries food and doubles

as a stove, four additional signal silks (in four
different colors), and bedding

. Belt attaches here

3 Signal staff - reflector mirror

The signal staff has a mirror with a hinged
swivel cover. This mirror is used to reflect
sunlight to create communication signals to
other scouts. The swivel cover can be used
to interrupt the refiected light to create signal
patterns or Morse-code-like messages.

4 Detail sketches are a quick and easy way to flesh out elements of the design Im
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Second, | erase the large signal silk to the
left of the character. | want to give the image
more depth, so on a new layer under the
character | paint in a new a new signal silk
that extends back into the background

Now I'll work on tightening things up. I'll
create a new layer on top of the layer stack
and using the angled brush (again set to 50%
opacity) I'll paint in more lighting information
and add secondary details such as the

little weights that keep the robes in place
and the staff details. During this process

| also rework the background with the
addition of a patch of dry, cracked ground.

Step 09

Additional design details

Now that the final design is done, I'll
create a few sketches of additional
design details. These quick sketches will
help flesh out elements of the character
design that don't come through in the
image from the previous step and
communicate additional design ideas.

If you look at image 09, these include a detail
of the supply pack carried by our scout, a
detail showing how the large headdress folds
out into a shelter to protect the character

from the environment (whether from the heat
of day, the cold of night, or a desert storm),
and finally a detail of the signal reflector
mirror that is encased on the end of the staff.

Step 10

Compiling the design sheet

The last thing to do is to compile the design
materials onto a single page. This will serve
as our design sheet that would be used to
present the final design to the client. | take
the final design render, the additional design
details, and since the facial area is half
covered by the mask of the moisture trap, |
include the head elements from the evolution
study as well, and | arrange all the images on
a page with the relevant notes (image 10).

At this point, if there are no revisions
needed, the design is finished. If this
design were to be approved, we would
then move forward with creating a turn-
around and potentially more detailed
images so other artists could start to
implement the design into the final product.

1. Body: the slender elongated body
allows for less heal retention. Wide
shoulders allow for increased

airflow around the body.

A The final design sheet is created to communicate the design to the client
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Eye: a large brow and darkened eyewell
help protect the eye from intense light

Moisture trap: captures moisture from
breath, funnels this down to the water
bladder (worn around back of tights).

Signal silk: used to convey
messages to other scouts.

Bladders: water bladders are slung
around the back of the lower robes.
Filled before missions and can

be refilled at supply stations.

Head: numerous other features on the
head contribute to desert adaptation: ear —
enlarged ears allow heat to escape; mouth
— the small mouth helps retain moisture;
nose - nostrils that open and shut when
breathing prevent moisture from escaping.

Supplies: carried on the back

Shelter: the large headdress unfolds
into a small single-person shelter.

Signal staff — reflector mirror: this
mirror is used to create communication
signals to other scouts.
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Sci-fi female

Design and paint a character surviving in a low-gravity environment

by Charlie Bowater

My starting point for this character is the
theme of “low gravity”; the idea that the
character must have adapted to survive in
that particular aspect of her environment.
My first priority is to find out what the
effects of low gravity on the human body
actually are. Although there’s no way

to know what the effects would be long
term, common side effects for astronauts
are loss of body mass and bone density,
nasal congestion, muscle atrophy,
motion sickness, sleep disturbance,

and bloating due to blood pooling in

the center of the body. Sounds great!

Those are just a few starting points that
could spark an idea for character design.
Next | want to think about what | actually
want to paint. What kind of colors and
designs do | have in mind? | really like
the idea of taking some color inspiration
from space itself: a very deep, dark
background and some vibrant splashes of
pink and blue to highlight the character.

I also really like the idea of a bit of white
armor, a la storm trooper, to add a nice
contrast to the dark background.

It helps to throw together a mood board
or collection of references to get the ball
rolling! None of them have to be anything
that you have to stick to, but they can
really help with inspiration and remind
you of what you originally had in mind.
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4 I'm really just focusing on the general shape of the character at this point

4 | have a few ideas in mind in relation te low gravity; I'm having fun and seeing what works



A Copy and paste from your other designs

Step 01

arting with a sketch

To get started with my sketches | open
up a new canvas, usually around 3500 =
4900 pixels. | like to work on fairly high-
resolution canvases, as they're large

enough to accommaodate all of the detail

I'll add later on; my canvas also needs to

be large enough to be printed eventually.

On a new layer, | start to block out some

very rough silhouettes of different character
designs. | like working in silhouettes and
rough sketches to start with — | can be

very detail focused, so it's good for me

to try to not worry about details too much
at the start and just focus on the overall
shape of the character. | still try to include
character traits related to the effects of

low gravity on the human body, though

a larger torso due to blood in the body

pooling around the core, in particular.

Step 02

teration, iteration, iteration

Once you've decided on a particular
character shape that you like the most
you can move forward and experiment

with some variations on the design

New Fill Layer
New Adjustment Layer

Craste Clipping Mask

AiteCtrle G

Smart Objects
Video Layers

New Layer Based Slices

Group Layers
Hide Layers
amange

&lign

Lock Layers.
Link Layers
X

Merge Visible
Flatten Image

ShifteCtris £

4 I'm opting for a blue monachrematic color palette but then contrasting it with a vivid pop of pink | LS

The reason | chose to move forward with
the silhouette highlighted in image 02 is

that it's the one that | personally liked the

best; it has a simple and very readable

pose so you can understand the shape and

design of the character. It also included

the low-gravity

acter trait of a larger

san experiment with

core. At this stage we

the finer details of the design (such as

rstyles, and so on)

ostumes, armor,

until we reach a d

gn we're happy with

Step 03

Deciding on the initial design

As you can see we have my initial

chosen design in image 03. | like the

look of this outfit and it hits on some
of the elements | want to include; it's

form-fitting and a little structured

I do like

~ertain aspects of the other outfits
as well, but I'm happy to go ahead with
this as my initial design. | can always add
further elements to her design as | work
my way through the painting. Sometimes
I'm pretty set on the initial idea and other
times the idea progresses throughout the

painting. | think either way can work well

depending on the purpo: the ct

Step 04

Starting the color worlk

Now that | have my chosen design | can
start adding color. I'm going for a very bright

high-contrast color scheme, as | think that

will work well with the sci-fi theme. You can
use any color scheme you like, but try and
use colors that work well with each other.
color wheels are great for seeing which

colors complement each other (see step 09)

| add dark blue on a new layer underneath
my character and then add a mid-tone
skin color to my character. For her skin |
choose a mid-warm beige tone that isn't
too light or dark — | just want a starting
point that | can then develop further with

adows and highlights in different tones

Always remember that the base color is

likely to change a lot when you add further
layers of color throughout the process
so there's lots of room for tweaking these

colors along the way if you aren't happy.

Once I'm happy with my own base colors, |
select both the character layer and any color
layers relating to the character and merge
them together, by selecting Merge Layers in

the Layer menu (Layer > Merge Layers)
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A | flip my canvas



% PRO TIP

Keep it simple

| try not to get too bogged down with
too many brushes. Custom brushes
are great and you can add some great
textures with them, but I'm not sure
how helpful they are when you're first
starting out. I'd definitely recommend
keeping your brushes fairly simple
and honing your craft before you try
using every custom brush that you
can get your hands on. A fancy brush

will never rescue a dodgy painting!

Keep your brush nice and small when painting finer details

Step 08

Color transitio

A Keep color swatches visible so you can keep referring back to those colors 08



Step 09

| want to briefly on the subject

itsel

2ory, which is a whole kettle of fis

matic

ve gone for a fairly monoch

color theme for this illustration, as you
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on blue. If | kept everything in the i

t would lo

splash of vibr k in her hair
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Step 11

Lighting and form

At this stage | want to build up the form of
the armor and lighting as | go. In order to
do this, | take my regular brush as usual
and much in the same way that | added
lighting to the character's face, | paint in the
areas where the light will hit the armor.

You can block this in quite roughly if
needed, but | also take some time to
softly blend the transitions between the
light and shadow. Like in step 05, you can
always lower the opacity of your brush if
you struggle with blending; this way you
can add strokes of paint very softly and
gradually, so blending should be easier

As mentioned in step 10, | want her armor
to appear quite matte and in order to
achieve that texture, | avoid adding any
shine” to the armor. To understand where
the light is going to hit the armor, | just think
about the areas of her body that protrude
further outward, and will catch the light
under her ribs and bust, for example.

Step 12

A little more lighting and texture
Up until now | haven't really paid

much attention to the lower half of the
character's body, so | spend a bit of
time building up the form and lighting on
her legs. Her legs are generally going
to be a lighter calor than the rest of her
as they're closest to the light source

So, with a lighter shade of her suit, | add
some shape to her legs. It helps to think of
them as a cylindrical shape when it comes

to adding form. They are brightest in the
center of the leg. along the shin, and then
gradually transition into a darker shade
towards the sides of her legs. You can also
add a bright streak of color as a bounce light
on the sides to contrast the darker shade and
to clearly define the silhouette of the legs

To add texture, you can either directly
reference photographs of texture (fabric for
her outfit, as an example) or lay it over the
area you want to place it and experiment with
different layer options and opacity levels

4 Use soft lransitions between highlights and shadows to create form without adding shine 11

Overlay usually works best — a handy way
to increase the brightness and contrast is to
add in some highlights on an Overlay layer
along with setting that layer to a clipping

mask (page 21) - but try a few methods

and see which gives you the best result

4 Add in some highlights on an Overlay layer and set that layer tc a clipping m

Another option is to leave out
photographic textures and experiment
with different brushes and paintstrokes
to emulate the texture instead. Even
just a few scratchy marks can read as

a worn texture when zoomed out

e | 12



A Break the hands down into simple shapes

Step 13

Step 15

Step 14

4 Artis supposed to be fun, so if you want I 14
to add something ridiculous then do it!

% PROTIP

Experiment with color

If you ever find your color palette isn't quite as harmonious as you'd like, a good tip is
try experimenting with Color Balance. Make a duplicate layer of your painting (Layer

> Duplicate Layers) and then click Image > Adjustments > Color Balance. This can
be a great way of gently tweaking all of the colors in your image at the same time
Try nudging the dials a little; maybe increase the concentration of blue or pink —
an even bright f it v just experiment and see what looks best. You might only need to k things the
T i st tiniest bit, but it can have a really big impact on how well your colors sit together







Medieval jester

Concept and illustrate a medieval jester

by Ahmed Aldoori

Research is an important foundation

for creativity, so | find myself looking at
old medieval paintings as a start. Sure,

| could just copy a jester’s costume
directly from reference and call it done,
but that would be boring; we as artists
have the opportunity to take something
and put an interesting spin on it to fita
character. In this chapter we will go from
the development of loose pencil drawings
into a more refined design at the end.

"Even though they won't
all make it to the final
illustration, it's beneficial
to feel that the character
has emotion while you're
designing the costume”

It's important to get a feel for the
character’s emotions. | want this jester to

be a sinister type who despises everyone.

He's a court fool, after all. Conveying
this idea is supported by sketching facial
expressions within the design process.
Even though they won't all make it to the
final illustration, it's beneficial to feel that
the character has emotion while you're
designing the costume. Otherwise it will
feel like you're designing a costume
tailored for a blank mannequin.

An understanding of anatomy is a
required skill for this type of design.
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A | don’t render out tiny details early on because loose pencil work can indicate many possibilities I



e

M fo)

d

A Afew of the many sketches | did in my sketchbook to get a good I

understanding of a jester

Without knowing how the human body
works, a cool-looking costume in a still
image could end up completely useless
when it comes to being animated for
human movement. Photoshop knowledge
is also important for this process. | will
be using layers, levels, and blending
options to help me with my design.

"A typical T-pose is an
option but | want to make
this look interesting, so |
go with the more pensive
stance. It's important to
flush out a lot of different
pose possibilities at this
stage in the process”

Step 01

Exploration sketch phase

You'll find a variety of different jester
designs from history. There are extravagant
costumes that include all kinds of silk and
silver bells, and there are simpler costumes
that appear to be made out of rags.

4 | drew these as small thumbnails in order to avoid getting caught
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up in details. The gesture of the jester is the important factor in this phase

In the sketches you can see in image 01,
| am figuring out different hat designs,
as well as fabric configurations. The
expressions on the faces help me
solidify the jester as a real character.

Props are important, too; a lot of the
jesters had some kind of rod with a
mask on it, representing a smaller
version of them, to add to the whimsical
entertainment they provide for royalty.

Step 02

More pencil drawing

In addition to using expressions to help
salidify the character, the poses are
important as well. It helps to think about the
character in motion; in this case the jester
could be performing in front of his audience

In image 02 you can see that I've chosen
to give him an angry look in order to
indicate the resentment he holds towards
everyone. The evil smile in the top right
can really sell that idea of him being

truly sinister; it's universally understood.
Stay away from anyone that looks at
you like that! On the bottom right | have
made a smaller version of him.

Step 03

Pose specific to the final image
Until step 07 we only need the basic
Brush tool with pen opacity turned on.

The poses you can see in image 03
have been drawn with the final image
in mind. Whatever the final illustration
is it must showcase the costume
completely for the art director or 3D
modeler to understand its concept.

Keeping this in mind, | do my best to
avoid poses that cover up important

parts of the design. A typical T-pose is

an option but | want to make this look
interesting, so | go with the more pensive
stance (marked with a red star). It's
important to flush out a lot of different pose
possibilities at this stage in the process
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A The thumbnail beneath eventually fades l
away as | repeat this step on top of this drawing

Step 04

Pose refinement phase

| lower the opacity of the thumbnail from step
03 and make a new layer on top to draw
another pass of the design. | take the creepy
face | drew earlier and use it as reference for
this, drawn at a different angle (image 04).

For the masked rod | draw a geometrical and
symmetrical frame to act as a placeholder
for the mask to be drawn in perspective.

It's better to lay down a foundation to

help guide your drawing, rather than

trying to draw it without a framework.

Step 05

Refinement round two

| do the previous step again on top of the
first drawing pass. This allows for another
layer of precise detail. The main difference
you can see in image 05 is form indication.

The jester hat is a complex object so it
requires some planning. | have the hat shape
drawn out from before; the form was slightly
suggested, but here the wire-frame lines help
make a clear statement of its volume. On the
floor you'll see a grid sketched beneath him
to indicate perspective. This will ground your
figure so that he seems to be standing on
actual ground rather than floating in the air.

Once again this pass will slightly fade
away as the next drawing pass comes

144

Ko
0
VN

A This pass will slightly fade away as the I-
next drawing pass comes into view

into play. This is a building process; one
step lays the foundation for the next.

Step 06

A bit of tone and value

Again, the opacity of the previous step is
lowered. This time | draw in the triangular
patterns on the jester’s costume and

fill it in with value. The value breakup

will help you control the focal point.

It's important to be smart with value
placement. If the darks are too evenly
distributed you will lose movement and focus,
unless having a bland design is the intention
We want this character to stand out. You'll
notice in image 06 that I've drawn the mask
on the side. This was easier to draw on a

flat view, which will be put in place using

the Free Transform tool in the next step

Step 07

Transform into perspective

Up until now the only Photoshop tools |
have used are the basic brush and layers
In this step | use the Free Transform tool to
place the mask onto the rod in perspective

Press Ctrl+T and a bounding box will
appear: you can hold Ctrl and click and
drag the corners into any perspective.
Once you are happy with the placement,
you can double-click within the box or
hit Enter to finalize the transformation

N
|

A Still fairly loose here: it's not necessary lm
to do a perfect line drawing

i
\\i

This is very useful for placing things into
perspective. The Free Transform tool is
also useful if you want to explore different
proportions of your character. You can use
it to squash or stretch him to your liking.

Step 08

Masking the jester

Making a mask for your design will make
painting it a lot easier. The purpose

of this is to make a sharp silhouette

A Using the Free Transform tool



under the

Step 09 ester color schemes con

on its Color thumbnail exploration and gre nt to make an interesting
=warm and cool change to the typical colors, so | try making
Coming up with a decer olor scheme oJo] {V ed by a warm
be dif at first. He er, if you sim, orange (second row of three in image
do this above any layer by ho the f ss to a few colors, you can come 09). It seems out of place. and | like it
king between the 3yers in p with many variations to choose from

anel. You can create muiltiple The first row of three you can see in image Step 10

layers this way and whatever you paint will 09 is dominant with warm colors, green
within the silhouette. | have chosen bein )| nt. In the refere ple 1bnail in the corner of

green arbitrarily; it can be any color.

A Even if | choose a color scheme, it can be easily shifted using the Im A The Jester's face is also on its own layer to allow me to shift the
Hue/Saturation menu to get more variations. This is shown in step 15 colors of everything else very easily withoul messing with his face
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round brush to block in the colors in the

clipping mask. It might be helpful at first to
keep each color set on its own layer: blues

on one layer, yellows on another, and so on

At this point there is no need to model
or render the forms. Flat coloring will
set the local color for the design, which
will then be manipulated using Levels

adjustments. | recommend avoiding
fancy texture brushes when doing this.

Step 11

Lighting and form

Here's a secret method to help you move
forward very quickly by creating volume and
form. Simply duplicate your flat, blocked-in
bits of color and use Levels adjustments to
make them 50% darker. This will make all
the shadows equally dark, setting a unified
value range for all the darks. You then
simply erase out where you want light to
go. | use the Airbrush as an Eraser to shine

light onto the costume. Instead of using just

the Eraser, you can also use a Layer mask

4 Using this method is fast and easy, you won't have to think about specific color accuracy, the ' (see page 78). Both methods wark well
right value is already there

Step 12

Clothing indication and bounce light

3 = Clothing has thickness, and should be

portrayed as such. Once again | use a basic

ihziegesee)

'3

koo
A Always pay attention to clothes and the many ways they wrinkle in real life. It comes in handy Im A Painting some more of the costume'’s I
when you're drawing or painting clothing design elements



A Creating and adjusting the shadow

round brush. Wherever the cloth meets at

a seam, | indicate a lip where the s

might be. Wrinkles are indicate ntly as
well. The purpose of this is to avoid having a

design with flat shapes that are seamless

Bounce light will assist you in showing the
form of the clothing as well. | use the Airbrush
to paint a soft light coming from below. This
also helps indicate the cloth's material

which in this

se has a silky reflectivity.

Step 13

Costume refinement and details

| now paint some more of the costume’s
design elements. Jesters always have
interesting patterns and shapes. | highlight
the triangular design language on the hat
by outlining the dark shapes with a yellow
line. This could end up being some kind of
embroidery or just flat color, depending on
the level of detail that the video game allows

| start painting the face, which also has an
angular language to flow with the rest of
the design. | don’t want to over-paint the
face since the more important factor for this

project is the costur

e the jester is wearing

There is still no immediate need for any
texture brushes or texture overlays.
The round brush look will suffice as

a preliminary design sketch

Step 14
Shadows in perspective
Here is a neat trick that will make your

character m placed in an actual space

Since | already have the silhouette cut out
from the early steps, it will suffice as a semi-
accurate shadow shape. Simply duplicate
the silhouette and use Free Transform
(Ctrl+T) to squash everything down beneath
the character (top part of image 14).

You can then paint in a solid gray color onto
the whole thing using the same clipping
mask methods as in step 08. You can erase
away any parts that do not make sense,
such as the shadow of his leg sticking out
You can also blur the shadow using Filter >
Gaussian Blur to have a softer lighting setup

for your character (bottom part of image 14)
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Step 15

mentioned the

explore oth

k way of generating

or a client

Since we have the face separate from the

an turn that layer off and

ume

mess around with the Hue shift (Ctri+U

This will expose new

1 may never have tho

There is also a drop-down menu within

image

the Hue/Saturation windo!

Drop-down menu for individual
color adjustments

clor-shifting method will work on anything, from props to characters to landscapes. There is no limit to what you can do!

e final illustration

of the medieval jester on the right-

hand page here, shadow and all
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Merchant trader

Use custom brushes to add finer details to your character's costume

by Markus Lovadina

Let’s start with a merchant trader
character description: based on a few
hundred years ago, this is someone who
has come from a distant foreign country
and settled in the West. He now runs a
business from a busy trading port. He
is a confident man, unscrupulous and
calculating when it comes to money.

He is intelligent and sharp-witted, with
an eye for detail and a nose for profit.
His physique displays his success and
conveys his taste for rich food and

wine, which he has in plentiful supply.

The first thing that came to my mind was
the “good old masters”. Referring to the
old painting masters is always a great
starting point. If you observe some of the
old images you can learn a lot, especially
in terms of brushstrokes, lighting, colors,
and composition. This time | decided to
research some Dutch painters, who have
a great sense for color and lighting (as
many others have too). | wanted to go for
a sort of painterly feel. You can find great

reference images by searching the web.

It is very important to start by searching
for references — not only for the design
but to get a feel for the specific theme.
The more | know regarding materials,

patterns, fabrics, and so on, the easier

the design and painting process will be

A Laying down the first colors

After looking at a range of references




and reading articles regarding costumes,

| was ready to fire up Photoshop.

"If you're afraid of painting
on a blank white canvas,
start with the background”

Step 01

Painting tt

ckground is a good way to

get a

ter feeling for where the character

should be placed

and to set the moo
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the entire image. If you're afraid of painting

on a blank white canvas, start with the

background. The painted background could

also be used for showing the color theme
you'd like to work with. A brown tone gives
the feel of an old canvas and will contribute

to the overall look | want to achieve

Laying down the first colors can be hard

but keep in mind that you can always

change them using Color Balance

e

5 of this chapter for more information)
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% PRO TIP

research!

02a

BEEBBBDDDB

The brush texture settings

Research, research,

Nothing is more important
than research, especially if
you have to work on a topic
that is out of your comfort

Don't be afraid of playing around until
you're happy with the first look

Step 02

| paint the background with a simple

round, textured brush (image 02a), set to
Transparency mode, Texture, and Shape
Dynamic (image 02b). | mostly use a huge
brush size and keep the strokes quite loose.
The main focus for now should be the

overall color theme and the compasition

Umkehren

Texture Each Tip
Mode:  Heght

Depth

02b

making notes. This will help
you to save time later on. It
will also allow you to focus
more on the really important
things during the painting
process, such as details,
mood, color, and so on.

zone or has to be as realistic
and believable as possible. It

is absolutely worth spending
a lot of time researching and




Squares created
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4 Adding the floor is a simple way A The fioor pattern will be one of your A Always try to keep your image balanced
getting your first depth into the images guidelines later on between warm and cold tones
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4 The costume is now separated into single element

Step 06




"Adding the first details is
great fun, but you should
still keep in mind what
they are for: showing

the characteristics of the
character’

PR ED DS
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Ctri+L) until you have enough contrast "This will give a 3D feel

d balanc Now go back to top menu and create yo and adds a nice depth,
ush as described in step 07 which is absolutely
necessary to making your
Step 10 costume convincing”

A Extra details add some depth to the character's story A The costume details are starting to come together at this point 11b



Step 12

A Chain custom brush

Brush Presets
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¥ Texture
Dual Brush
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¥ Sevocthing

BB BB

V' Protect Texture

A The final result of creating the chain effect 12c¢

4 Chain custom brush settings 12b A Scaling down the pattern to reuse on the costume 13



"The red stripes on the
trousers bring in a bit more
color variety and portray
his military background.

| also add wrinkles and
more details to the boots
and the costume”

A The character’s face before aging shadows have been added 143

backgrc

letails to the

Step 14

dding in these

helped to add age to the

te these darker

(abo

paint in the smalle

roat A The face after | added darker areas to age it 14b




A Color settings for Highlights

Step 15

Final touches

1 happy with the fina

add some more

ostume, such as the thin

stripes on the lower part of the belt and

also a

ther t

g for his money. The
stripes are on a separate layer and the

fi

layer is set to Soft Light. Us|

g layer

is a nici

way to blend in elements

Now it is time for some slight color

shanges. | make these changes us

alance effect nest, I'm

e with this effect. |

se it a hundrec

ape paintings and

it's pure fun to add some color variety to

shadow

midtones, a

ghlights

1g the Color

alance tool is not a

it is more about playing around
and finding a personal flavor. For sure,
the color should match the topic, but this

is all up to you. See images 15a-15¢

for how | set up the Color Balance. The
important thing is to use all channels -

Highlights, Midtones, and Shadows.

Now it's time to merge all the Ia

save it, and call it a v
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flects

ng the

15a A Color settings for Shadows

Vv Preserve Luminosity

A Color settings for Midtenes

% PRO TIP

Create your own image library

One of the most important aspects of my painting workflow is my huge personal
image library. | try to have a camera with me all the time, in case an opportunity
arises to add to my library. This will be enough to capture a mood, a scene, a

color combination; you could use an image as a texture for one of your upcoming
paintings, or even create a custom brush out of it. I's also a good way to study
light and materials. And the best thing — those images and photos are all yours.

15b










Quick tips
Discover how to create common elements
used in character design.

Characters are made up of many different elements that all
play a role in the believability of a design. The visual credibility
of these details can influence the success and quality of your
paintings, which can cause problems when you are trying to
paint something that you have never painted before. So, as a
beginner artist, it is useful and important to practice the art of
recreating convincing details and textures. To help you develop
these skills, this section will offer a myriad of approaches and
tips for creating common details and textures such as skin, hair,
and lace, all of which will help to improve your workflow.



Curly hair

by Bram "Boco” Sels

01 Line drawing

Curly hair is mostly characterized by locks of
hair twirling and interlocking with each other.
It's important to lay down an outline for each
lock. In the example a lock of hair spirals
down and gets pointier towards the end

To keep your curls organic make sure each
turn follows the same direction as the last

02 Masking the form

Create a second layer underneath the line
drawing and use a regular round brush

to block in the shape of the hair with a
solid color. Typically curly hair has areas
of white space around the edges, so try
to create your locks so you can see the
background (or skin) through the gaps.

03 Painting the highlights

and shadows

Creale a new layer on top of the line drawing
and determine where the highlights are

with a color slightly lighter than the base
Wherever a curl is pointed towards the light
(see arrow) a highlight should be there. On
the other side of the curl will be a shadow,
so with a slightly darker color than the base,
paint a shadow for each highlight. Locks that
are behind other locks will be darker as well

04 More curls!

Once the larger curls are blocked in, select
a highlight color and start adding smaller
curls behind and on top. Depending on how
curly you want your hair to be, you can keep
on going. To make bigger curls “pop”, pick

a color even lighter than the highlights and
add little specular highlights to the top parts.

05 Details and overlays

Use a smaller brush to add extra small
hairs that move through the maze of curls
Work from large to small, so keep these
details until the very end. Make your
colors shine by adding an extra Overlay
layer and go over the highlights with a
big soft brush and your highlight color.
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Shading hair

by Tim Léchner

01

Use the freehand Lasso Tool and make

a selection based on your drawing. Now
use the Paint Bucket Tool and fill the
selection with a color on a new layer. Now
you can use the shape like a stencil/mask
if you turn on the Lock transparent pixels

in the upper area of you Layers panel

02

Use a soft round brush to add the basic
shadows and highlight onto your layer
with the pixel mask. The highlight can
be painted with a simple, horizontal
thick and soft line. The bright rim light
gives the shape a nice outline

03

With a hard round brush you now define
smaller sections using your light and shadow
colors. Use smaller strokes to add smaller
and brighter highlights into the rough
highlight line. Often a beginner's mistake is
to think only about the overall hair texture
Thinking in bigger forms and sections

will help you to create a better result

04

Now you can start thinking about the smaller
details and the texture of the hair. Use a
smaller and sharper brush to paint some hair
texture and detail into the midtones. You can
do the same to highlight areas, but in smaller
areas than the midtones. To add more depth
and realism to the hair, add smaller details
and strands to it. Use a very thin and sharp
brush and draw some bright hair lines here
and there. Do the same with dark lines

To see

05

Use a brush with hard edges and the thls qU'le
Opacity Jitter set an Pen Pressure to tlp used in a
make the hard edges of the hair ends final concept‘
fade out naturally. Also paint some single go to page

hair tips here and there. This breaks

202

up the hard edges, makes the hair look

fluffier, and gives a hint of the structure



Short hair

by Carlos Cabrera

01 Silhouette

Start with a silhouette to paint the bulky hair

tool, draw the silhouette and

use the Bucket tool to fill it with a gray color.

02 Volume and contrast

ect the Lasso Tool to create a hair shape

n. Pick a darker gray and with the
Gradient tool apply from top to bottom

Create another small selection where the

highlights will be and make another Gradient

1 a brighter gray color; remember

to make smaller sel

ns in each step.

03 Add detail to the hair

With a small brush at 2-5 pixels, pick a
larker gray and start to paint the locks of
hair with curved brushstrokes. Start with the

darkest hairs and move o the brighter ones

your hair will look more realistic
Pick a smaller brush at 1-2 pixels and paint

ry lines in the middie section of your hair.

Leave the perfect curved locks for the end

04 Rough up your lines

Realistic hair has a lot of imperfections
with different shapes and lines even
when it is combed. So, deselect any

selection you have, and with the Smudge

tc tart to paint over the edge of the

hair. Set the Smudge tool to 90% and

go crazy on each brushstroke.

05 Color the hair

e our base values in gray,

low we h

rs (Layer > Merge Down)

ayer in Overlay mode. Pick

the base color of the hair and select an

airbrush or soft brush at 40 pixels with a
low opacity of 20%. Gently paint over the

2 the size of the brush when

hair, Chang

painting close to the edge, or make a quick

selection. Now pick a brighter color (always
move on the color wheel) and paint the
highlights on another Overlay layer. To finish,

all the layers and use the Dodge

ease the brightness of the hair
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final concept,
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Straight hair

by Bram "Boco" Sels

01 Laying down the shape

Nhen painting a t
When painting a
mandat thi ner | i
If y nt hair to look Jht i t
have cu tick I tt
idi 1shstroke
alre | JooC f what ]
I look i I t pe
Se S|

02

Adding shadows

\g shad can be

select the Dodge tool; set it to

e a soft brush to gc

05 Stray hairs

Keep on refining t




Painting fringes

by Bram "Boco” Sels

01

Just like with the straight hair (see straight
hair quick tip on page 165) it's important
to get the shape of the hairstyle just right

Fringe hair has a lot of locks that move over

anc

nder each other, but despite that the

al direction

hen painting
the bigger shape make sure you give it

a lot of pointy ends so it looks natural

02 Add

Using a mult

lined brush helps to quickly

generate shadows and highlights where

they're needed. In this case | went with

a general light from the front, whick
results in shadows on the top of the
head and behind the neck, and | used a

strong back light from the right side

03¢

The most difficult part when painting

a fringe is understanding how the hair
wraps around the head and moves over
and under itself. | think that it always
helps to define it for yourself by quickly
drawing some arrows on a separate layer

just to point out how the hair flows

04

Once you know the direction of the locks
think about how they overlap. Wherever
a lock moves over another, the top one
should be highlighted, while the back one
should get some shadow. Just like with

i 0 use the

d

straight hair, itsa g

Dodge tool to go over the bigger shapes

like the forehead and bigger locks

05

ayer on top and put its

05

ng mode to Overlay. Pic oright

color, and with a s arp 1, add

some scratches and tiny hairs all over the

haircut. These specular highlight

it more random

make it all the more convincing

02

04



Youthful skin

by Bram "Boco" Sels

characteristics by t

and around it. It'll be wa

colder to

a separate layer and give it a solid color

similar to the skin fc you're aiming for

03 M

To add a tan y

alternatively

skin darker. Ctri+cl
rin the
op, fill it w

node to

tweak the effect with the C

04 Detailin

lile looking at your reference, really

focus on the skin tones and the light that

affects it. Keep on pushi

05 N

Skin has a lot of texture ir lich can be




Aged skin

by Romana Kendelic

01 Basic shapes

Reference is the key to realistic depiction of
human skin, so you can study the anatomy.
light, and surface texture first-hand. Block

in the very basic shapes. ignoring all of the
details. Squinting at the reference or even
blurring it slightly in Photoshop can help with
understanding the underlying structures

It is important that the anatomy is solid
before you attempt detailed rendering

02 Aging skin

When we age, the skin grows thinner,
paler, and translucent. It becomes dry
more fragile, with enlarged pores. It often
develops pigmented spots (age spots)
The most obvious changes are sagging
skin and wrinkles. Two types of wrinkles
are deep furrows and surface lines. Also
in very elderly people you may notice that
the face is not completely symmetrical

03 Developing

With the basic form done, begin adding
deep furrows on the forehead, prominent
indentation on the side of the nose, and
folding of the skin on the upper lid. Do
not draw out the wrinkles. Try to paint
the convex parts, bring out the volume
of the folds and creases. Treat them like
you would a slightly squashed cylinder.

04 Colors

For the very pale skin, stay away from
black for the shadows. It will dull the
colors, giving the skin a lifeless, grayish
appearance. Observe the wealth of hues:
saturated oranges in shadows, pinks and
magentas where the skin is particularly
thin on the lower lid — even pale blues and

violets to accentuate the transparency

05 Finishing touches

Deepen the furrows using hard-edged
brushes. Add details like spots, pores, and
fine lines. Finally paint in the fine speckled

highlights for a life-like appearance
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Healed scars

by Carlos Cabrera

01 Choose your scar

Over a skin-colored base, make the shape of
the scar. Make a selection (using the Lasso
tool) or paint freehand. | chose a bullet scar,
so | paint a circle in the middle and a cross
cut on it. Pick a darker color than the base
skin tone and paint inside the selection.

02 Texturing the shadows

Pick an even darker color using the Color
Picker. With the Polygonal Lasso tool select
where the shadows will be on the scar; every
stitch and skin healed will give you a lot of
texture information, just simplify the shapes.
With the selection made, select an airbrush
or soft brush with a low opacity of 10% and
paint slowly and smoothly over the selection.

03 Lighting the scar

Select a hard brush at 5 pixels and 50%
opacity. Experiment with the basic brushes
Pick a saturated skin color, in this case a
pale orange, and paint the opposite side
of where the shadows are. Remember

to let some of the base skin color in the
middle to emphasize the shadows

04 Sometimes blur is better

Make a round selection using the Elliptical
Marquee tool that covers the entire scar
and hold Ctrl+Shift+C then Ctri+Shift+V to
make a merged copy. Now go to Filter >
Blur to blend and smooth the scar; repeat
until it's blended together. Lower the opacity
of the layer until the two images blend
perfectly: 50% is a good place to start.

05 Texture the scar
Select a hard brush (a round hard brush is

To see
perfect for this stage) set to 70% opacity and hi icl
pick a brighter skin color, a little lighter than _t 15 qU]_C K
the highlights. Paint with short strokes over up usedina

the scar. Repeat in a new layer then lower final conce pt[
the opacity to 30%. In another new layer at go to page

50% opacity, paint with the bright skin color 200
on the edges of the scar to create a bumpy

look. Use Color Dodge to add the final touch.
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Open wounds

by Alex Negrea

01 Line art

With a default round brush | paint the line
art, keeping it as simple as | can. | keep
in mind the volumes that are going to be
rendered in the next step, so | draw the

wound wrapping around them properly.

02 Blocking in

| block in the areas that need separation later
on in the process. | use a brush with Color
Dynamics turned on to achieve some slight
variation in the hue, value, and saturation of
the skin. To turn on Color Dynamics, open
the Brush engine (shortcut F5) and check the
box next to Color Dynamics. Play with the
sliders to see how they affect the brush that
you are using. | move them just a bit to the
right because | don't want a strong effect

03 Initial details

Keep the inside part of it a dark red. Most
of the work is done outside the wound
You can add some highlights to the edge
of the skin to suggest the thickness of it
Adding some darker and saturated colors
near it will indicate some trauma that the

tissue near the wound is suffering

04 Blood spatter

| use a brush with Wet Edges activated
in the Brush Presets panel to paint some
blood stains near the edge of the wound
| add some more variation to the dark
red inside the wound by color-picking it
and using a brush set on Linear Dodge
(Add) mode. To change Brush mode

on the fly use the shortcut Shift+right-
click while using the Brush tool

05 Highlights and extra details
| add some specular highlights with a

default round brush and a color near to
white. | add some more detail with some
bruising. | paint bruises by setting a brush
to Multiply and picking saturated green
blue, and yellows, and painting in the

same layer as the skin so it blends well
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Tattoos

by Tim Lochner

01

Create a new Photosl

can design your tattoo. Just create the
image, whether it is a tribal pattern or

a colored picture, by drawing it with full
opacity. At this point you don't have to
think about the perspective distortion of
it while being on the arm. Makes sure it's

on a different layer to the background

02

You can place the tattoo into you

document by dragging the lay
into the workspace of your painting. Pl
over the arm and size it to your likir

the Transform tool (Edit > Transform

hold down Shift to keep the proportions)

03

For this task you need the Warp command
Go to Edit > Transform > Warp. Now a
transformation framework is placed over your
tattoo. Pull the anchor points to adapt the
form of it to the roundness of the arm. You
can also click and drag the cells of the grid to

form your tattoo. Hit Enter after you're done

04

Now that you have put your tattoo into
shape you can simply switch its layer
mode to Overlay. Now it adapts the
shading of the arm below and blends into

the painting. You might want to adjust the

brightness since it might have become

a bit too dark depending on the original

value of the tattoo. To resclve that you

down the layer's opacity, which is placed

in the upper area of the Layers panel

05

If you want to extend your tattoo, you

can add another layer with tt

tattoo image on it. Drag and drog

original tattoo drawing

ment and flip it horizontally (Edit

ransform > Flip Horizontal). All that
2-04

v is to repeat step:

To see
this quick
tip usedina

final concept,
go to page
202
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Female ears and earrings

by Tim Lochner

01 Preparations

t you h to think about what

istics an ear has in general

or a young female. An ear has
y! g

very thin skin, so in certain areas you see

more red of the blood shining thro

when light falls on it, which rr s the ear

appear a bit more red. Later in the process

you need to be careful to not over-

the ear so it works together with the soft

and kind appearance of the girl's face

Use a big, soft round brush to roughly add

the main colors and shadow. Remembe

srated and

make the shadows more s

02 Defining shapes

You don’t have to

detail here. Just tighten up some of

e form bit. The ear has a pretty

smooth surface on the inner forms, so

you'll see a few more hi

03 Masking earrings

To have

rer separation from the skin

of the character, it's helpful to create an

extra layer with the earring shapes on so the

different materials t mix up. Just paint the

a| f the earrings on an extra layer
F g Y

swil

the pixel lock in the Layers panel

04 Shading the earrings
Tt

he earrings are obviously made of different

material to the skin, so you need to show

ntrast of this. M

allic mate|

/ reflective surf; so the t

from light to shadow will not be very sm

F

1 darker value right next to the light area

This strong contrast defines the material

To see

05 Additional details 1 ; this qU'iCl(
can add additional details onto the : . tip used in a
nal concept,
[1 ore interesting. | :[rj :tl ‘E]‘VI.[E:—IH color 11. go t0 page

: s S 202

surface of the earrings to make them |

op with the mode set to Overlay, and

the colors with a sharp brush
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Female eyes and makeup

by Bram "Boce” Sels

01 The shape of the eyes

Draw the shape of the eye on a separate
layer to use a guide. Note how the eyelids
wrap around the eyeball and how they fit
neally into the eye socket. This is important
because it will help you to determine

what to shade and what to highlight

02 shading the eyeball

Another important thing to realize when
painting eyes is that you are painting a round
object. Note how the ball shape is rendered
and how it catches a little highlight on the
top. The eye itself will be shaded accordingly

and the eyelid will be draped over it

03 Eyelashes

Women often use makeup to increase the
size of their lashes. To enhance that effect
they also darken them and the eyelids
around them. Use a dark brown to darken
everything around the lids, especially in the
crevices. Nole how lashes become pointy
towards the ends and by exaggerating that

you can make the eyes seem even bigger

04 Makeup magic!

Makeup is easy if you have the shape and
values of the eyes blocked out correctly. Add
a new layer on top, set its blend mode to
Overlay, and use your preferred color to paint
in the makeup where you want. in image 04
you can clearly see what the Overlay layer
looks like without the blend mode on. Don't
go overboard; I've exaggerated it for the sake
of this quick tip, but subtlety is often the key

05 Little specular lights

Because makeup is rather noisy and gritty
it's a good idea to add little specular lights
around the highlights to make the noise

more convincing. Use a textured brush (like
the standard Chalk brush), add a new layer
on top, set its blend mode to Color Dodge

and use a dark gray to dot over the eyelids
and the points where the eyeball meets the

eyelid. Your eyes will feel polished in no time!
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Male eyes

by Carlos Cabrera

01 Notice the difference

Create a new layer and pick a small 10-pixel
brush to make a quick sketch. Paint the
skin color with a bigger brush at 50 pixels
with opacity set to 50% to blend the colors.
Paint the skin color in another layer below
the line art to keep the skin clean

02 Volume plane

The face is divided into planes. On a top
layer in Normal mode, paint the planes of
the face with a big round brush. Paint the
light with a yellow/bright skin color. Avoid
black for the shadows. Use the Lasso tool to
make the projected shadows aver the face

03 Shadow detail

The line art is still visible with the layer on
Multiply, so change the line art color to
dark brown. With Lasso tool, “draw” the
shadows without losing the planes from
step 02. Paint with a round brush at 25
pixels and opacity set to 20% to blend
the skin color on the shadow areas. Work
on the shadows, not the highlights

04 Strong highlights

To add volume to your eye add some
lights without dulling it. Now you have the
color base for the shadows and skin tone,
move to a yellower/brighter color, keeping
it desaturated. Add a stronger highlight
on the forehead, and transparent ones to
the cheekbones, by making a selection of
the highlight areas and using the Gradient
Tool from the top (where you will have the
strong color) to the bottom of the face

05 Smudge it all

Now we have the highlights, the shadows
and some detail we need to smudge all
the areas. With the Smudge Tool blend
the highlights and shadows to create
realistic skin. Select a 6-pixel brush set to
50% opacity and paint the highlights on
the iris. With a smallest brush paint the
hair on the eyebrows with little strokes
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Male ears

by Alex Negrea

01 Establish the proportions

| start with lines to establish the proportions
and the design of the object that | am
drawing. | use a default Photoshop brush. |
think about the volumes that | am about to
render: the ear is made mainly of cylindrical
pieces. The silhouette of the ear could also
be considered to be a half of a heart shape.

02 Start rendering

Once | have finished the line art, | use
selections to define the entire silhouette of
the object that | am rendering. In this case
the shape is simple so | use the Lasso tool
Once | have the selection | fill it with a skin-
toned color and lock the transparent pixels.
| start blocking in the shadows, considering
the volumes that | want to represent.

03 Sub-surface scattering

The ear is a thin layer of folded cartilage
which allows light to enter the surface

and bounce inside it, creating sub-surface
scatlering (SSS). This means that inside your
shadow areas there will be some saturated
light. To achieve this, color-pick the existing
shadow color and, based on that, alter it

so it's a bit lighter and more saturated.

04 Soften the surface

Because the ear is old | intentionally
leave some rough textures from my initial
brushstrokes. | use the Smudge tool to
soften the surface with a default round
brush with some Scattering. You can
experiment with the Hardness option too.

05 Texture details

The older the person, the more textured and
hairy the ear. | use Bevel & Emboss with

a default round brush with Scattering for
the tiny bumps. The effect is too strong at
first so | rasterize the layer style (right-click
an the layer and Rasterize Layer Style).

| then apply a Gaussian Blur filter on that
layer so the effect is smoother. | also add
some white hairs coming out of the ear.

02

04
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Delicate nose

by Bram "Boco" Sels

01 The shape of the nose

As with all facial features, you should plan
ahead and lay down a sketch of what you're
painting. Look for reference and using only
a few lines, try to construct how the nose fits
on the face. Keep your lines on a separate
layer so you can still turn them off later.

02 Construction

When painting a complex shape it's often
better to start out by dividing it into flat blocks
and planes. Study how the bridge of the nose
moves inward around the brow and jumps
forward at the tip. This is especially true for
young noses and is a big part of what makes
kids and teens look sweet and innocent.

03 Blending the planes together
Once you've constructed the planes of the
nose it's an easy task to blend them together
and smooth them out. You can do this by
either using a big soft brush to go over each
corner or by selecting the Smudge Tool to
push the pixels into each other. Don't worry
about the noise and freckles you're losing,
you can add them quickly again later.

04 Lines versus edges

Now it's time to turn off the line drawing and
focus on the edges. The difference is that
lines don't actually occur in nature, so you
have to find a way to paint the transition
between light and dark without using a

hard line. Note that wherever a crevice
occurs (such as beneath the nostrils), the
shadows are darker and the edges sharper.

05 Detailing

Keep on working on those edges, but
don't forget the large shapes. The tip of
a small, young nose is often round and
should be shaded accordingly. Look at

how part of that round tip catches light
while the other side is much darker. You
can also reconstruct the freckles around
the bridge of the nose and paint in that
small, fun highlight on the tip of the nose.
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Thin lips

by Romana Kendelic

01 Blo

| start by blocking i

Stay

2d and loose he

ing the right form and expression. Ensure

clude the surrounding areas — chin

cheeks, philtrum (that litt oression above

both sides of it

p she

i color of

ving in mind the ¢ on

shing darks and lights

lip is often darker

om light. Skin of the

naturally

thinner than the skin o the face

at gives |

eddish t | use a d.

rated, and slightly orang

03 Smooth forms
D

2lop the form

volume. The upper it

central rounded [ zrance and two

forms. The lower lip, often fuller, consists of

two. There should be no edges, with forms

flowing smoothly. You want them to feel fleshy

and

Lips don't have an outline. Lipstick

2 that but a vermilion border in

ansition, not a shary

ral lips is a mild t

line. There is often a highlight just abo

er because lips curve slightly outward

04 Sharpe

Use a hard round br

> shape

up

with opacity set to

Pen Pressure to tig

jark tones in the of

e corners of

first highlights. P attention to

mouth, where some muscles attach

overlap. This is where ¢ n expressior

are

well as the

visibl

Vary the hues ¢

lors for a more realistic effect

05D

Paint in fine

tails

h

8 lips texture

a very pale pink add tiny speckled highlights

he surface. Don't overdo this unless

you want the lips to look chapped and dry
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Voluptuous pout

by Tim Lochner

01 The

Before | put color and rendering into the lips
it's important to have a simplified drawing,
which describes the design of the mouth and
gives it its proportions and shape. You don't
have to outline every detail, just the most
important parts: the opening line of the mouth
and some indications for the upper and lower
lip. Don't draw the opening line too strong;
it's only important to add the middle contact
point of the lips and the mouth corners

02

Use a large, normal round brush with 0%

Hardness to fill in the basic light and shadow
colors. Don't worry if you go over the lines

— it looks more natural if the lips aren't
completely separated from the skin around
the mouth. Reduce the opacity of the line
art layer beforehand. | usually base my lip
colors on the character’s skin tone and add
more saturation and red to it. A strong red
too far from the skin tone, will look unnatural

03 Detaili

I mainly use a brush with hard edges and
the Opacity Jitter set on Pen Pressure
Use it to add details like very subtle folds
in the shadows and small light strokes
for the highlights on the lit side

04 Harc

The separation of the upper and the lower

lip is important. Use the freehand Lasso

tool and select the upper edge of the mouth
opening. Add a darker value with a small
round brush with 0% Hardness. To increase
this effect you can invert your Lasso selection
and add a lighter value to the lower lip so the

dark edge of the upper lip touches the part TO Se.e

of the lower lip, which is a little bit brighter. th]s qU]C
tip used in a

05 Removing lir nal concept,

To give it a more painted and realistic

go to page
202

look, | erased the lines of the drawing. |
suggest adding a layer mask, which you
can find at the bottom of the Layers panel




Male nose

by Alex Negrea

01 Rough line drawing

Here | start a rough line block-in. It's rougher
because from this angle the only things that
overlap enough to see form transition are
the nostrils and the skin of the cheeks, which
doesn't allow us lo see all the nose parts.

So | add some lines even though | don't see
them (for example the bridge of the nose).

02 Lay down the first colors

To get some nice skin tones | activate the
Color Dynamics on the brush that | am
using. This creates variety in the values
of the initial coler you are using. | also
paint the shadows inside the folds, even
though they overlap with the line art at this
point. This allows me to have that shadow
already in, and not worry about it later.

03 Render the forms

The shapes of the nose are made of
spherical and cylindrical volumes. Roughly
knowing those shapes in your head

will make it easy for you when it comes

to rendering. To make the shadows
deeper | use a brush set to Multiply.

04 Add in texture

Because my shadows were already too dark
and because | am painting skin, | have to
think about sub-surface scattering. | lighten
them using a brush set to Lighten and with
a color that is more saturated and lighter

in value than the shadow. To add texture |
use a default round brush with Scattering
turned on to create all those tiny speckles
without spending too much time on them.

05 Final details

To make the skin older | continue to
add more speckles and imperfections
to it. Because this is an old person’s
nose, | add some white hairs inside the
nose to further push this feeling.

Quick tips
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Mouth and teeth

by Alex Negrea

01 Line art

| start with line art to help me pre-visualize
the subject that | am about to render. Having
the teeth drawn out before the rendering is
a huge help. The teeth marked with blue are
flatter than the rest. That means that when |
render them | will treat them like a box and
not as a cylinder (like the rest of the teeth)

02 Block in the colors

I use the lines to do a clean selection using
the Lasso tool so that later on when | need
to paint on them, | don't worry about their
edges. Once | make the selection | create
a new layer and fill it with the foreground
color and lock the transparent pixels.

03 Render out the values

| use a soft round brush to paint everything in
this stage. | set it on Multiply for the interior of
the mouth so | can paint some darker values
| keep the colors saturated and close to
reddish and orange-ish colors. | pay attention
to the volumes | want to render. The lips are
like cylinders that wrap around the mouth
and the tongue is like a stretched sphere.

04 Paint the teeth

Even though teeth are solid they allow
small amounts of light to pass through
them. That means a sub-surface scattering
effect is going to be visible. Meaning that
parts of the transition edge of the shadows
will be more saturated and lighter in

value than the shadow. | try to remember
this so | don't destroy that saturation

05 Specular light and depth

| leave the specular lights for the last part
of the drawing. They add the glossy feel
of the teeth and the other wet surfaces
like the tongue or the lips. Note how |
keep the interior side of the mouth edges
very soft to push the idea that it's a soft
material and not hard like the teeth. It
also adds depth, making the teeth appear
more forward than the rest of the mouth
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Fur

by Romana Kendelic

01 Types of fur

There are many different types of fur, not
just in color or length but the texture, too,
There is bristly, woolly, soft and plushy,

silky, tangled, and so on. Also lots of
animals have layered fur: a softer undercoat
(downy hair) and a coarser top layer (guard
hair). This top layer is usually strongly
pigmented including a whole range of
patterns (for example as seen on big cats)

02 Basic shapes

| block out shapes with a soft brush. Start
with the placement of light and shadow. Paint
in the basic color and tone, and pattern if
any. Fur of some lengths naturally clumps
together and this is what you should paint
thick sections that overlap and separate. Use
loose brushstrokes and leave all detailing for
later. Keep in mind that fur has depth and
weight. Paint in the direction of the growth

03 Clumps of fur

Define the edges of the clumps of fur. Check
a reference to see how they move - is it soft
fur with gentle curves, or coarse and bristly
which would benefit from sharper, straighter
lines? Instead of rendering every individual
hair you are trying to give an illusion of detail

04 Details

Refine the fur. Start by adding more
defined highlights and shadows. Do not
lose the clumps; just add more definition
to them. There may be cast shadows

to darken, or overlaps to highlight. If

the fur is not the focal point of your
painting you can safely stop here

05 Guard hair

Finally add the guard hairs. Usually they are
coarser single hairs protruding through the
coat. Use a hard-edged brush on a separate
layer. Sharpen filters may help separate

the soft undercoat from the firmer top layer
(Filter > Sharpen). If the fur is glossy, now
would be the right time to add highlights

To see
this quick
tipusedina

final concept,
go to page
204
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Lace

by Bram "Boco” Sels

01 Dressing up

When painting translucent materials such as
lace, the background they're draped over is
what makes them convincing, as it shows
off the transparent parts. In this quick tip

we start with a pair of legs which we'll soon
dress up with a fantastic-looking lace skirt

02 The base of the skirt

Start out by painting a convincing base
without worrying about the details. In this
case | went for an opaque white skirt; you
can change the base color to whatever
color you want. Keep in mind that the
shape of the skirt should wrap around

the legs as convincingly as possible.

03 Opacity

Next, duplicate the layer then hide the back
layer and select the top layer. At the bottom
of the Layers palette click Add Layer Mask
and press Ctri+l to invert the layer mask
Notice the skirt disappears - this is because
your layer mask is now empty (black). If you
now select the layer mask (click the black
rectangle next to the layer's thumbnail) and
paint in that mask with a white brush, your
layer will show through wherever you paint.
Finally, unhide the second skirt layer and set
its opacity to 50% to get a see-through skirt.

04 Painting in the lace pattern
Select the upper skirt layer (which is still
invisible due to the black mask), click
on the layer mask (the black rectangle),
change your foreground color to white
and you can now use a regular brush

to paint in the lace pattern. Everywhere
you paint in the layer mask, the opaque
top skirt will appear in your canvas.

05 An extra detail layer

Finally, create an extra layer on top of the
others and paint in the rest of the details.
Don't do this in the masked layer, as lace
patterns tend to be bumpy and uneven, while
the masked layer is clean and straight
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Leather

by Bram "Boco” Sels

01

Fill your background layer with your chosen
local color and use a big brush to create a

general direction for the light. | used brown
with a top light, so lighter browns will be

in the middle, while the outside is dark

02

Add a new layer, fill it with white and, with

a dark brown foreground color, go to Filter
> Filter Gallery > Texture > Stained Glass

By changing the Cell Size you'll get a larger

or smaller texture. Now use Filter > Fi
Gallery > Brush Strokes > Spatter. Select

Accented Edges to get rid of the stiff edges

03 Be
With the white texture layer still showing,
click on Channels in the Layers palette
Ctrl+click on the blue channel. This selects
everything white (the leather cells), so go
back to the Layers tab, click on the t

background layer and do Ctrl+C and Ctri+V
to copy/paste the cells from the background
Hide the top white layer and double-click

on the new layer. You'll see the Layer

Style window — click on Bevel & Emboss
This will make all the leather cells pop u

with a nice highlight anc

shadow color

04 M
Unhide the white leather pattern and set
its blending mode to Multiply to accent the

crevices of the leather. The pattern is rather

horizontal, so select both your Multiply layer
and the Bevel & Emboss layer and rotate
them a bit. You may have to resize them

to fill the empty space from the rotation

To make your texture more convincing add

some scratches and dirt. Create a ney

ayer

on top and use some rugged brushes to
paint over the layers below. Add some broad
strokes of dirt with big soft brushes, and

ome rougher scratches with smaller, sharper

brushes, to achieve a less digital look




Silk

by Bram "Boco" Sels

01 Local color, light color

Silk is fairly reflective, so lighting

are important. Choose the color of the silk

(local color), and the color of the lig

the environment (light color). In this ¢

the silk is red and the ligl

the highlights of the sil urplish

pink (red mixed with

). The shadows

will turn out to be a warm kind of brown

02 Shadows and folds

To make your silk shine it has to feel or

and folded. Start with the shz s, and

use just one color to paint the shapes

Every shadow you paint will be

e a logi

than the rest. so try to creat

transition between the red shapes
03 Highlights
Once you've painted the shadows, do

the same for the highlights. Think about

h one another

highlights will form lines t
each other. For each shadow painted in

the previous step, paint a highlight near it

04 Blending and smoothing

Once your basic cc

ors are laid down, it's

time start blendi

hem. Shadows will

be darkest w furthest

from the camera and wi dually flow

over into the midto

the same goes

for the highlights. The sharper a fold, the

sharper the highlight on it, so in pla

05 Texture

Although silk feels smooth, it still has a

ittle texture and noise

t. A quick

to get this texture is to p Ciri+Ato

select all, and Ctri+Shift+C to copy, then

Ctri+V to paste a merged version of your

pe ) Filter > Filter Gallery

nting. N

> Chalk & Charc

hit Ctrl+3

shift+U te

and set its blending moc
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Jewelry

by Romana Kendelic

01 Sketch

Start with the sketch. It does not have to
be particularly detailed; an accurate outline
with basic placement of cast shadows wil

be fine. Try to find a pleasing composition

02 Blocking in

Set your sketch layer to Multiply. Create
another layer below and start blocking
in the basic colors in a midtone range

Note the light source and how the v

changes across the forms. There
light sources, one on each side — a closer
one and one further away. Establish the
midtones, core shadows, and light areas
on the spherical gems. On the cubes find
the sides that are light and ones that are
dark. Learning to paint basic shapes is
an essential part of creating a successful

illusion of 3D objects on a 2D canvas

03 Developing the forms

Lower the opacity on the sketch layer and
start developing the forms; pay attention to
how different materials act. The elliptical gem
on the ring is semitransparent — see how the
light enters the gem from the right and above
then pools on the opposite end. The light
that shines through takes the color of the
gem. The spherical gems are opaque; they
do not transmit the light. The core shadow

is colored due to the reddish surface

04 Metal

Turn off the line layer (click on the eye
symbol next to it) and concentrate on the
metallic parts (ring and wires in the earrings)
See how hues shift from slightly greenish to a
range of ochers to yellow highlights. Darken

the shadows; contrast is the key here

05 Highlights

It's all about well-placed reflections and
highlights. The harder and smoother the
surface, the more reflective it is. Pick the
ightest color, almost white, and with a

hard-

ed brush pinpoint your highlights.

Multiply + Opacity: 100%

Lock: [ v b @ Fill: 1009

-

To see
this quick
tip used in a
final concept,
go to page
204
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Weapons

by Carlos Cabrera

01 Don't lose the shape and line
Draw everything in one layer (line art layer)
Create another layer below this. Make a
quick selection with the Lasso tool, fill with
the Paint Bucket tool, and using the same
selection apply a gradient to create light
and shadow. Change the layer mode to
Multiply to see the line over our base layer.

02 Simplify with boxes

When painting the light and dark areas
simplify the shape. You can do this in another
layer. The strongest lights are followed by a
darker shade lo give a flat and deep feeling
to the shape. Use the Polygonal Lasso
selection tool to creale the faces and the
Paint Bucket tool to fill them with gray colors

03 Add detail to the object

Using the Brush tool and a brighter color
than the base, paint the weapon with an
almost white color to achieve a metallic
feeling; note where metal reflects light. Paint
soft shadows on the holster to emulate

the fabric. Use the Dodge tool to add

the highlights and create softer lights

04 Colors

Add a new layer in Color blending mode
and paint with a desaturated blue. Pick
a green and paint only the shadow side
of the weapon and holster. In a new
layer set to Normal mode, paint where
the highlights will be with a round brush
at 20 pixels. Smooth out the light and
shadows on the gun to make it realistic

05 More detail and realism

Add contrast to color to create better
volume. Soften the fabric with the Smudge
tool to create a realistic texture. With a
10-pixel round brush, paint highlights on
the metal and blend the reflections. Add
saturation to the shadow area with a layer
set to Overlay. Add small details, like
seams and creases with a small 2-5-pixel
round brush set to 100% opacity.
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200




Glasses

by Bram "Boco" Sels

01 Designing rla

The selling power of your image comes from
the design of the glasses. In this case | went
for an old model that sits on the nose, and |
started out by creating two separate layers
for it: one with a dark color for the frames

and one with a gray color for the glass

02 Deciding on the col
Once you have both layers you can decide
what material your glasses will be made of
The glass itself is easy to do, just put t

layer’s opacity to 20% (or more if you want
thicker glass), and that's it. The frames are a
bit more difficult, but to begin we'll decide on
the color we want. | give them a gold/brass
kind of color by pressing Ctri+U and fiddling

around with the sliders until | am satisfied

03 Bevel & Emboss

Far shapes that are thin and small like this
one, Bevel & Emboss can get you started
really quickly. Double-click on your frames
layer in the Layers palette, choose Bevel

& Emboss in the pop-up, and change the
colors of the highlights and shadows from
white and black to browner colors. Hit OK
and right-click on the layer to Rasterize Layer
Style. This merges the effect into the layer

04 H

Bevel & Embass can only get you so far,

though. It's a digital effect and therefore
looks like one, so it helps to go back in and
manually paint over the effect. Also think
about where the light is coming from (in my
case from the top-left) and accent the frames
with some bright highlights in that direction

t shadow

05 C:
To make your glasses even more convincing
paint in the cast shadow it leaves on

the face. It helps to ground the glasses

on the nose and makes it all the more
convincing. Finally you can also add some
little scratches and bumps to the model

to make it a little more worn and used
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Breakdown gallery

Find inspiration for your own creations
with a gallery of diverse characters.

In this section you will discover a stunning gallery by a
selection of talented artists, which will also uncover the
visual progression of each image as they reveal the steps
behind their process. This will enable you to understand how
different elements covered in this book can be combined and
built upon to produce a top-quality character painting




Subterranean man

by Chase Toole







Alchemist

by Andrei Pervukhin
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Femme fatale

by Pyeongjun Park
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Warrior elf

by YongSub Noh







Bio-mechanoid

by Gerhard Mozsi
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Tattooed girl
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Moonshine villain

by Charlie Bowater

01 02

03 04
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The socialite

by Devon Cady-Lee
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Glossary

Adjustments layer palette

Above the Layers palette (if it's missing

go to Window > Adjustments) you'll find

the Adjustments layer palette. Each of

the buttons here quickly creates a new
adjustment layer on top of the layer you have
selected. What an adjusiment layer does

is change the way all the layers below it

look. You have adjustment layers to change

Background

The Background layer is the bottom layer of

the layer stack. It's partially locked because

you can't put anything below it and it can't be
directly edited either. It is always at the very

Blur

Blurring is a technigue that's mostly used to
reduce details and noise in an image or layer.
In Photoshap there are typically two ways a
blur can be applied: the first, via Filter > Blur
(Gaussian Blur being the most notable here)
the second via the Blur tool, found in the tool

Bounding box

The bounding box is an invisible box that
holds the content of a layer. You can easily
turn it visible by clicking on the Select tool
and checking the Show Transform Controls
box. Now your layer will be surrounded by
its bounding box. The Transform Controls
on the side of the box can be used to
quickly rotate and resize the bounding box,
simultaneously rotating and resizing what's
in it as well (see Rotate and Scale)
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brightness, contrast, levels, hues, colors,

Add an adjustment
0w 55 P Y
M O E
dE =X E

and so on. The benefit of using these layers
is thal you quickly tweak your image without
actually changing the information in the
layers below. In other words, you can always
go back and change or delete the adjustment
layer later if you're not happy with the results

bottom of the image and fills up the entire
canvas (see Canvas). It functions as the
foundation on which you build your image

every new layer will be “built” on top of it

bar under Smudge. While the first applies an
equal blur to the entire layer, the latter can ianaliect
be used as a brush in different places. Note
that once you apply a blur it's irreversible

so it's a good idea to always keep a backup

layer before you start blurring away.

& Show Transhorm Controls




Brush tool

B
The Brush tool can be used to paint lines S — S - =
shapes, and textures in any color. It's o = - R
important to set your brushes up in a way Bf Shopa Dyt :
Scatterng w

you're comfortable with. Something that can Teture ;

A ¥ Duai Brush ~
help you tweak the brushes to your liking P ;
is Shape Dynamics. Shape Dynamics can o Tearater -

Brush Pme

(-2 ]

help you mimic real-life brushes by altering
the brush settings (see image). Putting the
control of the Size Jitter to Pen Pressure
mimics the effect of a real paintbrush. When
you press hard on your stylus a lot of “paint
will appear on the paper and when you
press lightly only a little will appear. This
option is great when doing line art, but also
when filling larger areas and you want your

work to have a traditional textured look

Burn/Dodge tools
The Burn/Dodge tools are basically brushes,
but instead of laying down paint they darken

or lighten the paint that's already there. This
is really helpful when you want to darken
or lighten a specific area rather than the

entire image. Two important settings to keep
in mind here are Range and Exposure.
Range let's you pick what it is you want to
darken or lighten and Exposure how hard
you want to change it. Say for instance

that the darkest tones of the shadows in

your painting are too bright: select the Burn
tool, set its range to Shadows and quickly

o
H
&
-
-
’\

brush over the shadows you want to boost
It'll quickly darken it up while leaving the
mid-toned and highlight parts of it intact.

Canvas

The Canvas, much like a traditional painting
canvas, is the surface you work on. The
Canvas has nothing to do with the resolution
of the image (see Resolution), but is merely
a guide to show you where your painting
begins and where it ends. Unlike a real
canvas, you can easily increase your canvas
size while working via Image > Canvas Size
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Clone Stamp tool

A great way to duplicate patterns, textures,
or brushstrokes is with the Clone Stamp tool
If you hold Alt with the Clone Stamp tool
selected you'll notice the cursor changes

o a cross. If you now click anywhere

on your image that spot will become the
starting point for the duplication. Release
Alt and now you can “paint” with the part
you've just selected. Anather useful trick

is to change the sample in the top bar to
Current Layer, which will keep your clone
restricted to what's in that layer. It's a cool

trick to duplicate silhouettes and edges.

Color adjustment layers

These three adjustment layers are Hue/
Saturation, Color Balance, and Selective
Color. They are mainly used to change

the color of the underlying layers

Hue/Saturation gives you the option lo slide
the

tire color scale of the layer at once

and also lets you saturate and d

saturate it

Color Balance is a bit different, since instead

hanging the entire color scale at once,
it lets you hone in on a specific range and
change just that range. Say for instance
that you feel your shadows are too cold
select Shadows as your tone and move
the Yellow—Blue slider towards yellow and
the Cyan—Red slider towards red. In no

time your shadows will feel a lot warmer.

Color mode

Simply put, the Color mode is the method

in which the pixels in your image are
organized. Standard printers only have four
different inks: cyan, magenta, yellow, and
black (CMYK) and they create different
colors by combining those four inks. So in
Photoshop you can organize your image

in a way that a printer knows how much

of which ink it needs to recreate a color

similar to what you see on your screen

That's where the Color mode comes in

A good rule of thumb is when your image
will be used on screens use RGB and

when it will be printed use CMYK
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View  Window

Finally, Selective Color goes even further
and lets you pick a specific color and

change just that color. Feel your Greens
aren't lush enough? Just select Green

under colors and tweak it from there

Image Layer Type Select Filter
Adjustments L4
Auto Tone Shift+Ctrl+L
Auto Contrast +Shift+ Ctrl+ L
Image Size Alts Ctrl+]
Canvas Size... Alt+Ctri+C
Image Rotation L
Trim...

Reveal All
Duplicate...

Apply Image...

Calculations...

Help

A Fow

wos [ of

Current & Baiow
Al Layers

3D View Window Hel

Grayscale

RGB Color

v CMYK Color
Lab Color
Multichannel

v 8§ Bits/Channel
16 Bits/Channel




Contrast

30 View Window

Image Lajer Type Select Filter

Brightness/Contrast:

sasing, . DeeTReR 0

In Photoshop, Contrast stands for the

difference between light and dark. Inci

P Levels.
srair <o oo u i Aute Tone Shift= CtrleL
contrast means the dark parts of your image N Gancel e i S ik
ntrast: p
become even darker and light parts even b 0 Auto Calar ShiftsCtrl-B
YT s Vibrance

lighter. Lowering the contrast will do the '\”:i”; o= Hue/Saturation...
opposite and will result in a neutral, more Use Legacy m Lot Dutanc
pp W sult eut 0 Imag Black & White. Alte
grayed-out image. You can increase the Tiim Photo Filter

. Channel Mixer
contrast of a layer via Image > Adjustments it Coler Lookup.

Duplicate.
i
to make your values more readable Calculations

> Brightness/Contrast. It's a great way

Apph

Crop
Cropping an image is a way to resize

utting off parts

Crop the image?

canvas (see Canvas) by

of it. In short you select the part of your —

E Don't Crop
i _c J

outside of that selection will be deleted. So

image you want to keep and everyt

in contrast to Resize Canvas, it also d

les

all the information outside the borders of

canvas, clearing up unused parts of

and as a result decreasing the file size

There's a quick and simple selection to

you can use to crop an image, which

be found in the toolbar or by pressing C

Filter

Filters are mostly used to add specific artistic
effects to images, like making a layer look
hand-painted, appear in an impressionistic
style, or look as though it was drawn with

charcoal. Some of these filters can be used

as smart filters, leaving the layers to which
they are applied intact, but most of them

will irreversibly change the layer, so use

them with caution and keep a backup

Flatten . s

Kind
Flatten simply means all your layers

are combined and merged into the e ETET Normal
background layer (see Background).

Neediess to say, it's something you only

a T ;
are absolutely sure L

want to do if yo

rs anymore 3 - Background

u don't need your la
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Gaussian Blur

Gaussian Blur (Filter > Blur > Gaussian
Blur) is an easy-to-use filter that blurs your
selected layer. I's a great tool to virtually
create depth of field. Remember, blurring

a layer is irreversible so use it carefully;
Gaussian Blur is a filter, which means it's

a digital calculation and will therefore look
digital - if you want a realistic/traditional feel
it's best to create the effect without a filter. It's
a useful tool in a production pipeline where
things need to go quickly and efficiently.

Gradient tool

The Gradient tool, much like the Paint
Bucket tool (which will fill an area around
the pixel you clicked with your selected
color), either fills the entire layer or just
the part you've got selected, and creates a
gradual blend between two or more colors
The standard gradient consists of the two
colors you've selected as foreground and
background colors, so you can quickly
create new gradients by using the Color

Grayscale

Grayscale is a Color mode (see Color
mode) that turns your entire image to black
and white, deleting all color information but
making your file size much smaller. What's

Highlights/shadows

Each image can be turned to black and white
and seen as a combination of different values
(see Grayscale). It is in these values that we
find the highlights and shadows. Everything
that's dark can be considered shadow, and
everything light a highlight (in between are
midtones). In Photoshop these terms are
used to let you know where the effects are
applied — if you use Color Balance, you can
change the tone to shadows and only apply
the effect to the darker parts of the image
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Presets

Name:  Foreground to Hew

Gradent Type: Sok =

Picker. Alternatively you can also click on
the gradient in the options bar on top to

important to know about Grayscale is that

the Histogram is based on it, and it's a scale
that consists of 256 different values, ranging
from black (being value 0) and white (being

Shadows [
Amount: T %
Tonal Width: 50 %
Radius: 30 px
v
Highlights
Amount: 0 %
Tonal Width: 50 %

Grdant Type: Sokd  ~

Smonthness:

Stops

open the Gradient Editor and to manually
modify it to blend more or different colors

value 256). Every type of gray can be found
between those two values. The same scale
is used by other Color modes too, but there
each value also has a color applied to it

Radius: 30 px
Adjustments

Color Correction: +20
Midtone Contrast: 0
Black Clp: 0.01 %
Wwhite Clip: 0.01 %
Save As Defaults

! Show More Options



Histogram

The Histogram gives you an overview of the
values in your image. You can find it under
Window > Histogram. It's an especially useful
tool to keep your values in check. From left
to right it shows how your values are divided.
On the left are the dark values, on the right
are the light. In the extended view you can
also see the values for each separate color
channel. When using the Histogram there
are a few things to consider. Is the flow of
the graph more or less fluent? If there are
big spikes, there's probably a value that's

too prominent and should be broken up into
a few more subtle values. Another thing to
keep in mind is that your values should stay

Keyboard Shortcuts (Actions)
Keyboard Shortcuts work in the same way
as Actions (see pages 18-19 in the first
chapter of this book). Using Keyboard
Shortcuts efficiently can save you a lot

of time. When you get comfortable with a
working method you'll notice that you often
repeal the same steps over and over and
in that case it pays to have a shortcut for
it. Click on Edit > Keyboard Shortcuts and
here you can change the way you access
most of the tools found in Photoshop

Lasso tool

Getting sharp edges becomes easy when
you use the Lasso tool. Simply select part

of your image using the tool, create a new
layer, fill it with a color and click on Lock
Transparent Pixels (see Layers palette) and
you'll have a sharp silhouette, which you can
fill with whatever you want. There are two
important Lassos: the basic Lasso, and the
Polygonal Lasso, which does the same but
with straight lines. You can quickly alternate
between the two by pressing All. It takes a
bit of practice, but it absolutely pays off!

away from the absolute left and absolute
right — those values are pure black and

pure white and they have the tendency

to create flat and dull looking images

- UK
Vaysoad Sharteats Ve

Cancel

Set: Phatoshop Def

Shortcuts For:  Appicaton Menus = | Use Legacy Channel Shortcuts
Application Menu Command Shertcut
b Fle
- Edit
Undo/Redo ez
Step Forward Shift+Crl+2
Step Backward at+Cr+2
Fade Shift+Qur+F
Cut Cirl+X Summarze...
F2
Copv e C

+ | Toedit keyboard shortcuts:

1) 1)click on the New Set button to create a copy of the selected set, or select a setto mody
2) Click in the “Shortcut” column for a command and press the keyboard shortcut to assign

3) Save the set when you are done editing to save all your changes.

215



Layers palette

The Layers palette is your friend! It's one of
the most important features Photoshop has
to offer so try to make good use of it. The
basics are simple: think of layers as stacks of
paper, if you cut a hole in the top paper the
paper below becomes visible. The Layers
palette is a visual representation of that stack

of paper. One of the most important buttons

Liquify

The Liquify filter allows you to push, pull
and deform your selected areas as if they
were wet paint. You can find this option in
Filter > Liquify where a separate preview
window will appear, so you can view the

effects before you make them permanent

here is the Lock Transparent Pixels button

at the top. You can quickly toggle it to lock
everything in the layer you haven't painted
on and if you paint on the layer now it will
only change the parts that have pixels in
them. Other useful buttons are at the bottom.
Drag and drop layers on them to respectively
create a folder, duplicate, or delete them

Liquify (Untitled-6 @ 1

L ox
Cance
Load Last Mesh
Advanced Mode
Toel Optons
BrushSire: 100 |+

Beush Pressre: 100 v

Resonetrct Optons

Restore Al

Occlusion shadow

The darkest parts of the shadow are usually
at points of contact, where secondary
sources can't reach. These are called
she

where the main shadow meets the cast

ocelu: ws. Occlusion occurs

shadow and it is usually very dark

Opacity
Each layer (see Layers palette) in your layer
stack can differ in opacity. Basically, opacity

(which is expressed in 9

your layer is. A layer with 100% opacity is a

solid layer you can't see through, so every

pixel in that layer will completely hide the pixels

below it. Turn it to 50°

50% of itself as well as © of what's below.
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Patterns

When you double-click on a layer in the
Layers palette, the Layer Style window will
open. In it you'll find the Pattern Overlay
option, which is used to fill the entire

layer with a pattern. You can use these
patterns to give your image a texture by
changing the Blend Mode of the pattern

to Overlay, Soft Light, or Multiply

Creating your own patterns is also easy
Simply open up an image from which you'd
like to create a pattern and click on Edit >
Define Pattern. You'll now find your new
pattern in the Layer Style window. Tile-
able images work best for this since they'll
seamlessly flow over into each other. On
sites such as http:// freetextures.3dtotal.
com and www.cgtextures.com you can
download tons of tile-able patterns for free.

Resize

Resizing your image means you either
decrease or increase it in size. Which of the
two you do is important though, because in
the case of the first you'll ask Photoshop to
use the pixels you have to make the image

Resolution
For a lot of people the resolution is a

complicated concept because they often

confuse it with the resolution of their screen.

But think about it like this: an image of
10 x 10 pixels in Photoshop (that's not
zoomed in or out) will exactly use 10 x 10

Rotate

Rotate is used to literally rotate the layer
you've got selected. By turning on the
Transform Controls (see Bounding
box) and hovering your cursor over

the corner of a layer, you will see

that it changes into a bent arrow.

- Pattem Overlay
Styles Pattarn
Bianding Options: Default

Bevel 5 Emboss =
Opacty

Blend Mode: Worma

oK
Cancel

New Style...

Contour

Texture

7 Pre

D [ Seants orgn

Make Gefaut

Drop Shadow

smaller, which is usually not a problem, but
in the case of the latter you'll ask it to space
out the pixels you have and “invent” the open
spots that'll turn up between them. Increasing
the image size is usually not a good idea,

pixels of your screen, regardless of how
high the resolution of the file is. Why are
there different options there then? Other
hardware, such as a printer, does not know
what pixels are. So in your file you can
include information as to how it should deal

With it you can turn a layer 360 degrees
around to whatever position you want. This
is useful when you've got different objects
on different layers and you feel some of
the objects lack dynamism or don't feel
like they fit right in the compaosition

o/ Link with Layer

Resat to Defat

because you'll end up with a blurry image
as the pixels become more spread oul. It's
always better to start out big and resize
your image later, than to do the reverse.

with those pixels. "ppi” stands for pixels per
inch, and simply tells your printer how many
pixels it should print on 1 inch of paper

The rule of thumb here is that images for
print should have a resolution of 300 ppi
Images for web have enough with 72 ppi.
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Scale

Scale is another word to describe the
size a layer has in your image. In other
words, how big it is compared lo the other

Selection

A selection in Photoshop is immediately
recognizable by the “marching ants’
surrounding it (moving dashed lines).

It's an important feature in Photoshop
because what you've got selected is the
only part of the image or layer that will be

Sharpen

Sharpen is a filter that locates the edges in
your image and then increases the contrast
(see Contrast) around them, making them
appear more defined and crisp. The most
regularly used Sharpen is the Unsharp
Mask, which you can find under Filter >
Sharpen > Unsharp Mask, but you can also
use the Sharpen tool the same way you'd

Smudge tool

The Smudge tool does exactly what the little
icon shows; it pushes your paint around.

It's like putting your finger in wet paint

and smearing it around. It might sound a

bit messy, but it's a useful tool for several
reasons. First and most important, it helps
you to be able to generate different types

Swatches

I's a good idea to keep a collection of
swatches. Sites like http:/icolor.adobe.
com can help you find and save the
perfect colors for your work (there's also a
separate palette for that site built directly into
Photoshop under Window > Extensions >
Kuler). If you have a color selected, simply
open up the Color Picker (by clicking on
the color in the Tools palette) and click

on Add to Swatches. You'll now find your
new color in your Swatches palette. Look
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layers. You can quickly change the scale
of a layer by turning on the Transform

Controls (see Bounding box) and dragging

affected when you work in it. Selections
can be tweaked and modified by right
clicking in them and clicking Refine Edge
By doing this you can see exactly what
you've got selected and change how soft
or smooth the edges of that selection are

use the Blur tool (see Blur). You might be
tempted to think of it as a way to reverse
blurring, but nothing is more wrong. Blurring
is a way lo reduce details and noise, but
Sharpen can never reinvent all that lost
detail, instead it will result in an image
that's blurred, but with very high contrast

of edges - instead of having only straight,
sharp edges, some of your edges could

be blurry and blend with the background
Second, when you are painting materials
that have a smooth surface, it helps you to
blur the surface without losing that painterly
feeling which you may be locking to achieve

for color palettes consisting of five colors
that fit well together and then add a black
Swatch to separate it from the next five
You'll then have quick and easy access

to a few super solid color combinations.

the control points that pop up. Quick tip
holding Shift while dragging on the corners
keeps the proportions of the layer intact.
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Value adjustment layers

The first three adjustment layer options
are your go-to layers to change the values
of your image. Brightness/Contrast is by
far the simplest, and provides you with
just two sliders that you can use to adjust
the tonal range of the image. The Levels
panel shows a histogram for the image
On the left you see the dark values and on
the right the light values. With the sliders
you can easily change a specific part of
the values without touching the values
you're happy with. The Curves panel is the
most complicated, but it does the same as
Levels (it's more expansive if you want to
micromanage your values). It shows you

the same histogram, but instead of using

sliders it uses a curve to alter the values

Vignettes

Vignettes have been used in the photography  to the middie of the image, towards what set its blend mode to Multiply and go to

and film industry for decades. It's a technique  is important. In Photoshop a quick way Filter > Lens Correction. Then just click on
in which the periphery of an image is to do this is to create a new layer on top Custom where you can change the Vignette
darkened, which helps to guide the focus of the layer stack, fill it with white, then slider; moving it to -100 works well

Warp tool

Sometimes a shape just doesn't feel 100%
right and needs to be altered a little fo fit.

In that case the Warp tool is the way to go
You can find it under Edit > Transform >
Warp. What the Warp tool does is cover your
layer with a grid that has 16 anchor points

in it. You can drag and move each of those
points to transform the layer exactly how you
want it. Alternatively, in the same menu you

can also find Distort and Perspective, two

other great ways to manipulate your layers.

Zoom

The Zoom function is another great (like traditional painters used to do), you can but the most commonly used is the wheel
Photoshop feature. Instead of having to have Photoshop do it for you. There are a of a Wacom tablet, or by pressing Ctrl and
move back from and forward to your canvas few ways to zoom in or out in Photashop, + to zoom in, or Ctrl and - to zoom out
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Beginner’s Guide to Digital Painting: Characters is a comprehensive guide
for artists wishing to create convincing and detailed characters. It features
established artists such as Charlie Bowater (concept artist at Atomhawk)
and Derek Stenning (freelance concept artist and illustrator, with clients
including Marvel Entertainment and Nintendo) who share their industry
experiences by covering such aspects as posing characters, choosing

the correct costumes, conveying emotions, and creating suitable moods.

Comprehensive step-by-step instructions — including a quick tips section that

covers how to paint elements that are integral to character design — make
this an invaluable resource for those looking to learn new skills, as well as

those pursuing the next level.

“These tutorials not only provide interesting
exercises for the beginner to help build a strong
foundation for drawing and painting, but also provide
important insights into the mindset of a concept
artist. Very useful and inspiring!”
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